A
MerATive

Curam 8.1.3

Independent Living Accelerator Guide






Note

Before using this information and the product it supports, read the information in Notices on page
165

© Merative US L.P. 2012, 2024



© Merative US L.P. 2012, 2024



Edition
This edition applies to Caram 8.1, 8.1.1, 8.1.2, and 8.1.3.

© Merative US L.P. 2012, 2024

Merative and the Merative Logo are trademarks of Merative US L.P. in the United States and
other countries.

© Merative US L.P. 2012, 2024



© Merative US L.P. 2012, 2024



Contents vii

Contents
L0 PP i
=T 11 o o PP S SURPPUPPPPRRRR Y
1 Independent LiVING aCCEIEIatOr.......cooviiiiiiiiieiceei et e e e e e e e e e e e e eeneannees 9
1.1 Overview of Independent LiVING........coooiiiiiiiiiiiii i 9
The Independent Living DUSINESS SCENANIO........c.uuuiiiiieeiiieeiiiii e e e e e e e e e e eeeeeeees 9
Independent Living example reqUIrEMENTS. .........uuiiiiiiiiiiiieiie e e 9
The Independent Living DUSINESS PrOCESS. ... ... aeaneeaneeeneannennrernrennne 9
Independent Living desSign dECISIONS..........uuuiiiiii et e e e e e e e e e e e e e eenennans 11
1.2 Installing the Independent LiVING @CCEIETALON...........uuiiiiiiiiiiiiiiiiiee e 11
1.3 Performing the Independent LIVING SCENATO. ........ccouiiiiiiiriiiieeeiiiiiii e 12
yaNo [0 [T aTo = T 0 1=T 6o ] o PP 12
(1 =T 1] g [o =T e 10 {oTo] o 0= o] = o 1 13
Running an assessment for the CENt.............oooii e 13
Adding activities to the plan.............oo o, 14
ReasseSSING the CHENT..........e e e e 15
UPdAting the PIAN........oee e e e e e e s 15
1.4 Analyzing the Independent Living appliCation..............ceiiiiiiiiiiiiiiiiin e 16
Analyzing the assesSSMEeNt reQUINEIMENTS. ........c.uuiiiiiiiee et e e e e 16
Analyzing the outcome plan reqUIreMENtS...........cooooiiiiiiiiii 24
ANalyzing the USEr rEQUITEMENTS......uuu i e e e et s e e e e e e e et s s e e e e e e e e arann e e eeeaeeenenes 32
Analysis results for INdependent LIVING...........couiiiiiiiiiiieeiiiiiiee e 33
1.5 Configuring the Independent Living application............ccoooeevriiiiiiiiini e, 34
Configuring the component order for Independent LiViINg..........ccccuviiiiieeiiiniiiiiiieeeeeee e 34
Create a user and associated user appliCation VIEW.............uuuuvrurerirerieriirerireeiesrieeereereeeree.. 35
Configuring OULCOME PIANS........uuuiii e e e e e e e e e e e e e e e e eareaa s 54
Setting Up CDA fOr @n @SSESSIMENT.......uuuiiiiiieiiiiiiiiii it e e e et e e e e e e e s e eeeaeeas 70
Configuring @SSESSMENIS......ccciiiii i 99
L] (=] €= o7 TP 137
N [0 o = 165
117z 103V o o ] o Y 2SR 166
B =0 (=] 00 T T ERPR PP 166

© Merative US L.P. 2012, 2024



Curam 8.1.3 viii

© Merative US L.P. 2012, 2024



1 Independent Living accelerator 9

1 Independent Living accelerator

Independent Living is a simple outcome plan that is built on top of the Cliram Platform and
Cuaram Outcome Management. From a planners initial assessment, a plan is created to assist the
client with returning to independent living. The application presents a basic path through Ctram
social program and outcome management.

1.1 Overview of Independent Living

The Independent Living accelerator provides a straightforward, worked example of how you
can create a basic outcome plan and run a simple assessment. After you worked through the
accelerator, you will be familiar with the design decisions and tasks needed to analyze and
configure your own solutions based on outcome management.

The Independent Living business scenario

The goal for the Independent Living scenario is to help elderly and vulnerable people to remain in
their homes and to remain independent as long as possible.

A typical Independent Living scenario could address the needs of a pensioner like Tony Smith,
who is aged 77. Tony is in receipt of an army pension and is able to take care of the weekly
shopping and financial affairs. Tony underwent surgery recently and is recovering at home.

Due to prolonged periods of bed rest, Tony is suffering from bed sores. The added immobility
affects Tony's ability to do weekly shopping, and safety concerns were expressed as Tony lives
alone. Based on a needs assessment, extra services are identified which would allow Tony live an
independent life.

Independent Living example requirements

In the worked example, the team that is deploying Independent Living have the following
caseworker requirements. The example is designed to familiarize you with the design decisions
and tasks that are required to meet these requirements.

* Search for existing clients or register new clients in the system.

* Create an outcome plan for a client.

* Run a needs assessment for the client to determine the initial needs of the client.

* Recommend activities for an outcome plan.

* Reassess a client’s needs after a change of circumstance.

» Update the outcome plan with new recommended activities based on the reassessment results.

The Independent Living business process

When a client is referred to an organization, a planner adds them to the system. The planner
works with the client to gather and submit the client information. The client information is
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assessed against a set of business rules to determine their needs. The planner creates a plan to
help the client return to independent living.

e W a a a

Users client Planner client Planner Planner
(ilplanner) (ilplanner) (ilptanner})

l l \J Reassess
System ) Create Ongaing
Flow %eﬁl'%t;t }—~ Outcome %Aﬁr’:&esesﬁent}—> Outcome  —— Needs
| Plan Management

Cuaram Clram ‘

Components | Case Management Caram Outcome Management ‘

IBM Clram Provider
Management

Caram Intelligent
Evidence Gathering

Clram . IBM Caram Social :
Decision Assist Enterprise Collaboration .

Curam Platform and Cram Outcome Management provides the processing and components
necessary to enable this business process. The business process uses the following components to
satisfy the requirements:

Ciram Case Management

This platform component helps to manage plans for high-risk, high-need people and intervene
with a social program, which results in better outcomes for the individual, in this case a
financial payment.

Cuaram Outcome Management

This separately purchased application module is designed to help organizations assess needs,
establish goals, plan for goal attainment, and track progress for citizens and their families by
creating and managing outcome plans.

Curam Intelligent Evidence Gathering
This platform component provides an interactive questionnaire to dynamically guide the client
or caseworker through the process of information gathering.

Cuaram Decision Assist

This platform component supports the configuration of an assessment to produce results that
lead to activity recommendations for use in an outcome plan. CDA is suitable for simple
assessments.
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+ Curam Provider Management
This separately purchased application module enables you to configure services and referrals
for a client. The simple plan in the Independent Living accelerator does not include the
configurations for integrating with Ciram Provider Management.

« Ciram Social Enterprise Collaboration
This separately purchased application module enables you to configure a multidisciplinary
team to address the needs of a client. The simple plan in the Independent Living accelerator
does not include the configurations for creating a multidisciplinary team with Social
Enterprise Configuration.

Independent Living design decisions

To meet the Independent Living requirements, the team must make key design decisions in the
following product areas. The design decisions are documented in detail in the Analyzing the
Independent Living application section.

* Needs assessment
*  Outcome plan
» User application views

1.2 Installing the Independent Living accelerator

The Independent Living accelerator is available for download only to members of Merative,
such as Lab Services developers who are assigned to work on a Ctram project on a customer
site. However, you can reproduce the sample application on the default product by following the
detailed step-by-step instructions in Configuring the Independent Living Application. Complete
the following steps to install the Independent Living accelerator.

Before you begin

Install a Curam Development Environment for application development. You must install the
Cuaram Data Extractor and the Cliram Outcome Management application module.

Procedure

1. Extract the Independent Living accelerator at the root of the “CURAM DI R%directory.
%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

2. From the “CURAM DI R%directory, update the Set Envi r onnment . bat and
Set Envi r onnent . sh files.

3. Editthe SERVER COMPONENT ORDER to add the IndependentLiving component after
the custom component.

4. Edit the CLIENT COMPONENT ORDER to add the IndependentLiving component after
the custom component.
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From the “CURAM _DI R% EJBSer ver\ proj ect\config
\ depl oynent _packagi ng. xm file to update the Caram EAR components element to
add the IndependentLiving component after the custom component.

From your Caram server development installation directory CURAM DI R% EJBSer ver ,
run the following commands.

build cl ean server database

buil d createC asspat hs

From your Ciram web client development installation directory “CURAM DI R%
\'webcl i ent, run the following command.

build clean client

Refresh the workspace within the Ciram Application Development Environment (ADE) and
start the application as normal.

1.3 Performing the Independent Living scenario

Detailed steps are provided for you to walk through the sample application, and experience the
full end-to-end business work flow.

Adding a person

Add a person by searching for an existing person or registering a person. If the person does not
exist, you can register the person.

Searching for an existing person
Complete the following steps to find a client who is already registered as a person on the system.

Procedure

1.
2.
3.

Log in to the application with the ilplanner user credentials.
From Quick Links, sclect the Search for a Person link.

Enter the following values on the Person Search tab and select Search.

Name Description

First Name Given name as stated on official document.

Last Name Surname as stated on official document.

From the Search Results window, select the Person link for any returned results to open the
Person's home page.
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Add a person by registering a new person.

Procedure

1.
2.
3.

Creating an outcome plan

Create an outcome plan for a client.

Log in to the application with the ilplanner user credentials.

From Quick Links, select Register a Person link and click Next.

Enter the following mandatory details and click Save. A tab opens for the newly registered

person.
Name Description
First Name Given name as stated on birth certificate.
Last Name Surname as stated on birth certificate.
Gender The classification of the Person as either Male or Female.

Date of Birth
Registration Date
Martial Status
Nationality
Country/Region of Birth
Address

An identification date to record the date, month, and year of birth.
The date on which the Person was registered.

The code to denote the state of marriage of the Person.

The code to denote the nationality of the Person.

The country/place of birth of the Person.

By default Caram supports 3 address layout types

¢ US address format.
* UK address format.
* Free form address format.

Procedure

1.
2
3.
4

. Drag one or more clients onto the client list to add them to the outcome plan and click Save.

From the person home page, select the Outcome Plan tab and click New.

. Select the Type and enter the Name of the outcome plan.

Choose the Start Date and Expected End Date.

The outcome plan opens in a new tab.

Running an assessment for the client

Run the Needs Assessment and answer the questions to determine the initial needs of the client.

Procedure

1. From the outcome plan, select the Assessments and Factors tab and click New.

2. From the New Assessment window, select Needs Assessment and click Next.

© Merative US L.P. 2012, 2024



Curam 8.1.3 14

3. From the Health and Safety window, provide the following answers to the questions that are

asked and click Next.
Question Answer
Is the home clean and tidy? Yes
Does the client suffer from pressure sores? Yes
Is the client able to manage their own financial affairs? Yes
Does the client's lifestyle place them or others at risk? Yes
Does the client display dangerous behavior towards others? No

4. From the Daily Routine window, provide the following answers to the questions that are

asked and click Next.

Question Answer
Can the client wash themselves? Yes
Can the client feed themselves? Yes
Can the client obtain food, medicines, and household items? No

Can the client access the toilet without assistance? Yes
Can the client walk long distances without assistance? Yes

5. From the Summary page, review the answers.

If required, you can use the back button to make changes.
6. Click Next

The assessment results are displayed.

7. Click Complete to save the assessment.

Adding activities to the plan

You can add recommended activities that were generated from the Needs Assessment to the plan.

Procedure

1. From the outcome plan, select the Workspace tab.

2. Expand the results tree to see individual factors.

3. Expand individual factors to see the recommendations.
4

. From the Workspace tab, drag each activity from the planned recommendations onto the

plan.
5. From the New Action wizard, add the schedule and duration of each action according to the
following table.
Factor Recommendation Frequency Duration
Health and Safety Nursing Services Daily 2 hours
Daily Routine Shopping Weekly on a Friday 1 hour
Health and Safety Advise on Secure Care  31st of the Month 1 hour
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Reassessing the client

Reassessing a needs assessment for a client.

Procedure

1. From the outcome plan, select the Assessments and Factors tab.
2. From the Needs Assessment action menu, select Reassess.

3. From the Health and Safety window, answers the questions as follows and click Next.

Question Answer
Is the home clean and tidy? Yes
Does the client suffer from pressure sores? Yes

Is the client able to manage their own financial affairs? No
Does the client's lifestyle place them or others at risk? Yes
Does the client display dangerous behavior towards others? No

4. From the Daily Routine window, answers the questions as follows and click Next.

Question Answer
Can the client wash themselves? Yes
Can the client feed themselves? Yes
Can the client obtain food, medicines, and household items? No

Can the client access the toilet without assistance? Yes
Can the client dress and undress themselves? Yes

5. From the Summary page, review the answers and click Next.
6. Click Next
The assessment results are displayed.

7. Click Complete to save the assessment.

Updating the plan

Based on the reassessment, add new recommended activities to the plan.

Procedure

From the outcome plan, select the Workspace tab.

From the Recommendations window, select the Factors tab.
Expand to see the individual factors.

Expand factors to see individual recommendations.

Drag each of the recommended activities onto the plan.

AN A

From the New Action wizard, add the schedule and duration of each action according to the
following table.
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Factor Recommendation Frequency Duration
Health and Safety Budgeting Weekly on a Friday 1 hour
Health and Safety Nursing Services Daily 1 hour
Daily Routine Shopping Weekly on a Friday 1 hour
Health and Safety Advise on Secure Care  31st of the Month 1 hour

1.4 Analyzing the Independent Living application

You are guided though the definition of project requirements for each of the main functional
areas in the business and technical flow of the sample application. The analysis tasks help you to
understand the key design decisions that you must make for each functional area, with important
concepts and default configuration options explained.

About this task

Specific examples are provided from the perspective of a business analyst who is defining the
requirements for the sample application. Examples can be chosen to demonstrate a particular
point, and are not intended to suggest a project methodology. Always read the examples and
guidance in the context of your project methodology, any incidental references to project
methodology are not proscriptive.

Analyzing the assessment requirements

For each assessment that you plan to use, you must analyze the assessment and identify the
project-specific business requirements.

About this task

You must study the assessment and have an understanding of the assessment objective and how it
is used to identify the root cause of a client's issues and needs. You must understand the questions
on the script and who is being assessed. You must also know how often the assessment is run.
You must know the expected results and how they must be displayed. You need to understand
these areas before you start with the requirements analysis.

Define the assessment questionnaire requirements

Typically, best practice assessments consist of a pre-defined set of questions with no flexibility in
relation to how the questions are worded. You must decide how best to structure the questionnaire
for your project.

You must decide on the sequence of the questions on the script and the responses to the questions.
The decision on how to represent the answers is based on whether you are allowed to select one
answer or multiple answers.

You must decide whether the assessment is used to assess a group of clients as a whole or whether
an assessment result is displayed for each individual that is assessed.

For large assessments, you need to consider how to separate the questions into meaningful
sections that fit on a page.
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Assessment guestionnaire
An assessment questionnaire is an interactive Intelligent Evidence Gathering (IEG) question
script that is specific to an assessment type.

Caseworkers can gather information about a client by stepping through the interactive script.

The question script specifies the behavior of the questionnaire, such as sequence of the questions,
or whether the questions are asked of all clients or a subset of clients. For example, a Caregiver
Strength and Needs Assessment presents questions to the primary and secondary caregivers, but
not to the focus child.

In the question script, you can specify help text for the entire assessment, a group of questions or
for individual questions.

Analyze the assessment factor requirements

You must define the factors across which clients or groups of clients are assessed when a
particular type of assessment is run.

Factors

A factor is an aspect of a client circumstance that is of interest to an organization. Client needs are
assessed by using factors.

Typically, a factor is considered either a need or a barrier:

* Needs are things that a client or family requires to be self-sustaining, but currently lack.

» Barriers are conditions that prevent or complicate a client's ability to obtain or achieve
something. Examples of assessment factors include substance abuse, mental health, and
parenting skills.

Each assessment typically has one or more factors, which describe performance standards for that
assessment. Each assessment has unique characteristics and while some factors might look similar
between assessments, the details of factors such as classifications, and thresholds, might differ
across assessments.

A factor can be added to an outcome plan as a result of an assessment. By running a Strengths
and Needs assessment, factors such as Substance Abuse and Mental Health can be added to the
outcome plan. A factor can also be added to an outcome plan by a caseworker who can select

a factor from a pre-defined list of appropriate factors. For example, this option can be used if a
third party is running the assessment and the caseworker wants to record the results manually

on the outcome plan. Finally, a factor can be added to an outcome plan when defined by a user
to specially address a particular circumstance. For example, through meetings between the
caseworker and the client an environmental issue might be identified as a factor. The caseworker
can record this factor on the outcome plan.

Guidance text can be defined for factors to help the user understand the steps that can be taken

to address a particular issue. For example, the following guidance can be displayed if a client is
assessed for Substance Abuse and is classified as 'Need': "The client can use alcohol or prescribed
drugs; however, use does not negatively affect their ability to look after themselves. Minimum
support is required; perhaps ensure that the client has support from family and friends, the
community, or both.'
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Categorize and classify assessment factors
After the assessment factors that are applicable to an assessment are defined, they are categorized.
Classifications must also be specified for each category.

Factors can be categorized to distinguish between the types of issues that a client needs to deal
with. For example, Substance Abuse and Domestic Violence might be categorized as a 'barrier' to
achieving a positive outcome whereas Education, Housing and Shelter might be categorized as a
'need'.

Factors must be categorized in the assessment administration application such that a set of results
can be derived for a particular factor.

When a client is assessed for a factor, a set of results are produced. The results describe
acceptable performance standards or range of results for that assessment. These results are
defined by using classifications in the administration application, for example, a client that is
assessed for the shelter factor might achieve one of the following results: In crisis, at risk, stable,
or self-sufficient. One or more classifications must be associated with a category so that an
assessment result can be produced.

Categorizing factors differently allow factors to be classified in different ways. For example,

a client who is assessed for the Housing factor, which is categorized as a need, might be
classified as safe, progressing, engaged, and vulnerable. However, a client who is assessed for
the Substance Abuse factor, which is categorized as a barrier, might be classified as a strength or
need.

A score can also form part of an assessment result. For example, substance abuse (categorized as
a barrier) can be classified as need (-5 to -1) and strength (0 - 3). Mental health (categorized as a
barrier) can be classified as need (-4 to -1) and strength (0 - 2). That is, different ranges of scores
can be applied to each classification of a factor. Figure 1 shows an example of the structure of an
assessment and the categorization and classifications of factors within that assessment.

You must specify ranges only for the classifications that are associated with the category and are
applicable to a factor. If you do not specify ranges for a classification, then it is not displayed in
the assessment results.
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Roles Assessment Type Factors Classifications and Ranges
Strength
I (0to 3)
Cpal:mf-'::r Substance
Refile Abuse Need
(Barrier) (-5te-1)
Strength
Mental (0to 2)
Health
Foeus Child Strength & ; Need
i p Ol (Barrier) i J
Asseszment (-4to-1)
Safe
(3to5)
Secondary Progressing
Caregiver (0to 2)
Role
Engaged
(-1te-3)
Vulnerable
(-4 to -5)

Figure 1: Assessment with Multiple Categories and Classifications

Mapping outcomes to factors
Outcomes are only applicable for assessments, which are implemented by using CDA. If you

use the CDA matrix to determine the results, then you must map CDA outcomes to factors or
factor classifications. The decision on whether to map to factors or factor classification depends
on whether scoring is used in the assessment. If scoring is used, then the CDA Outcomes must
be mapped to the assessment factors. If the assessment matrix does not use scores, then the CDA
Outcomes must be mapped to the assessment factor classifications.

The outcomes can be mapped to either the factors or the factor classifications.

If you are using scoring, you must map the CDA outcome to the factor. The scoring range is used
to map the score to the appropriate classification. For example, a Substance Abuse factor might
have three factor scores of High (2-5), Medium (-2 to 1), and Low (-5 to -3). The CDA outcome
is Substance Abuse with scoring and it is mapped to the Substance Abuse factor.
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If you are not using scoring, CDA outcomes can be mapped directly to factor classifications.

For example, a Substance Abuse factor might have three classifications of High, Medium, and
Low. So, the three CDA outcomes (Substance Abuse High, Substance Abuse Mild, and Substance
Abuse Low) are mapped to the factor classifications (High, Medium, and Low).

CDA outcome to factor classification CDA outcome with scoring to factor

Substance abuse o High

high High '\ /' 2105

Substance abuse Substance 1
Subslance abuse Medium Substance With sconng abuse Medium
mild y abuse -2 to1
Subslance abuse / \ Low
low ' Low 510-3

Note: Assessments that use a CER rule set to derive the results do not use outcomes. CER rule
sets can be created to produce scoring, classifications, or both, so outcomes do not need to be
defined.

Define the assessment factor requirements
The requirements for configuring factors can be complex, depending on the size of the
assessment. You must consider this guidance when you define the factor requirements.

You must define one or more factors for the assessment. The factors are unique to each
assessment.

Once the assessment factors that are applicable to an assessment are defined, they must be
categorized. You must define one category for an assessment factor, for example, for a Substance
Abuse factor the category might be barrier. A standard assessment has one category.

You must define the classifications for each category. All classifications that are defined for that
category are applicable to the factor. The range of results is used to measure a client or group's
functioning in that factor. Typically, all factors in an assessment use the same category.

If the assessment has a scoring component, then you must define the classification score. For
example, a Self-Sufficiency assessment might score the classifications as Vulnerable (0-2),
Engaged (3-5), Progressing (6-8), and Self-Sufficient (9-10).

If you use the CDA matrix to determine the results, then you must map the CDA outcomes to the
assessment factors. The outcomes can be mapped to either the factor or the factor classifications.
If scoring is used, you must map the CDA outcome to the factor as the range is used to map the
score to the appropriate classification. If scoring is not used, CDA outcomes can be mapped
directly to factor classifications.

You must decide whether the factor is involved in outcome planning or is only required for the
assessment in that they are used to determine the results of an assessment. If the factor is involved
in planning, it needs to be marked so that it is available outside of the assessment.
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Decide on the assessment role requirements

You use assessment roles to target questions at clients that play those roles. You must decide how
many separate roles you require to meet your assessment requirements.

Assessment roles

An assessment role represents the part that a client plays in terms of an assessment. For example,
an assessment might be assessing a client in their role as Primary Caregiver or as a Secondary
Caregiver.

Decide whether the assessment is role-based or group-based
You must decide whether the assessment is role-based or group-based. The decision is primarily
based on the wording of the assessment questionnaire.

You must study the assessment questionnaire to determine whether the assessment questions are
applicable to each role on the assessment or to specific roles only. If the assessment is group-
based, then you must name the group, for example, household or family.

You must also decide how the assessment results are displayed. You must decide whether the
results need to be displayed for both a group of clients and for individual clients.

Group and role-based assessments
The questions asked on the assessment can be directed to a specific group of clients or to the roles
that are defined for the assessment definition.

For group-based assessments, the questions asked during the assessment are specific to a group of
clients, such as a household. For example, if there are 5 members in the household the questions
are asked one time of the entire household.

For role-based assessment, the questions that are asked are specific to the roles defined for

the assessment. An example of a role-based assessment is the Caregiver Strength and Needs
Assessment with roles of primary caregiver, secondary caregiver, and focus child. The questions
are only asked of the roles that are selected when you run the assessment.

Define the assessment behavior
You must define how the assessment is managed and the results are displayed.

You must decide whether it is required to escalate the most urgent assessment results to the
caseworker. You can select each factor that is considered a priority. For example, a caseworker
might prioritize the factors for which the client scored the lowest results.

You must decide whether reassessment is appropriate for the assessment. Reassessment allows a
client's progress for specific factors to be measured over time.

You must decide whether it is necessary to display guidance or help text on the assessment
results or home page. The guidance assists a caseworker in addressing needs identified during the
assessment of factors. For example, guidance can be provided which suggests that a caseworker
can address a factor by creating particular services for clients. If you choose to display guidance,
you must document the text that must be displayed for specific factor classifications, factor
classification sub divisions, or both.

You must decide how to display the assessment results for each client. There are two options for
displaying the results on the assessment results page and the assessment home page - a graph
or a list. Selecting to graph or to list the assessment results depends on the assessment itself.
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For example, you must consider listing the results of a single factor assessment. Additionally, if
reassessment is not applicable to an assessment, it might be more appropriate to list the results.
If an assessment has multiple factors that use the same classification and scoring ranges or if
reassessment is applicable, you must consider displaying the results on a graph. Use graphed
results to track a history of the client or family's progress over time.

Decide on the assessment engine to determine assessment results

You must decide which assessment engine to use to determine the assessment results. Only one
assessment engine can be used. This decision is based on the complexity of the assessment and
whether there is a single outcome or multiple outcomes.

Simple assessments

Cuaram Decision Assist is suitable for simple assessments.

A simple assessment does not require rules processing. Typically, it has a single outcome, but can
have multiple outcomes.

Curam Decision Assist can be used for assessments where results can be derived without rules
processing. For example, a Caregiver Strength and Needs assessment contains nine factors.
Each factor has one question with four possible answers. The assessment result for each factor is
derived from the answer that is provided by a user.

Curam Decision Assist

Curam Decision Assist (CDA) is a tool that allows organizations to dynamically configure and
run simple assessments. Using CDA, you can link an existing Intelligent Evidence Gathering
(IEG) questionnaire with a decision matrix to run rules and determine the assessment outcomes.
CDA is also used to track assessment outcomes over time and to see the reasons for any changes.

For the selected questionnaire, you can choose which questions are used by the decision matrix.
The answers to the questions are used by the decision matrix to determine outcomes. You can
choose to score the answers. The score is then used to determine the outcome. CDA compares
the evidence that is collected against what is configured to arrive at an outcome without using
calculations.

The decision matrix can be thought of as a table. Each row in the table represents a question;
each sub row represents an answer; each column represents a potential outcome; each sub column
represents a combination of answers that lead to an outcome. A decision matrix can have a single
outcome or multiple outcomes and a rating based on a scoring mechanism for each answer.

For example, you might have a Mental Health Assessment with a question about depression.
Using CDA, you can choose to include the depression question in the decision matrix. The
question has two possible answers of 'Most Days' and 'Some Days'. These answers are pulled
from the questionnaire and included in the decision matrix. Using the decision matrix, you can
score the responses. You might score 'Most Days' as a 1 and 'Some Days' as a 0. You can then
specify Depression as an outcome for the answers. The client who responds Most Days is at a
higher risk of being depressed.

CDA provides an easy way of answering questionnaires, reviewing the answers, determining
results, and comparing the answers and decisions that are made over time. Answers given to
questionnaires can be changed and new decisions can be made. CDA provides an easy and
efficient way of maintaining rules-based assessments. The assessment lifecycle that is supported
by Decision Assist is easy to complete and repeat, if required.
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Complex assessments

Curam Express Rules (CER) can be used for more complex assessments where deriving the
assessment results requires rules processing. CER is used as the assessment engine along with the
Intelligent Evidence Gathering (IEG) tool to determine assessment results.

An assessment is considered complex when the assessment rule sets include calculations and data
comparison. A complex assessment typically has multiple outcomes.

You can configure the assessment definition to use an IEG script combined with a CER rule set to
derive the assessment results for complex assessment.

For example, CER can be used for a complex risk assessment that has two factors, Neglect and
Abuse. Neglect is classified by using classifications of Low (0 - 1), Moderate (2 - 5), High (6 - 8),
and Very High (9+). Abuse is classified by using classifications of Low (-1 to 0), Moderate (1 -
3), High (4 - 6), and Very High (7+).

The assessment produces a risk level, which is derived from the highest of the classifications for
Neglect and Abuse. For example, if the household that is being assessed is classified as Moderate
for Neglect and Very High for abuse, the risk level is Very High. This type of processing requires
a CER rule set.

_,  Veryhigh (9+)

— High (& to &)
| ;- '

Risk Wery high
Primary client  4——0o ass et 1

High (4 to 6}

—§  Abuse —

—
s Moderate {1 1o 3)
—

Low (-1 to 0]

Curam Express Rules

Curam Express Rules (CER) is a domain-specific language that was developed by Ctram for
use in defining questions that can be asked within the Curam application, and for performing
calculations. CER is used for a number of different aspects of Ctiram configuration.

CER rule sets are stored as XML data on the application database. The XML data for a CER rule
set adheres to the CER rule schema. CER rule sets can be created and maintained in the CER
Editor.

Each question specifies the following information:

* Name
* The type of data that provides the answer to the question.

* The rules for providing the answer.
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Answers to questions can be as yes or no, or you can define answer types to be as complex as you
need. For example, answering the question "Which groups of people in the household have an
urgent need?" might need a list of household groups, with each household group containing a list
of people.

Rules for determining the answer to questions can be as simple or as complex as you need. For
example, the rule for the answer to the question "What is the claimant's date of birth?" is likely
to (trivially) be "the date that the claimant declared their date of birth to be", whereas the rule for
answering the question "Is this person eligible to receive a benefit?" is likely to involve further
questions such as "What level of income does this person have?" or "How many children does
this person have?".

CER rule sets are stored as XML data on the application database. The XML data for a CER rule
set adheres to the CER rule schema. CER rule sets can be created and maintained in the CER
Editor.

CER can store rule objects on the database, so that the rule objects are available for future
processing. CER can integrate with the Dependency Manager to detect when input data changed,
and to automatically update calculation results, which depend on these input data items, similar to
spreadsheet processing.

Analyzing the outcome plan requirements

You must analyze and define the outcome plan requirements.

Define the required outcome

You must define the required outcome and then decide on the outcome plan name, goals, and
objectives.

Goals

An outcome plan is used to help one or more clients achieve their goals. The goal is the primary
objective that a client is working towards to become independent of the agency.

An outcome plan can support plan goals, client goals, or both. For example, an Assisted Living
plan can be created to achieve the goal of remaining in the home.

Objectives
Objectives are smaller steps that can be undertaken by a client to achieve the outcome plan goal.
You must decide whether your plan requires objectives.

An objective can be optionally specified for one or more clients on an outcome plan. For
example, the objectives for a client on an Assisted Living outcome plan might be to 'Manage
Disease' or 'Independent Living'.

Define the required factors

A factor is an aspect of a client circumstance that is of interest to an organization. You must
analyze your project requirements to determine which factors can be associated with the outcome
plan and how they can be implemented.

You must decide whether it is necessary to record results for a factor outside of running an
assessment. For example, a client might take their General Education Development (GED) test at
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a third-party agency. The agency sends the test results to the caseworker. The caseworker creates
a factor for the GED test in the system and records the test results.

You must decide whether a user is allowed to add factors that are not pre-configured on an
outcome plan to address a particular circumstance.

Priority factors represent the factors where either the most serious or pressing issues lie, or where
the most can be gained by applying resources to the problems or even strengths. You must decide
whether a caseworker can choose to prioritize factors within an outcome plan.

You must determine whether guidance text is available from the agency for inclusion in the
outcome plan to assist the caseworker in dealing with issues.

Factors
A factor is an aspect of a client circumstance that is of interest to an organization. Client needs are
assessed by using factors.

Typically, a factor is considered either a need or a barrier:

* Needs are things that a client or family requires to be self-sustaining, but currently lack.

» Barriers are conditions that prevent or complicate a client's ability to obtain or achieve
something. Examples of assessment factors include substance abuse, mental health, and
parenting skills.

Each assessment typically has one or more factors, which describe performance standards for that
assessment. Each assessment has unique characteristics and while some factors might look similar
between assessments, the details of factors such as classifications, and thresholds, might differ
across assessments.

A factor can be added to an outcome plan as a result of an assessment. By running a Strengths
and Needs assessment, factors such as Substance Abuse and Mental Health can be added to the
outcome plan. A factor can also be added to an outcome plan by a caseworker who can select

a factor from a pre-defined list of appropriate factors. For example, this option can be used if a
third party is running the assessment and the caseworker wants to record the results manually

on the outcome plan. Finally, a factor can be added to an outcome plan when defined by a user
to specially address a particular circumstance. For example, through meetings between the
caseworker and the client an environmental issue might be identified as a factor. The caseworker
can record this factor on the outcome plan.

Guidance text can be defined for factors to help the user understand the steps that can be taken

to address a particular issue. For example, the following guidance can be displayed if a client is
assessed for Substance Abuse and is classified as 'Need': 'The client can use alcohol or prescribed
drugs; however, use does not negatively affect their ability to look after themselves. Minimum
support is required; perhaps ensure that the client has support from family and friends, the
community, or both.'
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Analyze the outcome plan activity requirements

You must decide what activities you need to help a client achieve their goals. Activities might
include counseling sessions, physiotherapy, or an exercise routine. Within outcome management,
these activities are represented by services, referrals, and actions.

The activity workspace provides a caseworker with the capability to easily manage activities. The
caseworker can also quickly schedule new activities. The activity workspace provides a central
view on all activities that are currently scheduled for clients.

A caseworker can search for and add an activity to an outcome plan, or they can choose to add an
activity that is recommended by the system.

Actions

An action is a type of activity that can be added by a caseworker to a client's outcome plan.
Provider Management activities

If you have the separately licensed Provider Management application module, you can configure
more activities.

Services

A service is a type of activity that can be added by a caseworker to a client's outcome plan.

A service is paid for and tracked by the organization, but it is delivered by a third party or agency.
Scheduling a service begins with the selection of the service. A caseworker can search for and
select a service by using a taxonomy search or a name search, which returns services from the
CPM services registry. The service can also be recommended by the system and then selected

by a caseworker. The service that is selected dictates the information to be specified. Depending
on how the service is defined, the following information can be specified when the caseworker
schedules a service: Number of units, authorized rate, frequency, required participation, nominee
payment, owner, provider, and provider location.

Referrals
A referral is a type of activity that can be added by a caseworker to a client's outcome plan. The
caseworker can refer a client for a service to address a client need.

A referral is provided by a third party and is typically not tracked or paid for by the agency.

The process begins with the selection of the referral service. A caseworker can select from a list
of referral services that are stored in the CPM services registry, or the referral service can be
suggested by the system. The service that is selected dictates the information to be specified. The
following information can be specified when the caseworker schedules a referral: referral date,
whether to follow up with the client, provider and whether to send notifications to the client and
provider.

Define the outcome plan activity requirements
You must define a list of activities that are required to address client needs and decide on the
activity types that must be associated with the outcome plan.

You must work together with the project team to identify the actions and services that are the
most suitable to achieving positive outcomes.

You must consider the following when you analyze the referral:

* is a follow-up with the client necessary,
* who are the providers, and
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* do notifications need to be sent to the client and the provider when a referral service is added
to the outcome plan.

Define the recommendation requirements
You must decide what activities can be recommended based on your project requirements.

When the assessment requires recommended activities, you must determine how the
recommendations are mapped to the factor classification or score. You must also consider
whether the recommendations can be further broken down. You can configure the system so that
certain activities are recommended for a specific classification score, or a portion of the range for
that score.

You must also decide whether the recommendation is advised or discretionary. If it is advised,
then the caseworker must follow the recommendation and add the activity to the plan. If the
recommendation is discretionary, then it is up to the caseworker to decide to add the activity to
the plan or not.

Recommendations

Recommendations are suggestions of activities (services, actions, or referrals) or objectives that
are targeted to address a client's specific circumstances. These recommendations are often based
on best practices or suggestions from subject matter experts.

Recommendations are displayed in the activity workspace in the outcome plan when clients
are assessed and recommendations are configured for the assessment that is run. The
recommendation that is displayed depends on the client's circumstances (assessment results).

An activity can be recommended in two ways. It can be recommended by the system when that
outcome plan is created for a client. It can also be associated with a factor such that the action is
recommended when a client achieves a particular result from being assessed.

For example, you can configure that a counseling service (Service C) is recommended
if a client scores a classification of 'Need' on the Substance Abuse factor.

Service A
— . Slrength
012 5) Service B
Substance abuse —07 S’"w -
with scoring
Need Service C
(510 -1) Service D

Activities can also be recommended at a more granular level, for example a day retreat program
(Service D) can be recommended if a client scores a value of -5.
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Recommendations can be created for services, referrals, and actions. A recommendation and
reason can be specified. A recommendation indicates whether the caseworker is advised to

add the recommended activity or objective to the outcome plan for a client, or whether it is
discretionary to do so. The reason indicates why you think the recommended activity or objective
must be added to the outcome plan.

Sarvice A
—p Strength
] Service B
Substance abuse o | Substance ___
with scoring abuse
-2 to-1) Service C
Meed » »
(-5to-1) (-310-3) Service D

More recommendations with CPM
If you have the separately licensed CPM, then you can also recommend services and referrals.

Analyze the multidisciplinary team requirements

You must decide whether a multidisciplinary team (MDT) can be assigned to an outcome plan
type. If MDTs are applicable, you must decide on the types of MDTs that can be associated with
the plan type, and decide on the members of the team.

Multidisciplinary team portal

The multidisciplinary team (MDT) portal provides a forum to teams of skilled individuals and
community members where they can share information and communicate effectively with each
other. It provides communication tools such as discussion boards and support for scheduling
meetings and recording meeting minutes, which enable persons to work collectively to help
families.

An MDT can be assigned to an outcome plan to enable collaboration between the caseworker
and individuals who represent various disciplines within the team. The MDT members can use
the MDT portal to view outcome plans to which they are assigned. An MDT member can view
information that is shared with the member. An MDT member can also add an attachment or
note. After it is added, the caseworker is informed and can decide to share the items with other
members of the MDT.

It is important to note that the MDT portal is a separately licensed tool from Outcome
Management that is supported in Social Enterprise Collaboration (SEC). SEC is a common
platform and set of tools for multidisciplinary collaboration in social program organizations.
Social Enterprise Collaboration enables these multidisciplinary team members to reach beyond
their organizational boundaries to collaborate in support of their clients' needs.
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Decide whether an MDT is required for an outcome plan
You must decide on the MDT type and what information can be shared with each member.

You must decide whether a team with the same individuals can be assigned to particular types of
outcome plans. The other option is to allow the caseworker to add the team on an ad hoc basis.

You must identify who the MDT members are.

You must decide which information can be shared with each MDT. The following information is
shareable:

* Services
* Actions

* Referrals
* Notes

» Attachments

Analyze the requirements for monitoring client progress

Outcome management can track a client's progress to assess the effectiveness of their assigned
actions, services, and referrals. You must analyze the requirements for monitoring the client
progress that includes reassessment, plan reviews, and client participation.

Reassessments

Outcome Management supports the reassessment of a client over time by identifying current
needs and displaying a client's progress over time. The caseworker can run a reassessment,
compare assessment results, and view a history of the results.

Use reassessment to rerun an assessment on a client or group of clients across all of the factors
that were assessed during the original assessment, or across a subset of factors. For example, if
the original assessment was run across factors of substance abuse, social support, and domestic
violence factors, the caseworker might decide to reassess the client across the substance abuse

and domestic violence factors, since the client achieved a sufficient score for the social support
factor when the initial assessment was first run.

If escalation of the most urgent results is applicable to the assessment, on running a reassessment,
new priority factors can be selected from the reassessment results. For example, if the
reassessment results show that a client achieved sufficiency in a factor that was previously
marked as a priority when the original assessment was run, the caseworker might decide to
concentrate on new priority factors on reassessment. For example, a caseworker might prioritize
the factors for which the client scored the lowest results on the reassessment.

If the assessment allows role changes during reassessment, on initiating the reassessment, the
caseworker can update the roles that are played by the clients on the assessment if necessary. For
example, if James Smith is assigned the role of primary caregiver and Linda Smith is assigned
the role of the secondary caregiver when a needs assessment is first run and after the assessment,
Linda Smith becomes the Primary Caregiver, the caseworker can change the client who satisfies
the role of the primary caregiver for reassessment purposes.

Assessment result comparison is used to compare the results of an initial assessment with any
reassessment. The caseworker can also compare the results of any two reassessments that are
run on a particular client or group of clients. By comparing assessment results, the caseworker
can easily identify what caused a change in a client's progress from one assessment and another.
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For example, the factors that have different results can be identified along with the questions and
answers that led to these differences.

When the results of two assessments are compared, the system displays the classification and
the score that is achieved for both assessments per factor and client assessed. For example, for
Assessment A, James Smith might have a score of -1 for the Substance Abuse factor that is
classified as a Need. For Assessment B, James Smith might have a score of 2, which is classified
as a Strength. The client's answers are also displayed for each assessment that is compared.

The caseworker can easily identify the differences between each set of assessment results, the
differences between the assessment results and the answers are highlighted.

The caseworker can also view the assessment history. The view provides access to the results
achieved by clients each time that the clients were assessed. For each assessment, the caseworker
can view the clients that were assessed, the roles that the client played on the assessment, when
the assessment was started and completed, and a list or graphical representation of the results. The
system displays a clients progress over time for each factor.

Outcome plan reviews

Outcome plan reviews can be carried out to ensure that the activities on an outcome plan are
correctly addressing the needs of clients. Reviews also assess the client's progress towards
achieving the plan goals and objectives. The caseworker can make appropriate changes to the
plan based on the client's current circumstances.

Reviews are normally undertaken at regular intervals. For example, a review can take place every
90 days. The first review, however, can be undertaken shortly after plan creation to ensure that
any issues a client is experiencing can be dealt with early in the planning process. You can specify
areview frequency that defines when subsequent reviews need to be undertaken. Based on this
frequency, the system displays a next review date on the outcome plan to inform the caseworker
when the next review is due.

The review process begins when the caseworker creates a review on the system, specifies the type
of review, a review period, and an expected completion date. While a review is ongoing, any new
or completed activities, goals, or objectives are automatically recorded in the review and can be
seen by the caseworker. The expected completion date can later be updated by a caseworker and a
history of changes to the expected completion date recorded. A textual narrative of the review can
be recorded with review notes.

The system also displays a list of activities and goals that were not reviewed.

The review is complete when the caseworker finishes the review of all necessary aspects of the
plan.

Assessments can be run as part of a review. The output of the assessment can provide information
to the caseworker to review other items such as goals or objectives.

The effectiveness and appropriateness of visits (or interactions) between visited clients and
visitors can be reviewed. A visit review is created for each visited client and visitor where a
visitation plan for the participants exists for the review period. To assist the caseworker with
their visit evaluations, a list of visits that occurred during the review period, along with the
compliance, is displayed for the visit reviews. Compliance measures whether the visitor was
compliant with the expectations with regards to the frequency of visits with the visited client in
question.
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Client participation
Client participation information can be captured in the system to track whether the client is
participating in their assigned activities.

To ensure that a client is participating in the services and actions that are assigned to them, a
caseworker or provider can record client participation information. If a client is not participating
as required, sanctions can be applied to their benefits. A provider can record daily attendance for
services that use rosters in CPM.A caseworker can also record daily attendance for actions and
services from within an outcome plan.

Progress notes
Progress notes can be used to indicate how well a client is progressing and to capture detailed
information about their progress.

Progress notes can be used to capture the client's progress that is related to goals, objectives,
services, actions, and factors. When you create a new progress note, you must select a progress
rating and enter a textual description about the client's progress. For example, you might select a
progress rating of Excellent, Good, Moderate, or Poor. You can substantiate the rating by adding
detailed information about how the client is progressing.

Define the requirements for monitoring client progress
You must define the requirements for monitoring client progress by using reassessment, plan
reviews, and progress notes.

For reassessments, you must decide whether an assessment can be reassessed. If so, you must
decide whether the assessment can be rerun on a client or group of clients. You must also decide
whether role changes are allowed upon reassessment. You must define how often a reassessment
must occur.

For plan reviews, you must decide on when the first review can take place. You must also decide
on the frequency calculation. The frequency calculation can be based on the Scheduled Date of
the Preview Review Completion Date. You must decide on the review frequency that determines
when to do subsequent reviews.

For client participation, you must decide whether participation information must be captured for
an activity. You must also decide whether sanctions can be applied to the client's benefit.

For progress notes, you must decide on the progress values and the order of how the progress
values can be displayed.
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Analyzing the user requirements

You must analyze the default application user interface to ensure that it meets your requirements.

User application view

A user application view is a pre-defined view of the application that is specific to a user role.
The user application view displays the application home page, personalized pod pages, sections,
shortcuts, searches, tabs, and other user interface components that are relevant to the user role.

User interface components
An application user interface is composed of a number of elements that allow a user to perform
functions on the system.

For more information about the user interface, see the Web Client Reference Manual.

Users
A user is somebody who is employed by the organization to complete tasks on the system, such
as creating and managing cases.

New users must be registered on the system and assigned a security role and user application
view.

Default user application views

There are a number of default user application views including the administrator and system
administrator. From an outcome planning perspective, the most important user application view is
the outcome planner view.

Administrator user application view

The administrator user application view provides access to the administration configurations for
the administrator user.

The administrator user application view allows the user to configure the organization structure,
location structure, case structure, rules, evidence, intelligent evidence gathering, intake, among
other functional areas.

System administrator user application view
The system administrator user application view provides access to the system administration
configurations for the system administrator user.

The system administrator user application view allows the user to configure application
properties. The user can also configure case audit selection queries, communication templates,
batch processes, security settings, business intelligence reports, target systems, and content
management interoperability services.

Outcome planner user application view

The outcome planner user application view allows the user to identify clients needs, plan
activities to address these needs, and monitor a client's progress over time to ensure that these
needs are being met.

The user application view sections, pods, tabs, and shortcut panel are configurable.
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Define the user application view requirements

As part of any deployment of Ctiram, you must identify the functional and data requirements
for each of your users. Review the existing user application views and define any additional
requirements for your users.

The user role and user application views can be determined by examining functional areas (for
example, Outcome Management and On-going Cases) and existing requirement documentation.
You must understand which features are required by the user role.

When you define the requirements for the user application view, you must consider the following
user application view elements:

* Personalized pod pages,

e Sections,

o Tabs

e Shortcuts, and
* Searches.

You must decide which pods must be pre-configured on the personalized pod pages and which
ones can be added at the discretion of the user. You must also consider whether any of the pre-
defined pods need to be modified and if there is a requirement for a custom pod.

You need to decide which sections can be displayed for the user role and limit the number of
sections to under five sections.

It is also important to review the existing tab structure to determine whether any tabs must be
removed if the user role does not require access to the information.

You must also decide whether the default shortcut panel menu items need to be modified.
Consider removing any links the user role must not have access to. Conversely, the user role
might require more links on the shortcut panel to perform their tasks.

The default application allows the user to perform various searches on the system data. You must
decide whether all of the existing search pages that are displayed in the user application view are
required by the user role. You might need to modify the search pages if the user role must not
have access to some of the data that is presented in the search results.

Analysis results for Independent Living

Analysis of the Independent Living application requirements resulted in the following design
decisions.

Independent Living assessments

The Independent Living sample application required a simple assessment for illustrative
purposes. A simple needs assessment satisfied the Independent Living outcome plan
requirements.

The needs assessment contains limited questions about health and safety and the client's daily
routine.

CDA is used to create the assessment questionnaire and determine the assessment results. The
CDA outcomes are mapped to factors. The outcomes are scored.
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Independent Living outcome plan
The Independent Living sample application required a simple plan for illustrative purposes. The
following plan satisfied the Independent Living outcome plan requirements.

The Independent Living plan is created based on the needs that are identified in the needs
assessment. The goal of the plan is to empower and enable people to achieve choice and control
over their lives and full participation as equal citizens in society.

The system recommends actions to address the client needs identified by the assessment. The
Independent Living plan does not recommend services or referrals that are both available through
CPM.

To monitor client progress, the outcome plan review is scheduled to take place every 30 days. The
caseworker can also capture the client's progress by writing progress notes.

The decision was made not to use multidisciplinary teams.

Independent Living users and user application views

The Independent Living sample application focuses on outcome planning. The addition of a
slightly modified version of the Outcome Planner view, in addition to the default administrator
and system administrator user application views, satisfied the Independent Living user
requirements.

1.5 Configuring the Independent Living application

Detailed step-by-step instructions are provided for you to reproduce the sample application

on the default product. Reproducing the sample application gives you practical hands-on
experience with each of the technologies and configuration steps that you need to create your own
application.

Before you begin

Attention: Ensure that you always save your configuration files so that your configuration
changes are persisted. Configuration files are overwritten each time you run a build database
target.

For each generic task, child pages provide you with the specific values that you need to reproduce
the sample application.

Configuring the component order for Independent Living

You must add Independent Living to the server and client component orders so that the
Independent Living component is included in the Ctram server and client builds.

Before you begin

Install a Curam Development Environment for application development. The basic Cliram
Development Environment consists of the Caram Application Development Environment (ADE)
and Java IDE.
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About this task

You need to create a Cust onmEnvi r onnent . bat file for running Ctram from Microsoft
Windows or a Cust onEnvi r onnment . sh file for UNIX. You must not update the

Set Evi r onment . bat / sh files directly to include the additional components. As the

Set Evi ronnent . bat / sh files are supplied with Ctaram, the files are overridden if you install
a new version of Caram. CURAM DI R%is the Ctram installation directory, which by default is
C:\ Merative\ Curam Devel opnent .

Procedure
1. From the “CURAM DI R%directory, create the Cust onEnvi r onnment . bat and
Cust onmEnvi ronnent . sh files.

2. Edit the Cust omEnvi r onment . bat file to add the following details to set the component
order for Independent Living.

set CLIENT COMPONENT ORDER=IndependentLiving, $CLIENT COMPONENT ORDER%
set SERVER COMPONENT ORDER=IndependentLiving, $SERVER COMPONENT ORDER%

3. Edit the Cust onEnvi r onnment . sh to add the following details to set the component order
for Independent Living.

export CLIENT COMPONENT ORDER=IndependentLiving, $CLIENT COMPONENT ORDER
export SERVER_COMPONENT ORDER=IndependentLiving, $SERVER_COMPONENT ORDER

4. From the “CURAM DI R%directory, run Set Envi r onnent . bat

Create a user and associated user application view

Create a user and define the user application view. A user application view presents a user with a
pre-defined view of the application specific to their user role.

Configuring a user application view

Complete the following administration tasks to configure a user application view.

Creating an application home page

Home pages are pages that are tailored to specific roles within an organization, such as case
worker, intake worker, or supervisor. Every application has a home page. The home page
can be configured to contain pods, announcements, and quick links. Complete the following
administration tasks to configure an application home page.

Procedure
1. Create the application home page.
For example, <page_nane>. ui m

2. Create a properties file for the associated UIM page to include the help text description.
For example, <page_nane>. properti es.

3. Create a constants file to include the page identifier name.
For example, Const ant s. properti es.
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4. From your Clram web client development installation directory “CURAM DI R%
\webclient,runbuild client.

%CURAM DI R%is the Ctiram installation directory, which by default is C: \ Mer at i ve
\ Cur am Devel opnent .

5. Refresh the workspace within the Curam Application Development Environment (ADE).
Independent Living application home page files

The following are the configuration files that are used for configuring the assessment planner
application home page for Independent Living.

File name Location

| LAssessnent Pl anner Hone. ui iCURAM DI R% webcl i ent \ conponent s\ | ndependent Li vi ng

\ HonePage
| LAssessnent Pl anner Hone. properrin? esg

Constants. properties Note: %CURAM DI R%is the Curam installation directory, which by
default is C: \ Mer at i ve\ Cur am Devel opnent .

Configuring personalized pod pages

You must configure a personalized pod page for each application home page. Personal pages
contain multiple pods. The user can alter the content and layout of the personal page by
rearranging the pods on the page, by adding more pods or by hiding pods. Complete the following
administration tasks to configure personalized pod pages.

Procedure

1. Log in to Cliram as a user with administrator credentials.
2. Select the Administration Workspace tab, expand the Shortcuts menu, and click User
Interface > Personalized Pods Pages.
3. Click New Personalized Page
4. From the Configure a Personal Page wizard, complete the following steps.
a) From the Page ID window, enter the Page ID of the UIM to be configured and click Next.
b) From the User Role window, select a role to associate with the page and click Next.
¢) From the Available Pods window, select the PODs to be displayed on the page and click
Next.
d) From the Defaults Pods window, select the PODs to be displayed by default and click
Next.
e) From the Page Layout window, enter the number of columns to be displayed on the page
and click Next.
f) Click Save.

Pod values for Independent Living
Specify the following values for creating the personalized pods for the Independent Living
assessment planner worker.

Name Value
Page ID ILAssessmentPlannerHome
User Role PLANNERROLE
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Name Value

Available Pods Select the following check boxes:

¢ My Next Reviews

¢ My Onging Reviews
e My Tasks

e My Appointments

¢ Quicks Links

¢ Work Queues

Default Pods Select 'Available Tasks'

Page Layout 3

Configuring a tab

Content in a section is displayed in a tab, and each section can open multiple tabs, where each tab
represents a business object or logical grouping of information. A tab can also be described as a
logical grouping of pages. Complete the following administration tasks to configure a tab.

Procedure

1. From the Administration Workspace > User Interface > Tabs, click New Tab....

2. From the New Tab window, complete the following fields and click Save.

Name Description

ID Specify the page name. The tab is displayed when the page is loaded.
Name The tab name.

Title The tab title.

Tab values for Independent Living
Specify the following values for creating a tab for the Independent Living assessment planner
home page.

Name Value
ID ILAssessmentPlannerHome
Name Home
Title Home

Configuring a section

An application contains a number of sections, which allow quick and easy access to some of

the more common tasks and activities that are completed by a user. A user application view can
define between one and five sections. For example, Home, Inbox, Case, Outcomes, and Calendar.
Each section supports displaying multiple object tabs. For creating a section, you need to create a
home and workspace section. The home and workspace sections are mandatory, and a maximum
of five sections is advised.

Procedure

From the Administration Workspace > User Interface > Sections, click New Section....
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Configuring a home section
Complete the following administration tasks to configure a home section.

Procedure

1. From the New Section window, specify the following fields and click Save.

Name Description

Section ID Specify the home section identifier. For example, <application-
code>HomeSection.

Section Title Specify the section title.

Default Page ID Specify the page identifier. The default page identifier element

refers to the page that is opened when the section is selected.
The page must be referenced by a tab so that the associated tab is
always found for the section.

Hide Tab Container Select the check box. The hide tab container element indicates that
there is only one tab in the section, and the tab bar is not displayed.

Select the section.
From the Tabs tab, click Add.

From the Add Tabs window, enter the tab name and click Search.

ANl

Select the check box for the tab you want to add and click Save.

Home section values for Independent Living
Specify the following values for creating a section for the Independent Living assessment planner
home section.

Table 1: New Home section values

Name Value

Section ID ILAPAPPHomeSection
Section Title Home

Default Page ID ILAssessmentPlannerHome
Hide Tab Container True

Indicator

Table 2: New tab to search for and select

Name Value

Tab Name ILAssessmentPlannerHome

Configuring a workspace section
Complete the following administration tasks to configure a workspace section.

Procedure

1. From the New Section window, specify the following fields and click Save.
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Name Description

Section ID Specify the home section identifier, for example <application-
code>WorkspaceSection.

Section Title Specify the section title.

Default Page ID Specify the page identifier. The default page identifier element
refers to the page that is opened when the section is selected.
The page must be referenced by a tab so that the associated tab is
always found for the section.

Hide Tab Container |Leave the check box as blank. The hide tab container element
indicates that there is only one tab in the section, and the tab bar
is not displayed.

Select the section.
From the Shortcuts Panel tab, click New Shortcuts Group.
From the New Shortcuts Group window, specify the following fields.

Name Description
ID Enter the short group identifier.
Title Enter the short group title name to be displayed.

Select Edit to change the shortcuts panel title and click Save.
Repeat step 3, 4 and 5 to add extra shortcuts groups to the workspace section.

From the group that you created, click New Link. Specify the following fields and click
Save.

Name Description

Link ID Specify the link identifier. The link identifier must be referenced
in the workspace section so that the associated tab is always found.
For example, <sc:tab id="<link-id>"/>

Page ID Specify the page identifier. The default page identifier element
refers to the page that is opened when the shortcuts link is selected.
The page must be referenced by a tab so that the associated tab is
always found for the link.

Title Specify the title to be displayed for the link.

Open As Modal Select the check box to open the link as a modal window.

Repeat step 7 to add links for each group created.

From the Tabs tab, click Add. Specify the Tab Name and click Search. Select the tab check
box and click Save.

Repeat step 9 to add the associated tabs for the links added. The page added during a new
link creation must be referenced by a tab so that the associated tab is always found for the
link.
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Workspace section values for Independent Living
Specify the following values for creating a section for the Independent Living assessment planner
workspace.

Table 3: New Section values

Name Value

Section ID ILAPAPPWorkspaceSection
Section Title Outcome Plans

Default Page ID Leave blank.

Hide Tab Container Leave the check box blank.
Indicator

Table 4: New Outcome Plans shortcuts group values

Name Value
ID OutcomePlans
Title Outcome Plans

Table 5: New Outcome Plans link values

Link ID Page ID Title
MyOutcomePlans  OutcomePlan_listByOwner My Outcome Plans
NewOutcomePlan  OutcomePlan_create New Outcome Plan

Table 6: New Searches shortcuts group values

Name Value
ID Searches
Title Searches

Table 7: New Searches link values

Link ID Page ID Title Open as Modal
OutcomePlanSea@btcomePlan_search Outcome Plan Yes
PersonSearch  Person_searchl Person No
CaseSearch Case_searchl Case No

Table 8: Search tabs

Search Tabs

OutcomePlanSearch

PersonSearch

CaseSearch

Configuring an application banner
An application banner is what is displayed at the top of the page when a user logs in to an
application. The four configurable aspects of the banner are the application name, application
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subtitle, welcome message for the logged in user, and the application menu. Complete the
following administration tasks to configure an application banner.

Procedure

1. From the Administration Workspace > User Interface > Application Management,
click New Internal Application.

2. From the New Application window, specify the following fields and click Save.

Name Description

ID The application code identifier. The application code
identifier is linked to the Users entity through the
CT_APPLI CATI ONCCDE. ct x code table.

Component Specify the custom component the application is contained
within.

Application Specify the application user full name.

Welcome Message Specify the welcome message that is displayed to the user when
they view the application workspace.
For example, Welcome %user-full-name.

Click Edit.

Click Edit Application, specify the following fields and click Save.

Name

Description

Preference Link

Select the preference link check box to enable the display of the
preferences on the application banner.

Logout Link

Select the log out link check box to enable the display of logout
on the application banner.

Preference Title

Specify the preference title.

Logout Title

Specify the log out title.

Select Application Search > Change Search Type.

From the Change Search Type window, select Single Default Search Page from the drop-

down list and click Save.

7.  Click Edit and specify the following fields and click Save.

Name Description
Default Search Page Specify a default search page.
Initial Text Specify the text that is displayed inside the search text field.

Select the Sections tab and click Add.

From the Add Sections window, enter the section title and click Search.

10. Select the check boxes for sections you want to add to the application.
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Workspace banner values for Independent Living
Specify the following values for creating an application for the Independent Living assessment
planner workspace section.

Table 9: New application values

Name Value

ID ILAPAPP

Component Cdram

Application Outcome Planner
Welcome Message Welcome %user-full-name

Table 10: New application values

Name Value
Preference Link True
Logout Link True
Preference Title Preferences
Logout Title Log out

Table 11: Search values

Name Value
Default Search Page OutcomePlan_resolveByReference
Initial Text Enter a Plan Reference Number

Table 12: Sections added

Sections

ILAPAPPHomeSection
ILAPAPPWorkspaceSection
DefaultAppCalendarSection

DefaultApplnboxSection

Configuring an application code
An application code is what is used to link a home page to an application. Complete the following
administration tasks to configure an application code.

Procedure

1. Login to Curam as a user with the system administrator credentials.

2. Select the System Configurations tab, expand the Shortcuts menu, and click Application
Data > Code Tables.

3. From the Search Criteria cluster, enter the Application Code and click Search.
4. From the Application Code, click New Item.
5. From the New Code Table Item window, specify the following fields and click Save.
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Name Description

Item Name Specify the item name, which is the name of the page you want to link
the application to.

Technical ID Specify the application code.
(Code)

6. Click Publish and click Yes.

Application data code table values for Independent Living
Specify the following values for linking the assessment planner home page to the application
code for Independent Living.

Table 13: New application values

Name Value
Item Name ILAssessmentPlannerHome
Technical ID (Code) ILAPAPP

Configuring a user
A user is somebody who is employed by the organization to perform tasks on the system, such as
creating and managing cases. Complete the following administration tasks to configure a user.

Procedure

1. Login to Curam as a user with the administrator credentials.
2. From the Administration Workspace > Shortcuts > Users, click New User.

3. From the New User window, specify the following fields and click Save.

Name Description

Title Select the title for the user from the drop-down list. The title is a form of
Nomenclature identifying the User's status.

First Name Specify the first or given name of the user.
Last Name Specify the common name, or the hereditary name, of the user.
Location Select the search icon. From the Locations window, select the location

from the list. The location is a unique reference for the location within the
Organization where a Staff Member (User) is located.

Personal Email Specify the personal email record for the user.

Username Specify the name of the user. The name is the unique identifier for the user.
Password Specify the user password, which is used for logging in to Curam.
Application Select the home page from the drop-down list. The home page

is linked to the user application code, which is stored in the
CT_APPLI CATI ON_CODE. ct x file.

Role Name Select the search icon. From the Security Roles window, select the role.
The role is assigned by the system to a Security Group record.

Account Enabled Select the check box to enable the account. The indicator specifies that an
account is enabled or not.
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User values for Independent Living
Specify the following values for creating the assessment planner user for Independent Living.

Table 14: New user values

Name Value

Title Mr

First Name INDEPENDENT LIVING
Last Name PLANNER

Location Springdfield

Personal Email financialuser@curamsoftware.com
Username ilplanner

Password password

Application ILAssessmentPlannerHome
Role Name PLANNERROLE

Account Enabled True

Assigning a user to an organization unit and a position

All users in an organization have a position within an overall organization structure. The
organization structure itself can consist of one or more organization units. Complete the following
steps to assign a user to an organization unit and a position.

Procedure

1.

DR w

7.

From the Administration Workspace > Shortcuts > Organization > My Organization, and
select the Structures tab.

From the Organization Structures window, select an Organization Structures name.
Select the Organization Units tab and select an Organization Units name.
Select the Positions tab.

From the list of positions, select the action menu for the position you want to assign the user
to and click Assign User.

From the Assign User window, select the search icon and enter the name in the search criteria.
Click Search.

From the Search Results, select the user record and click Save.

Assign the assessment planner a position for Independent Living
Specify the following values for assigning the assessment planner user to a position for

Independent Living.

Name Value

Organization Midway Social Welfare Plan '03
Structures

Organization Units Board of Directors

Position Chief Executive Officer

Assign User INDEPENDENT LIVING PLANNER

© Merative US L.P. 2012, 2024




1 Independent Living accelerator 45

Configuring quick links

Quick links are a collection of links to frequently used application pages, which allow users to
complete common actions. For example, searching for a person or accessing a page with a list
of the cases that are assigned to the user. Complete the following steps to add quick links to an
application view.

Procedure

1. From the Administration Workspace > Shortcuts > User Interface > Quick Links by
Application View.

2. From the application, select Add Existing.

3. From the Add Quick Link To Application window, select from the available check boxes
and click Save. It is advised for usability purposes that the number of quick links to not
exceed 7.

Quick links values for Independent Living
Specify the following quick links to be displayed on the assessment planner home page quick link
pod.

Name Value
Application ILAssessmentPlannerHome
Quick Links Select the following quick links:

¢« New Outcome Plan

¢ My Outcome Plans

¢ Outcome Plan Search
e Search for a Person

e« Search for a Case

e Search for a Person

¢ Register a Person

¢ My Cases

Customizing tab navigation
It is possible to customize, or override, the behavior of tab navigation in Curam.

About this task

This is a generic task on how to customize the behavior of tab navigation. The variable values are
specified in a sub topic.

Procedure

1. Locate the tab navigation file whose behavior you want to override.

2. Copy the file, and its associated properties file, into “CURAM DI R% EJBSer ver
\ conponent s\ COMPONENT_NAME\ cl i ent apps.

%CURAM DI R%is the Ctiram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

3. Update the file by adding the additional navigation pages that you want available on the tab.

4. If there are associated properties, add them to the properties file that was copied across.
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5. From “%CURAM DI R% EJBSer ver ,runbui I d i nserttabconfi gurati on.

6. Save your configuration files.

Custom person home tab navigation values for Independent Living
Specify the additional custom navigation page and associated property that is required for the
person home tab navigation for Independent Living.

Additional entry for Per sonHorne. nav

<nc:navigation-page id="OutcomePlan"
page-id="OutcomePlan listByParticipant"
title="Page.Title.OutcomePlans"/>

Additional entry for Per sonHone. properties

Page.Title.OutcomePlans=0Outcome Plans

Saving your user application view configurations

Save your changes to the user application view configurations.

Quick reference for saving user application view configuration files
Reference table for all files that are associated with saving your user application view
configuration files.

The following descriptions detail each column of the reference table and what their purpose is.

Task Name: The name of the current task.

Data Contained In: The relevant file or files in the “CURAM DI R% EJBSer ver \ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
Y%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve

\ Cur aml Devel opnent .

Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R EJBSer ver \ bui | d\ dat aext ract or folder for each task.

Files To Be Created: A list of files that need to be created by the user for each task.

Table 15: User Application View File Reference Table

Task Name Data Contained In Files To Be Copied Files To Be Created
From Data Extractor

Saving the personalized PAGECONFI G. dnx PAGECONFI G. dnx

pod pages configurations USERPAGECONFI G dnmx  USERPAGECONFI G dnx

Creating the application ~APPRESOURCE. dnx | LAPAPP. app

view configuration files | LAPAPP. properties

| LAPAPPHoneSect i on.
| LAPAPPHoneSect i on.

| LAPAPPW I kspaceSec
| LAPAPPWr kspaceSec
| LAPAPPW I kspaceSec
| LAPAPPW I kspaceSec
| LAssessnent Pl anner
| LAssessnent Pl anner
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Task Name Data Contained In Files To Be Copied Files To Be Created
From Data Extractor

Saving the application CCDETABLEI TEM dmnx CT_APPLI CATI ON_CODE] ct x
code configurations
Saving the user USERS. dnx USERS. dnx
configuration files USERLI NK. dnx USERLI NK. dnxPOSI TI ONHOLDERLI NK. dnx

POSI TI ONHOLDERLI NK. dimx
Saving the user quick QUI CKLI NK. dnmx QUI CKLI NK. drx
links configurations QUI CKLI NKAPPLI CATI ONQIUNCKLI NKAPPLI CATI ON. dnx
Creating an application | LAssessnent Pl anner Hone. ui m LA
home page

Saving the personalized pod pages configurations
Complete the following steps to extract the specified personalized pod page DMX files from the
database and put them under source control.

Procedure

1. Extract the DMX files from the database with the bui | d ext r act dat a build target.

2. From the “CURAM DI R EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

Note: % CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

Name Description

PAGECONFI G dnmx  Stores page templates for the personalized pages. The identifiers are
referenced from the CT_PodType. ct x code table.

USERPAGECONFI G. dritores user-specific settings for the personalized pages, including default
settings by user role. The identifiers are referenced from the CT_PodType. ct x
code table.

3. Inside PAGECONFI G. dimx and USERPAGECONFI G. dnx, you must find the attribute with
name="config" and change its type from blob to text.

=

. The second step is to replace all < symbols with &/¢; and replace all > symbols with &gt,

. Inside USERPAGECONFI G. dnx, you must find the record with a userPageConfigID value of
4500and change its pageid from ASCEligibilityWorkerHome to ASCEligibility WorkerHome2.
This change avoids the Adult Social Care user workspace configuration being overridden by
an Intake user workspace configuration.

From “CURAM DI R% EJBSer ver ,run bui | d dat abase.

Save your configuration files.

n

S8
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Personalized pod values for Independent Living
The assessment planner home page configuration files specific to Independent Living.

File name Location

User PageConfi g. dmx %CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
. \initial
PageConfi g. dnx

Note: %CURAM DI R%is the Ciram installation directory, which by default is
C.\ Merati ve\ Curam Devel opnent .

CT_PodType. ct x %CURAM DI R% EJBSer ver \ conponent s\ cor e\ codet abl e

Creating the application view configuration files

The section, tab, and application management configurations are stored in APPRESOURCE. dnx.
The associated blob files that are extracted from the database need to be converted into the
associated .app, .sec, .ssp, .tab, .nav, .mnu, and .properties files.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the “CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, search for
the <application-code> in the APPRESOURCE. dnx file.

%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

3. For each of the rows that are returned in the search results, the blob files are specified in the
content attribute. Extract all the application resource blob files referenced.

4. Rename the blob files and store in the UCURAM DI R% EJBSer ver \ conponent s
\ COMPONENT _NANE\ cl i ent apps directory. XML configuration files that are included
with Curam exist in the #CURAM DI R EJBSer ver \ conponent s\ COVPONENT _NAMVE
\ t ab directory. The row names that are specified in the APPRESOURCE. dnx file are
specified here. The names that the associated application resource files need to be renamed to
are specified. The ID in the files needs to be the same name as the file name.

Name Rename File To

curam confi g. app. <appl i cati on<appl i cati on-code>. app
code>

<appl i cation- <appl i cati on-code>. properties
code>. properties

curam confi g. sec. <appl i cati on<appl i cati on- code>HoneSecti on. sec
code>HonmeSect i on

<appl i cation- <appl i cati on- code>HoneSecti on. properties
code>HonmeSect i on. properties

curam confi g. sec. <appl i cati on<appl i cati on- code>Wr kspaceSecti on. sec
code>Wrr kspaceSecti on

<appl i cation- <appl i cati on- code>Wor kspaceSect i on. properties
code>Wir kspaceSecti on. properties

curam confi g. ssp. <appl i cati on<appl i cati on-
code>Wr kspaceSecti on_SSP code>Wir kspaceSect i onShortcuts. ssp
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Name Rename File To

<appl i cation- <appl i cation-
code>Wir kspaceSect i on_SSP. pr opedea>a%r kspaceSect i onShort cuts. properties

5. Search for the <page-name> in the APPRESOURCE. dnx file.
6. Repeat step 3.

Name Rename File To

curam confi g.tab. <page- name> <page- nanme>.tab

<page- name>. properties <page- nane>. properties
curam confi g. mu. <page- <page- nane>Menu. mu
name>Menu

<page- nane>Menu. properties <page- nanme>. properties
7. From “CURAM DI R EJBSer ver,run bui I d i nserttabconfi guration.

8. Save your configuration files.

User application view files for Independent Living
The following table contains details of the configuration files for the Independent Living
assessment planner application view.

File name Description Location

| LAPAPP. app and the For each section referenced in %CURAM DI R EJBSer ver
associated properties file. the ILAPAPP.app file specific to \ conponent s\ | ndependent Li vi ng
Independent Living, the related \ 't ab\ Appl i cati onVi ews
section . sec file must be defined

to include the tabs available in Note: %CURAM DI R%is the Cdram
each section. installation directory, which by
» The following workspace defaultis C: \ Mer at i ve\ Cur am
sections are defined. \ Devel opnent .
* Home
* Outcome Plans
* Inbox
» Calendar

The Home and Outcome Plans
sections are customized for
Independent Living. The remaining
sections, Inbox, and Calendar,
use the default sections as
defined in the core application. A
maximum of 5 sections is advised.

| LAPAPPHoneSect i on. sethe Independent Living Home
and the associated section references the assessment
properties file. planner home page.
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File name Description

Location

| LAPAPPWr kspaceSect i Tire ©eitcome Plans section

and the associated specifies the associated tabs,

properties file. including the core tabs, the
common intake tabs, the evidence
tabs, and the Independent Living
tabs.

The Independent Living shortcuts
panel is also specified.

The person's information is
specified in the Outcome Plans
section.

| LAPAPPWr kspaceSect i TheSsloortauitisks spthe Outcome

and the associated Plans section are defined. The

properties file. . t ab file (id) and . ui m(page-id)
must also be defined when the
shortcut is specified.

| LAssessnent Pl anner Adpéfores. thalassessment planner

and the associated home tab. The Independent Living

properties file. assessment planner home page
is specified. The page must be
referenced in a tab so that the
associated tab is always found for
the section.

The context panel and tab
navigation is not configured as
part of Independent Living home
page.

The context panel can be
configured to display a specific
UIM page that displays common
information for the tab that is
always viewable.

e <contextpanel > uim

The tab navigation can be
configured to group UIM pages as
part of a tab can be navigated to
within a tab.

* <navigation>. nav

| LQut conmePl anMenu. muDefines the content of a tab
and the associated actions menu.
properties

%CURAM DI R% EJBSer ver

\ conponent s\ | ndependent Li vi ng

\'t ab\ Assessnent Pl anner Tabs
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Independent Living user application files link diagram
The following image displays the associated links between the user application view files that are
created for the Independent Living assessment planner.

ILAPAPP . ILAssessmentPlanner
—b-‘ Ve S ness }—.’LASS essmemPImnerHome.mm—% AppHome tab ‘
ILAPAPP ILAPAPPWorkspace | [PAGENAVELUIM
WorkspaceSection.sac SectionShortcuts.ssp

[

ILAPAPPapp }—

Y

\J

NAVBARMAME].nav

Y

[TABNAVE] tab

[PAMNELMANME] ssp

Y

[SECTIONNAMES] sec

[MENUNAME].mnu

\/

Saving the application code configurations
Extract the content from the CODETABLEI TEM dnx file and add it to the
CT_APPLI CATI ON_CODE. ct x code table to save the application code configurations.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI R4 EJBSer ver\ bui | d\ dat aextract or
\ CODETABLEI TEM dnx file, search for the application code configured.

%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

3. Ifthere is no pre-existing CT_APPLI CATI ON_CODE. ct X code table in the %CURAM DI R
% EJBSer ver\ component s\ COVPONENT_NANME\ codet abl e directory, create a new
code table and add the content from the CODETABLEI TEM dnx file. If the code table exists,
add the content to the existing code table.

© Merative US L.P. 2012, 2024



Curam 8.1.3 52

4. From “CURAM DI R% EJBSer ver,runbui | d ct gen dat abase.
5. From “CURAM DI R webclient,runbuild client.

6. Save your configuration files.

User application code file for Independent Living
The following is the configuration file that is used for configuring the application code for

Independent Living.
File name Location
CT_APPLI CATI ON_CCDE. ct x %CURAM DI R% EJBSer ver \ component s

\ I ndependent Li vi ng\ codet abl e

Note: %CURAM DI R%is the Curam installation
directory, which by default is C: \ Mer at i ve\ Cur am
\ Devel opnent .

Saving the user configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the “CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

File name Description
USERS. dnx Stores user information.
USERLI NK. dnx Stores a link between the user name and user ID.

PCOSI TI ONHOLDERLI NK. dnstores a link between a position and a user.

3. From “CURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

User configuration files for Independent Living
The following are the configuration files that are used for configuring the eligibility worker for

Independent Living.
File name Location
USERS. dnx %CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a

USERLI NK. dnx \ demo

PGSI TI ONHOLDERLI NK. dmx| Note: %CURAM DI R%is the Ctram installation directory, which by default
is C:\ Merati ve\ Cur am Devel oprent .
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Saving the user quick links configurations
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

Note: % CURAM DI R%is the Clram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

File name Description

QUI CKLI NK. dnx  When a user logs in to the system, any quick links that are associated with their
role are displayed on their home page. Quick links are shortcut links, which can be
included within a user role home page Quick Links pod. All quick links are defined
in the QUI CKLI NK. dnx file.

QUI CKLI NKAPPLI O&TineslthéNguititinks for the application. The quick links act as shortcuts for users
for commonly accessed parts of an application, for example, the Financial or Case
Worker Application.

A Quick Links pod is displayed on a user role home page. The quick link must
be associated with the user role for it to display in the Quick Links pod. For each
quick link to be displayed in the Quick Links pod of a user role home page, an
entry must be added to QUI CKLI NKAPPLI CATI ONLI NK. dnx

3. From YCURAM DI R% EJBSer ver,run bui | d dat abase.

4. Save your configuration files.

User quick links files for Independent Living
The following are the DMX files specific to creating quick links for the Independent Living

assessment planner user home page.

File name Location

QUI CKLI NK. drmx YCURAM DI R EJBSer ver \ conponent s\ Assessnent Pl anni ng
\data\initial

%CURAM DI R® EJBSer ver \ conponent s\ cor e\ dat a\ deno

Note: %CURAM DI R%is the Curam installation directory, which by
defaultis C: \ Mer at i ve\ Cur aml Devel opnent .

QUI CKLI NKAPPLI CATI ONLI NE4HIRAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial
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Configuring outcome plans

Complete the following tasks to configure an outcome plan and to save your outcome plan
configurations.

Configuring outcome plans

You can configure outcome plans to address and manage the needs that are identified during the
assessment.

Configuring goals

An outcome plan is created to assist a client in achieving a goal. You can configure a goal so that
it can be specified for an outcome plan, or so that the goal can be specified for each client on an
outcome plan.

Configuring a goal

Goals can be defined by an administrator and then shared across multiple types of outcome plans.
Once configured, a goal can then be added to an outcome plan by a caseworker. Complete the
following steps for configuring a goal.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Qutcome
Management > Goals > New Goal....

2. From the New Goal window, enter the following details to create a new goal.

Name Description

Name The localizable name of the outcome plan.
The name must be specified, for example,
"Self-Sufficiency", "Reunification”, "Maintain
Employment".

Reference A reference can be specified which allows the goal
to be referenced in code.

Description The localizable description of the Outcome Plan
Goal.

3. Click Save.

Goal values for Independent Living
Specify the following values for configuring a goal for Independent Living.

Name Value

Name Independent Living

Reference blank

Description The aim of independent living is to empower and

enable people to achieve choice and control over
their lives and full participation as equal citizens in
society.
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Configuring actions

You can configure an action so that it can be specified on an outcome plan for multiple clients.
An action can have a cost associated with it. It can also be configured to indicate if participation
tracking is required, and whether the client or the caseworker is responsible for the action.
Actions

An action is a type of activity that can be added by a caseworker to a clients outcome plan.

An action can be selected manually by a caseworker and added to an outcome plan. You can also
configure an action such that it is recommended for addition to the outcome plan by the system.
An action can be recommended in two ways. You can configure an action from the outcome
plan such that it is recommended when that outcome plan is created for a client. You can also
configure an action from an assessment definition factor such that the action is recommended
when a client achieves a particular result from being assessed.

You can add keywords or evidence to an action from the actions list.

When you configure an action, you can specify a reference so that the action can be referenced in
code. The remaining action configuration options are as follows.

Configuring an action
Complete the following steps to configure an action.

About this task

You must configure an action in the administration application before you can add it to an
outcome plan. After you define an action, you can add it to an outcome plan to address a client
needs.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Outcome
Management > Actions > New Action....

2. From the New Action window, enter the appropriate details.

Name Description

Name The localizable name for this type of action.

Reference The unique reference of this type of action.

Cost Model The Cost Model drop down list allows an administrator to define the cost

associated with the action. Three values are available for selection: No Cost,
User Specified Costs, and Fixed Actual.

If No Cost is specified, it means that there is no cost associated with the action
and as a result no cost information is displayed for this action on an outcome
plan.

If User Specified Costs is specified, it means that the estimated and actual cost
can be specified by a user when creating and completing the action. An estimated
cost field is displayed when adding the action to an outcome plan allowing a user
to specify the estimated cost of the action. An actual cost field is displayed when
completing the action allowing a user to specify the actual cost of the action.

If Fixed Actual is specified, it means that a fixed cost is associated with the
action. If this is specified, a fixed cost must be specified when administering the
action. This cost is then displayed to a user when adding an action to an outcome
plan.
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Name

Description

Fixed Cost

Multiple Clients

Client Participation

Responsibility

Owner

Create SID
Modify SID

Exclude from
Availability Check

Description

List Preview

Home Page

Rename Allowed

Indicates the fixed cost of this type of action.

The multiple clients indicator allows an administrator to define whether a single
client or multiple clients can be selected when adding the action to an outcome
plan. If this indicator is switched on, multiple clients can be added to the action.
A multi select list is provided when adding the action to an outcome plan which
allows multiple clients to be selected. If this indicator is switched off, only one
client can be selected when adding an action to an outcome plan. A drop down
list is displayed allowing only one client to be selected..

The Client Participation indicator allows an administrator to define whether
participation needs to be specified when creating an action on an outcome plan.
When this indicator is switched on, a frequency and duration are displayed and
must be specified when adding an action to an outcome plan. This indicator
also allows actual participation to be recorded for an action. When this indicator
is switched off, participation cannot be recorded on the action i.e. a frequency
and duration are not displayed when creating the action and actual participation
cannot be recorded for the action.

Indicates who is responsible for this type of action. This dictates what gets
displayed to the user when creating an action of this type on the delivery side.

For more information about responsibilities, see the Outcome Management
Configuration Guide.

Indicates who can own this type of action. This dictates what gets displayed to the
user when creating an action of this type in the delivery side.

The Owner drop down list allows an administrator to define how the owner is
assigned to an action. Two values are available for selection: 'User Creating
Action’, 'Any User'.If 'User Creating Action' is specified, the owner of the action is
automatically assigned to the user who is adding the action to the outcome plan.If
'‘Any User' is specified, the owner can be specified by the user creating the action.
The user will be able to search for a user when adding the action to the outcome
plan.

Specifies the creation rights for this type of action.
Specifies the modification rights for this type of action.

Indicates if this action should be excluded from the list of scheduled appointments
returned when a user checks the clients availability.

The localizable description for this type of action.

The drop-down preview view that is used when the user selects the toggle for an
action that is displayed in a list view. This configuration is optional and is read
from a property if it is left blank.

You can specify a home page for a plan action. This configuration is optional and
is read from a property if it is left blank.

Where you want to give case workers the flexibility to rename actions, use the
Rename Allowed property to enable an action to be renamed from the outcome
application.

3. Click Save.

Action values for Independent Living
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Specify the following values for configuring actions for Independent Living.

Table 16: Actions configured

Name Description

Advise on Psychiatric Services Advise on Psychiatric Services. Psychiatric services
can be provided where an assessor feels that they
are appropriate.

Advise on Secure Care Advise on Secure Care. Some clients may require
secure accommodation and care.

Budgeting Services Budgeting Services. Help with money management,
bill paying etc.

Feeding / Carer Services Feeding / Carer Services. Feeding is part of general

carer services.

Housekeeping Services Housekeeping Services. This could include cleaning
and vacuuming the home. Ensuring that the home is
a pleasant environment to live in.

Nursing Services Nursing services are available where a client has
a medical condition that requires qualified nursing
care.

Shopping / Carer Services Shopping / Carer Services. Assisting the client with

the shopping list, purchasing the goods and storing
them in their proper location in the home where the
client can retrieve them.

Toilet / Carer Services Toilet / Carer Services. Assisting the client in the
use of the toilet, ensuring that they are comfortable.

Washing / Carer Services Washing / Carer Services. Washing, bathing the
client is part of general services that a carer would
be expected to perform.

Wheelchair Service Wheelchair Services. The client requires wheelchair
assistance to get around.

Table 17: Common configurations across all actions configured for Independent Living

Name Value

Client Participation True

Responsibility User Creating Action
Owner User Creating Action

Configuring progress

You can configure progress values so that the caseworker can record the progress on an outcome
plan.

Progress

Progress is an indication of how well the activities on the outcome plan address the client needs.

The progress values that can be selected by a case worker when recording progress on an
outcome plan must be defined in administration. An icon can also be configured for each value
that is displayed when the associated progress value is recorded for a client on the outcome plan.

The value must be specified and represents the progress values that can be selected by a
case worker on an outcome plan, for example, 'Good', 'Bad', 'Excellent'. The Resource Name
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represents the name of the icon that is selected in the Icon field and is required so that the icon
can be stored in application resources.

Configuring a progress value
Complete the following steps for configuring a progress value.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Qutcome
Management > Progress > New Progress....

2. From the New Progress Value window, enter the following details to create a new progress.

Name Description

Value The Value must be specified and represents
the progress values that can be selected by a
caseworker on an outcome plan, for example,
'‘Good', 'Bad’, 'Excellent'.

Resource Name The Resource Name represents the name of
the icon that is selected in the Icon field and
is required so that the icon can be stored in
application resources.

Icon An icon can also be configured for each value,
which is displayed when the associated progress
value is recorded for a client on the outcome plan

3. Click Save.

Progress values for Independent Living
Specify the following progress values for Independent Living.

Value Resource Name Icon

Excellent ExcellentProgress %CURAM DI R%
\ EJBSer ver\ conponent s
\ | ndependent Li vi ng
\data\initial\blob
\ Excel | ent Progress. png

Note: %CURAM DI R%is
the Cdram installation
directory, which by default
is C:\ Merati ve\ Curam
\ Devel opnent .

Good GoodProgress YCURAM DI R%
\ EJBSer ver\ conponent s
\ I ndependent Li vi ng
\data\initial\blob
\ GoodPr ogr ess. png

Moderate ModerateProgress YCURAM DI R%
\ EJBSer ver\ conponent s
\'I ndependent Li vi ng
\data\initial\blob
\ Moder at ePr ogr ess. png
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Value Resource Name Icon

Poor PoorProgress %CURAM DI R%
\ EJBSer ver\ conponent s
\ I ndependent Li vi ng
\data\initial\blob
\ Poor Pr ogr ess. png

Configuring outcome plans

You can configure outcome plans to address and manage the needs that are identified during an
assessment.

Configuring an outcome plan

Complete the following steps for configuring an outcome plan.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Outcome
Management > Outcome Plans > New Outcome Plan....

2. From the New Outcome Plan window, enter the following details to create a new outcome
plan.

Table 18: Outcome plan

Name Description
Name The localizable name of the outcome plan.
Reference A reference field so that the outcome plan can

be referenced within code. The reference field is
unique across all active outcome plans.

Home Page A home page can be specified such that the
default outcome plan home page can be
overridden to use a different home page.

Goals Applicable To The drop-down list allows an administrator to
define the level at which a goal can be added to
an outcome plan in the caseworker application.
The options available are

¢ Outcome Plan Only
¢ Clients Only

¢ Outcome Plan

¢ Clients

Specifying Outcome Plan Only means that a goal
can be created at the outcome plan level only.

Specifying Clients Only means that a goal can
only be created for clients on the outcome plan, a
goal cannot be added at the outcome plan level.

Specifying Outcome Plan and Clients means that
a goal can be added at either the outcome plan
level or for a client on the outcome plan.

Agreement Approval Check Agreement approval checks determine the
percentage of outcome plan agreements that must
be reviewed by a case supervisor.
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Name

Description

Ownership Strategy

Description

On the creation of an outcome plan, the ownership
of the outcome plan is automatically assigned to
the user which, created the outcome plan.

If an agency wants to define their own outcome
plan ownership processing, the default processing
can be overridden by specifying an ownership
strategy for the creation of an outcome plan. The
Ownership Strategy list allows an administrator to
select a work flow, which can be used to assign
an owner to an outcome plan instead of using the
default processing.

The localizable description of the outcome plan
administration.

Table 19: Multidisciplinary Team

For more information about configuring multidisciplinary teams, see the Social Enterprise

Collaboration Configuration Guide.

Name

Description

Type

Multidisciplinary team configurations allow an
administrator to define the type of multidisciplinary
team that can be added to an outcome plan. A
'Pre-defined Team' or an 'Ad hoc' team can be
selected from the multidisciplinary team type drop-
down list.

If 'Pre-defined Team' is specified, a caseworker
must select from a list of teams that are
pre-configured in the multidisciplinary team
administration to add a team to the outcome plan.

If 'Ad hoc' is specified, a caseworker can add
individual multidisciplinary team members to the
outcome plan.
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Name Description

Sharing Enabled If a multidisciplinary team is added to an outcome
plan, information can be shared with the members
of the multidisciplinary team. It can be accessed
by team in the multidisciplinary team portal.

For example, a caseworker can specify that
certain multidisciplinary team members can view
certain notes and attachments from the portal.
An agency might not want to share information in
this way. The Sharing Enabled indicator allows
an administrator to dictate if information is shared
with multidisciplinary team members or not.

If the Sharing Enabled indicator is off, a
caseworker is not provided with the ability to share
information with multidisciplinary team members.
Information is not visible in the portal for the
selected outcome plan.

If the Sharing Enabled indicator is on, a
caseworker is given the option to share certain
information with multidisciplinary team members.
The information that can be shared is configured
in multidisciplinary team member administration.

Portal Home Page When information is shared from an outcome plan,
it is accessed in the multidisciplinary team portal.
Information from social enterprise folders (SEF)
and Investigation cases is also viewable in the
portal. It is necessary for each case type to have
their own home page since each case contains
different information.

A default home page is provided for a SEF,
investigation, and an outcome plan. However, if
an agency wants to override the default home
page, a different home page can be defined for
an outcome plan that uses the Portal Home Page
field.

Table 20: User Creation Options

An action, factor, and objective can be added to an outcome plan without the need to
administer them in outcome management administration. Agencies might not want the
caseworker to add these types of user-defined items since they are difficult to report on.
Agencies might want to use a more standardized approach to outcome planning. To cater for
this the Create Action, Create Factor and Create Objective indicators allow an administrator to
dictate if a caseworker can add these types of user-defined items.
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Name

Description

Create Actions

Create Objectives

Create Factors

If the Create Action indicator is turned on, a
caseworker is allowed to add user-defined actions
to an outcome plan.

If the Create Action indicator is turned off, an
action must be selected from a pre-defined list of
actions.

If the Create Obijective indicator is turned on,
a caseworker is allowed to add user-defined
objectives to an outcome plan.

If the Create Obijective indicator is turned off, an
objective must be selected from a pre-defined list
of objectives.

If the Create Factor indicator is turned on, a
caseworker is allowed to add user-defined factors
to an outcome plan.

If the Create Factor indicator is turned off, a factor
must be selected from a pre-defined list of factors.

Table 21: Review Options

Name

Description

First Review (days)

Frequency Calculation

Frequency (days)

You can configure the date on which the first
review of a plan takes place with the First Review
(days) field. It is used in combination with the plan
creation date to derive a next review date.

For example, if this field is set to 30 days and an
outcome plan was created on the 01/01/2014,
the next review date (the first review) is set to
31/01/2011.

The Frequency Calculation can be based on
the 'Scheduled Date' or the 'Previous Review
Completion Date'.

If the review frequency calculation is set to
'Previous Review Completion Date', and a
previous review does not exist, then the next
review date is based on the 'scheduled date'.

You can specify a review frequency that allows an
administrator to dictate the next review date for
subsequent reviews. The Frequency is used with
the Frequency Calculation list.
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Table 22: Visits

Name Description

Visits Applicable The administrator indicates whether visitation
plans and visits are applicable to the outcome
plan. Visitation plans allow a caseworker to
specify and describe planned interactions that
occur between individuals.

For example, for Child Welfare, visitation plans
describe those interactions between the child

in out-of-home placement and family members
(parents or relatives) or other participants. If visits
are configured for an outcome plan, the Visits tab
is displayed on an outcome plan. The visitation
plans and visitation logs can be created and the
caseworker can also evaluate visits as part of a
review.

Visits are evaluated as part of the plan review
process. To assist the caseworker in performing
visit evaluations, the system calculates visit
compliancy and displays a compliancy level for
each client and visitor.

This calculation is based on visitation plans for
each client and visitor, which overlap with the
applicable review period. The system calculates
the compliancy of actual visits against the planned
visits set out in a visitation plan.

In order to calculate compliancy, a number

of factors are taken into account, such as the
duration of the visit, reschedule reasons for
rescheduled visits and method of contact. Some
of these factors, namely method of contact,
frequency of visits and expected duration,

are specified on the visitation plan. There

are also a number of configuration settings,
including acceptable duration, compliancy levels
and reschedule reasons, that are used in the
compliancy calculation.

Acceptable Duration (%) The acceptable duration is set for an outcome
plan type. This configuration is provided for
the administrator to set the percentage of the
visit duration that is acceptable for compliancy
purposes.

For example, if the acceptable duration is set to
50%, and the expected duration set out in the
visitation plan is 1 hour, any visits that occur for
that visitation plan, that have a duration of 30
minutes or more, is considered compliant from a
duration perspective. Any visits that are less than
30 minutes are not considered compliant and are
excluded from the compliancy calculation.
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Name

Description

Lower Age Limit

Upper Age Limit

The administrator can also specify the age range
for the clients to be visited for an outcome plan.

For example, on a Child Welfare plan, where visit
criteria between caregivers and children are set
out on a visitation plan. The lower age limit might
be set to 0 and the upper age limit might be set
to 21. It means that only the children aged 21
and under can be added as clients to visit on the
visitation plan.

3. Click Save.

Outcome plan values for Independent Living

Specify the following values for configuring an outcome plan for Independent Living.
Multidisciplinary team configurations are not required.

Table 23: Outcome plan

Goals Applicable To
Agreement Approval Check
Ownership Strategy

Description

Name Value

Name Needs Outcome Plan
Reference NeedsAssess

Home Page blank

Outcome Plan Only
blank
blank

Needs Outcome Plan Description

Table 24: User Creation Options

Name Value
Create Actions True
Create Objectives True
Create Factors True
Table 25: Review Options
Name Value
First Review (days) 30
Frequency Calculation Scheduled Date
Frequency (days) 30
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Associating goals with an outcome plan

You can configure one or more goals to be associated with a type of outcome plan. The associated
goals are then available for a caseworker to add as an outcome plan goal or a client goal on an
outcome plan.

Associating a goal

Complete the following steps to associate a goal with an outcome plan.

Procedure

1. From the outcome plan, select the Goals tab and click Add.

2. From the Add Goals window, select the check box for the goals you want to add to the
outcome plan and click Save.

Goals associated with the outcome plan for Independent Living
For the Needs Outcome Plan, there is only one goal associated called Independent Living, which
is specified for Independent Living.

Saving your outcome plan configurations

After you have configured an outcome plan, you must manually save all of the outcome plan
configurations to ensure that they are not overwritten when you do a build database target.
Quick reference for saving outcome plan configuration files

Reference table for all files that are associated with saving your outcome plan configuration files.

The following descriptions detail each column of the reference table and what their purpose is.

e Task Name: The name of the current task.

» Data Contained In: The relevant file or files in the CURAM DI R% EJBSer ver\ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

+ Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R% EJBSer ver \ bui | d\ dat aext ract or folder for each task.

» Files To Be Created: A list of files that need to be created by the user for each task.

Table 26: Outcome Plan File Reference Table

Task Name Data Contained In Files To Be Copied Files To Be Created

From Data Extractor
Saving your goal QUTCOVEPLANGOALADM N. dmxLOCALI ZABLETEXT| dnx TEXTTRA
configuration files
Saving your action OQUTCOVEPLANACTI ONADM N. dnmxLOCALI ZABLETEKT. dmxTEXTT
configuration files
Saving your progress PROGRESSADM N. dmx APPRESOURCE. dmxLOCALI ZABLETEXT. dr
configuration files
Saving your outcome QUTCOVEPLANADM N. dmx APPROVALREQUEST. dnx | OCALI| ZABLE
plan configuration files
Saving your outcome QUTCOVEPLANGOALADM NLI NK. dmx

plan goal association
configuration files
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Saving your goal configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

QUTCOVEPLANGOALADM N. dirhis entity stores goals that can be added to an outcome plan.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Merative\ Curam Devel opnent .

3. From Y%CURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Goal configuration files for Independent Living
The Independent Living goal configuration files are in the following location in the accelerator.

Table 27: DMX files

File name Location

OUTCOVEPLANGOALADM N. d##CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Ciram installation directory, which by default
is C:\ Mer ati ve\ Cur am Devel opnent .

Saving your action configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver\ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

OUTCOVEPLANACTI ONADM N hdsnentity stores activities that can be added to an outcome plan.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.
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Note: %CURAM DI R%is the Cliram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Action configuration files for Independent Living
The Independent Living action configuration files are in the following location in the accelerator.

Table 28: DMX files

File name Location

OUTCOVEPLANACTI ONADM N%BURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Caram installation directory, which by default
is C: \ Mer at i ve\ Cur am Devel opnent .

Saving your progress configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

PROGRESSADM N. dix This entity stores progress values which will be selectable by a user
when recording progress for a client.

APPRESCOURCE. dnx This entity contains application resource files.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. Inside the file APPRESOURCE. dix, you must find the attribute entry where name has a
value of the resource name that was specified during configuration.

N

. Search for the file that is specified for the attribute content in the bl ob folder and change it to
be the name of the resource that was specified during configuration.

Update the reference inside APPRESOURCE. dnx to point to this modified file name.

Update the relative path of the content attribute to point to . / COVPONENT _NANME/ dat a/
initial/blob.

7. From “CURAM DI R% EJBSer ver ,run bui | d dat abase.

S
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8. Save your configuration files.

Progress configuration files for Independent Living
The Independent Living progress configuration files are in the following location in the

accelerator.

Table 29: DMX files

File name Location
PROGRESSADM N. dnx Y%CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Ciram installation directory, which by default
is C: \ Mer at i ve\ Cur am Devel opnent .

Saving your outcome plan configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext ract or directory, copy the
following DMX files.

File name Description

QUTCOVEPLANADM N. dnx A type of outcome plan that can be created by an organization which
aims to achieve better outcomes for clients.

APPROVALREQUEST. dnmx  An approval request record is written to the system if an '‘Agreement
Approval Check' percentage is specified.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dmx  This entity holds the text translation for various locales.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Merati ve\ Curam Devel opnent .

3. From “CURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.
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Outcome plan configuration files for Independent Living
The Independent Living outcome plan configuration files are in the following location in the
accelerator.

Table 30: DMX files

File name Location
PROGRESSADM N. dnx Y%CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Caram installation directory, which by default
is C: \ Mer ati ve\ Cur am Devel opnent .

Saving your outcome plan goal association configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

QUTCOVEPLANGOALADM NLITis entity stores a link between a goal and an outcome plan.

Note: %CURAM DI R%is the Cliram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Outcome plan goal association configuration files for Independent Living
The Independent Living outcome plan goal association configuration files are in the following
location in the accelerator.

Table 31: DMX files

File name Location

OUTCOVEPLANGOALADM NLI BiCURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Curam installation directory, which by default
is C: \ Mer ati ve\ Cur am Devel opnent .
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Setting up CDA for an assessment

For assessments that use Curam Decision Assist (CDA) to determine the assessment results, you
must set up CDA before you configure that assessment.

Configuring CDA assessments

You must define what information to collect, how it is stored, and how the information is acted on
to produce the assessment results.

Creating questionnaires

You must configure each of the questions that you want to ask, and set up the data store to capture
the responses.

Creating a questionnaire

Complete the following steps to create a questionnaire.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, and select Decision
Assist > New Questionaire.

2. From the New Questionnaire window, enter the following details to create a questionnaire.

Name Description

Name The name of the questionnaire.

Note: Do not specify an apostrophe in
the name of the questionnaire as it is not
supported.

Type Select the type of questionnaire from
the list. The list of types are stored in the
CT_DAQuest i onnai reType. ct x code table.

Comments Enter any relevant comments.

3. Click Save.

Questionnaire values specific for Independent Living
Specity the following values for configuring a questionnaire for Independent Living.

Name Value

Name Needs Assessment
Type Needs

Comments blank

Configuring a data store
You must have an appropriate data store schema to add data to the data store for IEG scripts that
capture information for outcome management assessments. The data store schema must include
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all of the required domain types and attributes. Complete the following steps to create a data store
schema.

About this task

You must include a minimum of two entities, the Application (parent entity) and Person (child
entity). You can include existing domain definitions so that the domain types can be used for
creating new attributes. In the example in the procedure, the Application entity incorporates the
Person entity.

Procedure

1. From the questionnaire tab, select ACTIONS and click Edit Question Script. In the Edit
Question Script tab that is displayed, the IEG Editor starts. By default, the IEG Editor tab
is displayed in the IEG Editor.

2.  Click the Datastore Editor tab to create a new data store schema.
3. Select the Includes section and click Include Schema.
4. From the Add Include window, select /[EGDomains from the drop-down list and click OK.
5. From the Entities section, click Add Entity and enter the following details.
Name Description Example Value
Name The name of the parent entity. Application

6. Click Add Entity to create a second entity and enter the following details.

Name Description Example Value
Name The name of the child entity Person
Key Attribute The primary key attribute. personiD

7.  From the Person entity, click Add Attribute to create the following attributes.

Table 32:
Name Description Example Value
Name The name of the attribute in the  personID
data store schema.
Domain Type The name of the domain SVR_KEY
definitions.

Repeat step 5 to add more attributes to the entity.

From the Application entity, click Add Child Entity.
10. From the Add Child Entity window, select Person from the drop-down list and click OK.
11. Select File > Validate Schema to validate the schema.

12. Select File > Save Schema to save the schema.

Data stores values for Independent Living
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Specify the following values for configuring new data store entities and attributes for Independent

Living.

Table 33: Parent entity values

Name Value
Name Application
Table 34: Child entity values
Name Value
Name Person
Key Attribute personiD
Table 35: Child entity attribute values
Name Domain Type
personiD SVR_KEY
firstName IEG_STRING
gender IEG_GENDER
dateOfBirth IEG_DATE
rolelD IEG_INT64
participantlD IEG_INT64
guestionsApplicableind IEG_BOOLEAN
hasCleanTidyHome IEG_YES_NO
sufferFromPressureSores IEG_YES NO
canManageFinances IEG_YES_NO
placelndividualOrOthersAtRisk IEG_YES_NO
displayDangerousBehaviourToOthers IEG_YES_NO
canWashSelf IEG_YES_NO
canFeedSelf IEG_YES_NO
canGetMedicineFoodHouseholdltems IEG_YES_NO
requiresAssistanceToToilet IEG_YES_NO
canWalkLongDistances IEG_YES_NO

Configuring a question script

You must configure a question script through the IEG editor to define the content and the

presentation of the questions in your questionnaire.
Configuring the question script properties
Complete the following steps for configuring the script properties.

Procedure

1. From the Edit Question Script window, IEG Editor tab, click Edit > Configure Script

Properties.

2. From the Configure Script Properties window, enter the following details.
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Name Description

Quit Page The identifier of the UIM page to which the user
is taken to when they click Save and Exit at any
stage within this script.

Finish Page The identifier of the UIM page to which the user is
taken to when no more pages are left to display
in the script. That is, when the user clicks Next on
the last page in the script.

Config Properties You can specify a properties file to use for
modifying the text and style that is used for
various components in the IEG Player.

Show Progress Bar When set to true, the progress bar is displayed at
the top of the page. If not specified, this attribute is
set to true by default.

Show Sections When set to true, the sections panel is displayed
on the left side of the page. If not specified, this
attribute is set to true by default.

Validate Save & Exit When set to false, the page validations and
mandatory validations are not performed when the
Save and Exit button is selected. If not specified,
this attribute is set to true by default.

Highlight Validation When set to true, the mandatory or domain
validation errors that are displayed at the top are
also repeated next to the failing question.

If not specified, the value is taken from the

script configuration properties (that uses the key
val i dati on. hi ghl i ght), and if not present, it
defaults to false.

If two questions on the page have the same label
(not recommended) and one of questions failed
the validation, both questions are highlighted.

Fast-Path When set to true, the Fast Path navigation is
turned on for all script elements on which it
applies. If not specified, this attribute is set to false
by default.

Hide Control Question When set to true, the label and value of questions
that control for loops are hidden once the loop it
controls is entered. If not specified, it defaults to
false and the question value is read-only.

3. Click OK.

Script properties values for Independent Living
Specify the following values for configuring the script properties for Independent Living.

Name Value

Quit Page AssessmentScript_exit

Finish Page AssessmentDelivery _executeAssessment
Config Properties ILDA _ieg-config

Show Progress Bar True
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Name Value
Show Sections True
Validate Save & Exit True
Highlight Validation False
Fast-Path False
Hide Control Question False

Configuring a section

You can configure sections to group related pages together in a logical flow. Sections can also
help to indicate progress through a script. Both the section and the question page can have a
title and the question page can optionally have a description. Complete the following steps for

configuring a section.

Procedure

1. From the Edit Question Script window, IEG Editor tab, click New Section.

2. From the Section Properties tab, enter the following details.

Table 36: New section properties

Name

Description

Title
Title ID

Enabled

Disabled

Selected

The localizable name of the section title.

The identifier is used to reference a text property
in the appropriate locale-specific properties file.

A reference to the image to use for a section when
it is enabled. If not specified, a default image is
used instead.

A reference to the image to use for a section when
it is disabled. If not specified, a default image is
used instead.

A reference to the image to use for a section when
it is the current highlighted section. If not specified,
a default image is used instead.

3. Select File > Validate to validate the script and make sure that there are no errors.
4. Select File > Save Script to save the IEG script.

Section values for Independent Living

Specify the following values for creating the 3 sections that are created for Independent Living.

Table 37: Health and Safety section properties

Name Value

Title Health and Safety

Title ID Section.TitleHealthAndSafety

Enabled NeedsAssessment_health.png

Disabled NeedsAssessment_health_disabled.png
Selected NeedsAssessment_health.png
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Table 38: Daily Routine section properties

Name Value

Title Daily Routine

Title ID Section.TitleDailyRoutine

Enabled NeedsAssessment_routine.png

Disabled NeedsAssessment_routine_disabled.png
Selected NeedsAssessment_routine.png

Table 39: Summary section properties

Name Value

Title Summary

Title ID Section.TitleSummary

Enabled NeedsAssessment_summary.png

Disabled NeedsAssessment_summary_disabled.png

Selected NeedsAssessment_summary.png
Configuring a page

When a section is created, a page is automatically created for you. You must configure a question
page to present the questions. A page can contain many clusters to logically group questions on
the page. Complete the following steps for configuring a page.

About this task
You can define the structure of your questions in a logical grouping so that answers to the
questions can be captured effectively.

Procedure

1. Expand the section, select New Page. A page is automatically created as part of the new
section creation.

2. From the Question Page Properties tab, enter the following details.

Name Description

Page ID The unique identifier for the page. The identifier
can be used to reference the page when you link
to it from another part of the script. Or when you
indicate what page to start at when reentering a
script.
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Name Description

Entity The name of an entity from the associated data
store schema. If used directly within a section,
the entity that is referenced on a page must be a
child of the root element within the schema. Any
attribute within a cluster on the page, which does
not have its own entity that is specified is assumed
to be an attribute of this entity.

When a page is used within a loop, there is no
need to set the entity on the page. It is only if it is
the same as the entity used for the loop itself.

Page.Title The title element is used to define the localizable
text.
Page Title ID Each title element has an identifier, which is used

to reference a text property in the appropriate
locale-specific properties file.

Page Description The description element can be used to add a
description to any titled element within a script.
The description element has an ID attribute,
which is used to reference a text property in the
appropriate locale-specific properties file.

Page Description ID An identifier for the description text, which is used
as a key with which to reference the text within the
associated properties file. The identifier must be
unique within the content in which it is used.

For example, if the description is added to a
cluster, then the identifier only needs to be unique
within the page in which the cluster is contained.
Another page can contain an identifier with the
same value.

Set Focus When set to false, the attribute indicates to the
IEG Player that no initial focus is set on the form.
If not specified, the attribute is set to true by
default.

3. Select File > Validate to validate the script and make sure that there are no errors.
4. Select File > Save Script to save the IEG script.

Question page values for Independent Living
Specify the following question pages for the associated sections that are created for Independent
Living.

Table 40: Health and Safety question page properties

The following values are specific for the page, which is created for the Health and Safely section.

Name Value

Page ID HealthAndSafetyPage
Entity Person

Page.Title Health and Safety
Page Title ID Groupl.Title
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Name Value

Page Description These questions are related to health and safety

Page Description ID Groupl.Description

Set Focus True

and whether the client's state of health compromises
their standard of living.

Table 41: Daily Routine question page properties

The following values are specific for the page, which is created for the Daily Routine section.

Name Value

Page ID DailyRoutinePage

Entity Person

Page.Title Daily Routine

Page Title ID Group2.Title

Page Description These questions are related to daily routine

Page Description ID Group2.Description
Set Focus True
Progress 50

and whether the client requires help performing
everyday tasks.

Configuring a summary page
You can configure a summary page to display the list of the clients answers in read-only for the

questions asked. The summary page is the last page displayed.

Procedure

1.
2.
3.

Expand the summary section, you can delete the default page created for the section.
Right-click on the summary section and select Add Summary Page.

From the New Summary Page, select the Question Page Properties tab, enter the following
details.

Name Description

Page ID The unique identifier for the page. The identifier
can be used to reference the page when you link
to it from another part of the script. Or when you
indicate what page to start at when reentering a
script.
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Name Description

Entity The name of an entity from the associated data
store schema. If used directly within a section,
the entity that is referenced on a page must be a
child of the root element within the schema. Any
attribute within a cluster on the page, which does
not have its own entity that is specified is assumed
to be an attribute of this entity.

When a page is used within a loop, there is no
need to set the entity on the page. It is only if it is
the same as the entity used for the loop itself.

Page.Title The title element is used to define the localizable
text.
Page Title ID Each title element has an identifier, which is used

to reference a text property in the appropriate
locale-specific properties file.

Page Description The description element can be used to add a
description to any titled element within a script.
The description element has an ID attribute,
which is used to reference a text property in the
appropriate locale-specific properties file.

Page Description ID An identifier for the description text, which is used
as a key with which to reference the text within the
associated properties file. The identifier must be
unique within the content in which it is used.

For example, if the description is added to a
cluster, then the identifier only needs to be unique
within the page in which the cluster is contained.
Another page can contain an identifier with the
same value.

Set Focus When set to false, the attribute indicates to the
IEG Player that no initial focus is set on the form.
If not specified, the attribute is set to true by
default.

4. Select File > Validate to validate the script and make sure that there are no errors.
5. Select File > Save Script to save the IEG script.

Summary page values for Independent Living
Specify the following summary page for the associated summary section that is created for
Independent Living.

Table 42: Summary page properties

The following values are specific for the page, which is created for the Summary section.

Name Value

Page ID SummaryPage
Page.Title Summary
Page Title ID Summary.Title
Set Focus True
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Name Value

Progress 100

Configuring a cluster
You must configure a cluster before you can add questions to a page. Clusters help to control the
layout of the questions on the page. You can add multiple clusters to logically group questions on
the page. Clusters might also contain a title and a description. Complete the following steps for
configuring a cluster.

Procedure

1. For the section, from the right-hand navigation toolbar, select the Add Cluster icon and drag
under the section description.

2. Select the Cluster Title arrow to display the Cluster Properties tab.

3. From the Cluster Properties tab, enter the following details.

Name Description

Cluster Title The title element is used to define the localizable
text.

Cluster Title ID Each title element has an identifier, which is used

to reference a text property in the appropriate
locale-specific properties file.

4. Select File > Validate to validate the script and make sure that there are no errors.

5. Select File > Save Script to save the IEG script.

Cluster values for Independent Living
Specify the following clusters on the associated pages that are configured for Independent Living.

Table 43: Health and Safety cluster values

The following values are specific for the cluster, which is created for the Health and Safety page.

Name Value
Cluster Title Health and Safety
Cluster Title ID Groupl.Title

Table 44: Daily Routine cluster values

The following values are specific for the cluster, which is created for the Daily Routine page.

Name Value
Cluster Title Daily Routine
Cluster Title ID Group2.Title

Table 45: Summary cluster 1 values

The following values are specific for the first cluster, which is created for the Summary page.

Name Value

Cluster Title Health and Safety
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Name Value
Cluster Title ID Groupl.Title
Cluster Entity Person

Table 46: Summary cluster 2 values

The following values are specific for the second cluster, which is created for the Summary page.

Name Value
Cluster Title Daily Routine
Cluster Title ID Group2.Title
Cluster Entity Person

Configuring a question
Questions must be given an identifier, which must correspond to one of the attributes of the entity
type the page is mapped to. Complete the following steps for configuring a question.

About this task

Any data to be stored in the data store must be associated with an attribute of an entity in the data
store schema to be used with this script. If all the questions on a page relate to the same entity, the
page can be mapped to that entity type. For example, the page can be mapped to the Person entity.

Procedure

1. For the cluster, from the right-hand navigation toolbar, select the Add Question icon and drag
in to the cluster.

2. Select the New Question to open the Question Properties tab.

3. From the Question Properties tab, enter the following details.

Name Description

Question Attribute The identifier of a question refers to the name
of the attribute that is used to store the answer
to the question within the data store. The entity
to which the attribute belongs is taken from the
cluster, which contains the question or the page
that contains the cluster.

For example, if the question is contained within a
cluster on a page, which has the entity Address
that is specified for the cluster and Person that

is specified for the page. The ID of the question
is 'firstName', then the answer to the question is
stored in Address.firstName. If the cluster had no
entity that is specified, the answer to the question
is stored in Person.firstName.

Mandatory Specifies whether you must provide an answer
to a question. If set to true, the asterisk is
placed beside the question to indicate that it is
mandatory. Validations are performed when the
user clicks the Next button to ensure that an
answer is provided for the question.
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Name Description

Question Label The label element is used to define the label
text for any question or answer within a script.
Each label element has an ID, which is used to
reference a text property in the appropriate local-
specific properties file.

Question Label ID An identifier for the label text, which is used as
the key with which to reference the text within the
associated properties file. The ID must be unique
within the page in which it is used.

Question Help Text The help-text element is used to specify the
help text for a cluster, specify the help text for a
question within a script or specify the help text for
row level help for lists. Help text can be displayed
in two ways for clusters, at a cluster level and at a
question level.

When you run an IEG script, the help text for each
question within a cluster is combined with the
overall help text for the cluster itself to create a
help panel within the cluster. Help can also be
displayed at the question level, in this case a help
icon is displayed alongside a question.

Question Help Text ID The identifier of a question refers to the name of
the attribute that is used to store the answer to the
question within the data store.

4. Select File > Validate to validate the script and make sure that there are no errors.

5. Select File > Save Script to save the IEG script.

Question values for Independent Living
Specify the following questions inside the clusters that are created for each section that is
configured for Independent Living. The help text for each question is displayed at the cluster
level within a cluster. The help text is combined for all the questions with the overall help text for
the cluster itself to create a help panel within the cluster.

Table 47: Health and Safety cluster question values

The following values are specific for the 5 questions, which are created for the Health and
Safety cluster on the Health and Safety page.

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
hasCleanTidyHomE&ue Is the home Q1l.Label Is the home tidy Q1.HelpText
clean and tidy? and are kitchen
utensils clean?
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Question
Attribute

Mandatory

Question Label Question Label Question Help Question Help

ID

Text Text ID

sufferFromPressufie8eres

canManageFinancesie

placelndividualOrQtersAtRisk

displayDangerousBelgaviourToOthelBoes the

Does the client  Q2.Label
suffer from
pressure sores?

Is the client able Q3.Label
to manage their

own financial

affairs?

Does the client's Q4.Label
lifestyle place

them or others

at risk?

Q5.Label
client display

dangerous

behavior

towards others?

Pressure sores Q2.HelpText
are areas of
damaged skin
that is caused
by staying in
one position
for too long.
You are at

risk if you are
bedridden, use
a wheelchair,
or are unable
to change your
position.

Can the client
manage paying
bills, look after
their money and
budget?

Q3.HelpText

An example
might be where
client drives a
car but has poor
vision.

Q4.HelpText

Client threatens Q5.HelpText
people or

is verbally

abusive.

Table 48: Daily Routine cluster question values

The following values are specific for the 5 questions, which are created for the Daily Routine
cluster on the Daily Routine page.

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
canWashSelf True Can the Q6.Label Is the client Q6.HelpText
client wash capable of
themselves? taking a bath or
shower without
assistance?
canFeedSelf True Can the Q7.Label Is the client Q7.HelpText
client feed capable
themselves? of feeding

themselves or
do they require
assistance?
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Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
canGetMedicineFdodélouseholditen@an the client Q8.Label Is the client Q8.HelpText
obtain food, capable of
medicines, doing their
and household own shopping?
items? This includes
preparing
shopping lists,
getting to and
from the shops,
and managing
money.
requiresAssistanca@tod oilet Can the client Q9.Label Is the client Q9.HelpText
access the capable of
toilet without going to and
assistance? from, and using,
the toilet without
assistance?
canWalkLongDistdmaes Can the client Q10.Label Client cannot Q10.HelpText
walk long walk long
distances distances
without without tiring
assistance? quickly.

Table 49: Summary cluster 1 question values

The following values are specific for the 5 questions, which are created for the first Summary

cluster on the Summary page.

sufferFromPressur@8eres

canManageFinancasie

clean and tidy?

Does the client  Q2.Label
suffer from
pressure sores?

Is the client able Q3.Label
to manage their

own financial

affairs?

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
hasCleanTidyHonmEgue Is the home Q1.Label Is the home tidy QJ1.HelpText

and are kitchen
utensils clean?

Pressure sores Q2.HelpText
are areas of
damaged skin
that is caused
by staying in
one position
for too long.
You are at

risk if you are
bedridden, use
a wheelchair,
or are unable
to change your
position.

Can the client
manage paying
bills, look after
their money and
budget?

Q3.HelpText
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Question
Attribute

Mandatory

Question Label
ID

Question Label

Question Help
Text

Question Help
Text ID

placelndividualOrQtersAtRisk

displayDangerousBelgaviourToOthelBoes the

Does the client's Q4.Label
lifestyle place

them or others

at risk?

Q5.Label
client display

dangerous

behavior

towards others?

An example
might be where
client drives a

car but has poor

vision.

Q4.HelpText

Client threatens Q5.HelpText

people or
is verbally
abusive.

Table 50: Summary cluster 2 question values

The following values are specific for the 5 questions, which are created for the second Summary

cluster on the Summary page.

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
canWashSelf True Can the Q6.Label Is the client Q6.HelpText
client wash capable of
themselves? taking a bath or
shower without
assistance?
canFeedSelf True Can the Q7.Label Is the client Q7.HelpText
client feed capable
themselves? of feeding
themselves or
do they require
assistance?
canGetMedicineFdodélouseholditentan the client Q8.Label Is the client Q8.HelpText
obtain food, capable of
medicines, doing their
and household own shopping?
items? This includes
preparing
shopping lists,
getting to and
from the shops,
and managing
money.
requiresAssistanca@Tud oilet Can the client Q9.Label Is the client Q9.HelpText
access the capable of
toilet without going to and
assistance? from, and using,
the toilet without
assistance?
canWalkLongDistdmaoes Can the client Q10.Label Client cannot Q10.HelpText
walk long walk long
distances distances
without without tiring
assistance? quickly.

Configuring the cluster layout of the assessment
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You can configure a cluster layout where you have a high degree of control over what is
presented to the user, with the goal of presenting a friendly, intuitive user interface. Complete the
following steps for configuring the cluster layout for your IEG script.

About this task

The default appearance of a cluster is to display all the questions it contains in one column. The
questions are displayed in the order in which they are defined in the script. The label and input
field or value each taking 50% of the available width. To change the default appearance, a layout
element can be added to the cluster.

Procedure

1. For the cluster, from the Cluster Properties tab, select the Layout Properties section.

2. From the Layout Properties window, select the following details to configure cluster width
and alignment.

Name Description

Layout Type The type element is used within a layout element
for a cluster to control the layout of labels in
relation to input controls. You can select on of the
following types:

« flow - A cluster that uses this layout displays
the questions from left to right, top to bottom,
with the labels always appearing to the left of
the input control or value.

¢ compact-flow - The compact-flow behaves
in much the same way but with the label
displayed above the input control or value. You
can fit more columns into a cluster than if the
labels and input controls were side-by-side.

Num Cols The num-cols element is used within a layout
element for a cluster to control the number of
columns within that cluster. Each column consists
of both labels and input controls or values for
each question. The default number of elements to
display in a column is 1.

Label Width You can alter the label width by altering the
percentage of the available column that is given to
the label of a question from its default of 50%.
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Name Description

Label Alignment The label-alignment element is used within
a layout element for a cluster to control the
alignments for the text within all the labels for that
cluster. You can select one of the following label-
alignment options:

« right - to align the text to the right within
the space that is allocated to the label (the
default).

¢ left - to align the text to the left within the
space that is allocated to the label.

e center - to align the text to the center within the
space that is allocated to the label.

Cluster Width You can alter the width of the cluster by altering
the percentage of the available width of the page,
which the cluster uses from its default of 100%.

3. Select File > Validate to validate the script and make sure that there are no errors.

4. Select File > Save Script to save the IEG script.

Cluster layout values for Independent Living
Specity the following values for configuring the cluster layout for the needs assessment IEG
script for Independent Living.

Table 51: Cluster layout values

Name Value
Layout Type flow
Num Cols blank
Label Width 70
Label Alignment right
Cluster Width blank

Releasing a questionnaire
You must release your questionnaire to make it available for selection. Complete the following

steps to release a questionnaire.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, and select Decision
Assist.

2. From the list of questionnaires, select the questionnaire that you want to release. A new tab
opens for the selected questionnaire.

3. Select ACTIONS > Release > Yes.
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Updating a released questionnaire
To modify a questionnaire after it is released, you must create a new version of the questionnaire.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Decision
Assist.

2. From the list of Questionnaires, select the questionnaire that you want to release which opens
up in a new tab.

3. Select ACTIONS > New Version > Yes.

Configuring an assessment matrix

You must configure assessment rules in a CDA matrix to determine the logic for each outcome
that you need.

Configuring an assessment matrix outcome

An assessment matrix outcome is a result that can be obtained from a particular decision matrix.
The combination of outcome and decision matrix type, and score where appropriate, are what
constitutes a determination result. Complete the following steps for configuring an outcome for
an assessment matrix.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Decision
Assist > New Outcome.

2. From the New Outcome window, enter the following details.

Name Description

Name The name of the outcome.

Type The type of the outcome, which is specified in the
CT_DACut coneType. ct x code table.

Start Date The start date of the outcome.

End Date The end date of the outcome.

Comments Comments relating to the outcome.

3. Click Save.

Outcome values for the needs assessment matrix for Independent Living
Specify the following values for configuring an outcome for the needs assessment matrix for
Independent Living.

Table 52: Daily Routine outcome values

Name Value

Name Daily Routine
Type Needs

Start Date 3/1/2015
End Date blank
Comments blank
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Table 53: Health and Safety outcome values

Name Value

Name Health and Safety
Type Needs

Start Date 4/1/2015

End Date blank

Comments blank

Creating a CDA assessment configuration

You must create a CDA assessment configuration to associate the assessment questionnaire with
an assessment type. Complete the following steps for configuring the questionnaire association
with the assessment configurations.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select OQutcome
Management > CDA Assessment Configurations > New.

2. From the New CDA Assessment Configuration window, enter the following details.

Name Description

Name The name of the assessment configuration. The
assessment configurations are selected as part of
the creation of an assessment definition.

Question Script You must preconfigure a question script in order
for the question script to be available for selection
in this drop-down list. Only released question
scripts are available for selection.

3. Click Save.

Assessment configuration values for Independent Living
Specify the following assessment configuration values for Independent Living.

Table 54: CDA assessment configuration values

Name Value
Name Needs Assessment Config
Question Script Needs Assessment Questionnaire

Configuring a CDA matrix
You can define the rules to determine a particular outcome when the assessment is run. Complete
the following for configuring a decision matrix.

Procedure

1. From the created CDA assessment configurations, select the action icon and click Add
Decision Matrix.

2. From the Add Decision Matrix window, enter the following details for creating a new
decision matrix.
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Name Description
Name The name of the Decision Matrix Version.
Type The type of the Decision Matrix Version.

The types are configured in the
CT_DADeci si onMat ri xType. ct x code table.

Scoring By Outcome The indicator to determine whether the matrix is
needed to produce a score for the answers that
are used to reach each outcome.

Multiple Outcomes The indicator to determine whether the matrix can
produce multiple outcomes.

Comments The comments that are entered by the user.

3. Click Save.

CDA matrix values for Independent Living
Complete the following values for configuring a CDA matrix for Independent Living.

Name Value

Name Needs Assessment Matrix
Type Needs

Scoring By Outcome Yes

Multiple Outcomes Yes

Comments blank

Editing the CDA matrix

You must edit the decision assist matrix to define the logic that is applied to assessment response.
The questions in the question script are available for selection. The questions are displayed in the
decision matrix editor, which was pre-configured in the question script.

Procedure

1. From the created CDA assessment configurations, select the decision matrix link to open the
CDA matrix tab.

2. From the CDA matrix tab, select the action icon and click Edit Matrix to open the editor.

3. From the Create Matrix window, for the Add Questions step, select the check box for the
questions you wish to include and click Next.

4. From the Add Outcomes step, select the check box for the outcome you wish to include and
click Next.

5. From the Add Options step, select the options that you wish to include and click Create
Matrix.

6. Click Save.

Matrix values for Independent Living
Specify the following values to be configured a new matrix for Independent Living.

Table 55: Question selected

Select all 10 questions to be included in the CDA matrix.
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Questions

Is the home clean and tidy?

Does the client suffer from pressure sores?

Is the client able to manage their own financial affairs?

Does the client's lifestyle place them or others at risk?

Does the client display dangerous behavior towards others?
Can the client wash themselves?

Can the client feed themselves?

Can the client obtain food, medicines, and household items?
Can the client access the toilet without assistance?

Can the client walk long distances without assistance?

Table 56: Outcomes selected

Select the following outcome to be included in the CDA matrix.

Outcomes

Health and Safety
Daily Routine

Table 57: Options selected

Select the following option to be included in the CDA matrix.

Options

Scores

Configuring the scores and outcome combinations for the CDA matrix
For each question in the CDA matrix, complete the following steps to configure the scores and
outcome combinations.

Procedure

1. From the decision matrix editor, enter a score value for each of the questions in the Scores
column.

2. From each of the outcomes column, select the down arrow and click Add Combination.

3. From the combination column, enter the outcome combinations for each possible answer for
each question that is specified for each outcome.

4. Click Validate to validate the matrix.
5. Click Save to save the matrix.

6. From the decision matrix tab, select the action icon and click Release to release the decision
matrix.

Matrix score values for Independent Living
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Specify the following scores for the Yes/No answers and the different combinations for each
question.

Table 58: Health and Safety questions score values

Question  Question Answers Scores
Number
Q1 Is the home clean and tidy? Yes 0
No 1
Q2 Does the client suffer from pressure Yes 2
sores?
No 0
Q3 Is the client able to manage their own Yes 0
financial affairs?
No 4
Q4 Does the client's lifestyle place them  Yes 8
or others at risk?
No 0
Q5 Does the client display dangerous Yes 16
behavior towards others?
No 0
Table 59: Daily Routine questions score values
Question  Question Answers Scores
Number
Q6 Can the client wash themselves? Yes 0
No 1
Q7 Can the client feed themselves? Yes 0
No 2
Q8 Can the client obtain food, medicines, Yes 0
and household items?
No 4
Q9 Can the client access the toilet without Yes 0
assistance?
No 8
Q10 Can the client walk long distances Yes 0
without assistance?
No 16

Table 60: Health and Safety questions answer combination (C) values

Ques ArCICzCiCLCECECICECECICICICICICICICICICICzczczczczczczczczczceciep2
Num

Q1 YeJru€ru€ruéru€ruéru€ruéruéruéru€ruéruéru€ruéruérue

No TruBrurururueruerueruerueruerueruerurueruerpe
Q2 YeJru€ru€ru€ru€ruéru€ruérue TruBruEruErueruerueruérue

No Tru€ru€ruéruéruéruéruérue TruBrugrukrukrukrueruerpe
Q3 YeJru€ru€ruérue Tru€ruéruérue TruBrueruérue TruBrueruérue

No Tru€ruéruérue Truéruéruérue Trugrugruerue Trukrugruerpe

Q4 YeJruérue Tru€rue Tru€rue Tru€rue TruBrue TruBrue TruBrue TruBrue
No Tru€rue Tru€rue Tru€rue Tru€rue Tru€rue Tru€rue Tru€rue TruErpe
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Ques ArClCzCzCsCECeECICECECICICICICICICICICICcICczczczczczcczczcaczcicecies2
Num

Q5 YeJrue True True True True True True True True True True True True True True True

No True True True True True True True True True True True True True True True True

Table 61: Daily Routine questions answer combination (C) values

Ques ArCICzCICLCECECICECECICICICICICICICICICICzczczczczczczczczczcicicy2
Num

Q6 YeJru€ru€ru€ruéruéruru€ru€ru€ru€ruéruerueruéruérue

No TruBrururururueruerueruerururururueruerpe
Q7 YeJru€ru€ru€ruéruéruéruérue TruBru€ru€rueruerueruérue

No Truéruéruéruéruéruéruérue TruBrukrukrukrutrugruerpe
Q8 YeJru€ruéru€rue Tru€ru€ru€rue TruBruéruerue TruEruerutrue

No Truéruéruérue Truéruéruérue Trugruérukrue Trukrugruerpe

Q9 YeSru€rue Tru€rue Tru€rue Tru€rue TruBrue TruBrue Tru€rue Tru€rue
No Tru€rue Tru€rue Tru€rue Tru€rue TruBrue TruBrue TruBrue Truérue
Q10 YeSrue True True True True True True True True True True True True True True True

No True True True True True True True True True True True True True True True True

Saving your CDA assessment configurations

You must save your configurations.

Quick reference for saving CDA assessment configuration files

Reference table for all files that are associated with saving your CDA assessment configuration
files.

The following descriptions detail each column of the reference table and what their purpose is.

» Task Name: The name of the current task.

» Data Contained In: The relevant file or files in the #CURAM DI R\ %&JBSer ver \ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
Y%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

+ Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R\ %EJBSer ver \ bui | d\ dat aext ract or folder for each task.

» Files To Be Created: A list of files that need to be created by the user for each task.

Table 62: CDA Assessment File Reference Table

Task Name Data Contained In Files To Be Copied Files To Be Created

From Data Extractor
Saving your QUESTI ONNAI RE. dmxQUESTI ONNAI REVERSI ON. dfrx
guestionnaire

configuration files

Saving your data store DATASTORESCHENA. dnx
configuration files

Saving your question | EGSCRI PTI NFO. dnx APPRESOURCE. dmx QUESTI ON. dix
script configuration files
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Task Name

Data Contained In Files To Be Copied Files To Be Created
From Data Extractor

Saving your assessment
matrix outcome
configuration files

Saving your association
between the
guestionnaire and

the assessment
configuration

Saving your decision
matrix configuration files

DAQUTCOVE. dimx

DAASSESSMENTCONFI GURATI ON. dimx

DECI SI ONVATRI X. dnxDECI SI ONVATRI XVERSI ON| dmx DMQUEST

Saving your questionnaire configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.
2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext ract or directory, copy the

following DMX files.

File name

Description

QUESTI ONNAI RE. dnx

QUESTI ONNAI REVERSI ON. dirhis entity holds details of a questionnaire version. There can be multiple

This entity holds details of questionnaires, the answers to which help
decide how to determine a client's needs.

versions of a questionnaire over time, as questions can be added /
removed from the questionnaire.

Note: %CURAM DI R%is the Cliram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. Update the files so that they only contain the new configurations.
4. From “CURAM DI R EJBSer ver, run bui | d dat abase.

5. Save your configuration files.

Questionnaire configuration files for Independent Living
The Independent Living questionnaire configuration files are in the following location in the

accelerator.

Table 63: DMX files

File name

Location

QUESTI ONNAI RE. dnx

QUESTI ONNAI REVERSI ON. dnx

%CURAM DI R4 EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Curam installation directory, which by default
is C: \ Mer ati ve\ Cur am Devel opnent .
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Saving your data store configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

DATASTORESCHEMA. dnx  This entity holds the schema document that defines the structure of a
data store.

Note: %CURAM DI R%is the Cliram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

3. Inside the file DATASTORESCHENMA. dnx, you must find the attribute entry where
schemaName="NeedsAssessmentV1" .

F N

. Search for the file that is specified for the attribute schemaText in the cl ob folder and change
it to NeedsAssessmentV'1.xsd.

Update the reference inside DATASTORESCHEMA. dnx to point to this modified file name.

Update the relative path of the schemaText file to point to . / COVPONENT _NAME/ dat a/
initial/clob.

7. From “CURAM DI R EJBSer ver, run bui | d dat abase.

8. Save your configuration files.

AN

Data store configuration files for Independent Living
The Independent Living data store configuration files are in the following location in the
accelerator.

Table 64: DMX files

File name Location

DATASTORESCHENA. dnx %CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Curam installation directory, which by default
is C:\ Mer ati ve\ Cur am Devel opnent .

Table 65: Clob files

File name Location

NeedsAssessnent V1. xsd % CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial\clob
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Saving your question script configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1.  Extract the DMX files from the database with the ext r act dat a build target.

2. From the “CURAM DI R% EJBSer ver\ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

| EGSCRI PTI NFO. dnx This entity stores the IEG script definitions.

APPRESOURCE. dmnx This entity stores the application resources, such as properties and
image files.
QUESTI ON. dnx This entity stores the details of the questions that are associated with

the questionnaire.

Note: % CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. Inside the file | EGSCRI PTI NFO. dnx, you must find the attribute entry where
scriptID="NeedsAssessmentV1" .

4.  Search for the file that is specified for the attribute scriptDefinition in the cl ob folder and
change it to NeedsAssessmentV1.xml.

Update the reference inside | EGSCRI PTI NFO. dnx to point to this modified file name.

Update the relative path of the scriptDefinition attribute to point to . / COMPONENT_NAME/
data/initial/clob.

7. Inside the file APPRESOURCE. dnx, you must find the attribute entry where name has a
value that starts with NeedsAssessmentV1.

8.  Search for the file that is specified for the attribute content in the cl ob folder and change it
to be the same as the name. Add a .properties extension to the file.

9. Update the reference inside APPRESOURCE. dnx to point to this modified file name.

10. Update the relative path of the scriptDefinition attribute to point to . / COVMPONENT _NAME/
data/initial/clob.

11. From “CURAM DI R% EJBSer ver , run bui | d dat abase.

12. Save your configuration files.
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Question script configuration files for Independent Living
The Independent Living question script configuration files are in the following location in the
accelerator.

Table 66: DMX files

File name Description Location

| EGSCRI PTI NFO. dnx This file includes the reference to %CURAM DI R% EJBSer ver \ conponent s
the NeedsAssessnent V1. xmi \'I ndependent Li ving\data\initial

IEG script file.

APPRESOURCE. dmx  Includes the reference to Note: %CURAM DI Ro%is the Clram
multiple image files and IEG installation directory, which by default is C:
script properties files specific to \ Merat i ve\ Curam Devel opment .

Independent Living.

Table 67: IEG script files

File name Description Location

NeedsAssessnmenThé sgript that is written for %CURAM DI R% EJBSer ver \ conponent s
Independent Living was relatively \ | ndependent Li vi ng\data\initial\clob
small, when compared to the
large-scale scripts. It contains the
following sections:

* Health and Safety
» Daily Routine
e Summary

There are only 5 questions on
each of the Health and Safety
and Daily Routine pages.

. NeedsAssessTe6¢PraPesiefiles SRASHY Hie pr ofd/RAMDI R EJBSer ver\ conponent s

. NeedsAssessrtrtlné)ﬁt{.tb/it it dl{%oé?%%dﬂwﬁsgsafgg _Hea}lItmdﬁpoagaqeeqtyl'ﬁé/dengp}rdoaﬁear\t'ine'st hal \ bl ob
seéction and the finish and qui ) ) )

. NeedsAssess%@E\{&e,qmggghFé gb@cﬁﬁé&t_ml | yRout i nePage. properties

* NeedsAssessnent V1_1 Deci si onAssi st _Sunmar yPage. properti es

Saving your assessment matrix outcome configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

DAQUTCOVE. dnx The result that can be obtained from a particular decision matrix.

Note: % CURAM DI R%is the Caram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.
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4. Save your configuration files.

Assessment matrix outcome configuration files for Independent Living
The Independent Living assessment matrix outcome configuration files are in the following
location in the accelerator.

Table 68: DMX files

File name Location
DAQUTCOVE. dnx Y%CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Ciram installation directory, which by default
is C: \ Mer at i ve\ Cur am Devel opnent .

Saving your association between the questionnaire and the assessment
configuration
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext ract or directory, copy the
following DMX files.

File name Description

DAASSESSMENT CONFI GURATA Ebhfijocation for a type of assessment that can be executed to assess
a client by using a decision matrix.

Note: % CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.
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Association configuration files between a questionnaire and assessment in Independent
Living

The configuration files associating a questionnaire with a decision matrix in Independent Living
are in the following location in the accelerator.

Table 69: DMX files

File name Location

DAASSESSMENT CONFI GERAANDYDI dRvx
% EJBSer ver
\ conponent s
\'I ndependent Li vi ng
\data\initial

Note:
%CURAM DI R
%is the Clram
installation
directory, which
by default is C:

\ Merative

\ Cur am

\ Devel opnent .

Saving your decision matrix configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.
2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the

following DMX files.

File name Description

DECI SI ONVATRI X. dnx The decision matrix allows the user to define the rules used
to a achieve outcomes.

DECI SI ONVATRI XVERSI ON. dnx A decision matrix defines the rules by which a determination
configuration can reach a particular outcome.

DMQUESTI ONLI NK. dimx This entity stores details of questions that are used in a
decision matrix version.

DMOUTCOMELI NK. dnx This entity stores details of the relationship between an
outcome and a decision matrix version.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:

\ Mer at i ve\ Cur am Devel opnent .

3. Inside the DECI SI ONMATRI XVERSI ON. dnx file, search for the file that is specified for the
attribute matrixData in the cl ob folder.

4. Rename the file in the ¢l ob folder to NeedsAssessmentMatrix.xml.
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5. Update the reference inside the DECI SI ONMATRI XVERSI ON. dnx file to point to this
modified file name.

6. Update the relative path of the matrixData attribute to point to . / COVPONENT _ NANVE/
data/initial/clob.

7. From %CURAM DI R% EJBSer ver,run bui | d dat abase.

8. Save your configuration files.

Decision matrix configuration files for Independent Living
The decision matrix configuration files for Independent Living are in the following location in the
accelerator.

Table 70: DMX files

File name Location

DECI SI ONVATRI X. dnx %CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
DECI S| ONVATRI XVERS! ON, dind' 1 &

DMQUESTI ONLI NK. dnx Note: %CURAM DI R%is the Clram installation directory, which by default
DVOUTCOVEL | NK. drmx is C:\ Mer at i ve\ Cur am Devel opnent .

Table 71: Clob files

File name Location

NeedsAssessnent Mat ri x. YGURAM DI RvA EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial\clob

Configuring assessments

Complete the following tasks to configure an assessment to capture data about a client to
determine the severity of the client's needs.

Configuring assessments

You must define the assessment through configurations in the administration workspace.

After you define assessments, they are available to run. Running the assessment identifies and
determines the severity of the client's needs.

Configuring assessment definitions

You configure an assessment definition to manage and determine how the assessment results are
displayed.

Assessment definitions

You must configure an assessment definition to manage the way that the assessment is based and
to determine the way the assessment results are displayed.

A number of configuration settings are provided for an assessment definition. These settings
allow an administrator to specify how assessments that are based on this assessment definition are
managed and how the assessment results are displayed.

The following determine the way assessments that are based on this assessment definition are
managed.
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» Assessment Interval Days

* Reassessment Warning Days

* Assessment Configuration

* Approval Check Percentage

* Type drop-down list

* Role Change Allowed indicator
* Reassessment Allowed indicator

* Security Identifiers

The remaining configuration options determine the way the assessment results are displayed
when a client is assessed.

* Group name field

* Display Graphs indicator

* Graph By drop down list

* Priorities Applicable indicator

* Graph Type drop down list

* Display Guidance indicator

* Group Results By Category indicator
» Display Score Indicator

* Guidance Result Cluster drop down list
* Factor Display Text

* Classification Display Text

* Count Same Score As One Priority

The Results Page field allows the default assessment results page to be overridden with a
different page if required.

Configuring an assessment definition
An assessment definition is the template on which an individual assessment is based. Complete
the following steps to configure an assessment definition.

About this task

You can use assessments to identify the needs of clients and to enable the development of an
outcome plan to address those needs. An assessment can be run for a group of clients that results
in one result. Or it can be run for one or more clients that results in one result for each client. An
assessment can be run by using Ctiram Decision Assist (CDA) or Curam Express Rules (CER)
and is defined in the assessment definition configurations.

Procedure
1. Select the Administration Workspace tab, expand the Shortcuts menu, select Qutcome
Management > Assessment Definitions > New Assessment Definition....

2. From the New Assessment Definition window, enter the following details to create a new
assessment definition.

Name Description

Name The localizable name of the assessment definition.
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Name Description

Reference A reference field so that the assessment
definitions can be referenced within code.
The reference field is unique across all active
assessment definitions.

Start Date The date that the assessment is effective from.

Reassessment Warning Days The reassessment warning works with the
assessment interval. You can use this to alert the
caseworker who ran the last assessment that a
reassessment is due.

For example, the reassessment warning days
might be set to 5 days. In this case, a task can be
created 5 days before the reassessment due date
and assigned to the caseworker who last ran the
assessment.

Assessment Interval Days The Assessment Interval represents the frequency
at which an assessment might be run.

It is used to calculate the reassessment due date
of an assessment. For example, if an assessment
is run on the 01/01/2015 and the Assessment
Interval is set to 30, the reassessment due date is
31/01/2015.

Assessment Configuration The unique identifier of the assessment to run. For
example, the CDA or CER assessment identifier.

Type The type of assessment to run, for example
role-based assessments. For the role-based
assessments, the questions to be asked of each
role while for group-based assessments the
questions to be asked for the group.

Group Name The localizable name of the group to be displayed
when the group-based assessments are
configured.

Role Change Allowed Specifies whether the roles defined for the

assessment can be changed on reassessment.

When role changes are allowed, the Select
Clients and Roles page is displayed during
reassessment and the caseworker can change the
assessment roles.

When role changes are not allowed, the Select
Clients and Roles page is not displayed during
reassessment.

Note: Role changes are not allowed for
reassessment purposes if only one role is
defined for the assessment definition and only
one client exists on the assessment.
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Name Description

Reassessment Allowed Reassessment allows a client's progress
for specific factors to be measured over
time. Reassessment is applicable to some
assessments. Certain assessments can be
reassessed multiple times. Other assessments are
run only once.

When the Reassessment Allowed indicator is
selected, an option to reassess the assessment
is displayed on the assessment home page. This
option allows a caseworker to either reassess
for all of the factors that are defined for the
assessment or reassess for a subset of factors
only.

If the Reassessment Allowed indicator is not
selected, the reassess option is not displayed on
the assessment home page and the assessment
cannot be reassessed.

Display Graphs Specify true to display graphs for this assessment
definition or false to display a list.

Graph By If you are displaying graphs for the assessment
definition, specify whether the graphs are based
on classifications or scores.

Graph Type Dictates the type of graph to be displayed for this
assessment definition. For example, a bar chart or
spider graph. It is only applicable in the instance
where the display graph indicator is set to true.

Priorities Applicable Indicates whether priorities apply to the
assessment.
Display Guidance Indicates whether guidance is displayed for this

assessment definition. If it is set to true, the
guidance is displayed for the assessed factors
otherwise no guidance is displayed.

Group Results By Category Indicates whether the results of an assessment
are displayed by category, or by classification.
It is only applicable in the instance where only
one category is configured for the assessment
definition, and applies only to the priority results
list.
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Name Description

Display Score The Display Scores option indicates whether
scores can be displayed in the assessment
results. When this option is selected, the
assessment scores are displayed in the
assessment results. When this option is not
selected, the scores are not displayed.

In certain circumstances, an administrator might
not want to display scores in the assessment
results. For example, a risk assessment might
have 6 factors that are defined, only 3 of the
factors are based on the score. The caseworker
might only be interested in the classification that is
determined from the score.

Guidance Result Cluster Holds the identifier that indicates whether the
guidance result cluster is to be displayed by
default as open or closed.

Factor Display Text The term factors might be named differently from
agency to agency. For example, a factor might be
called a dimension or a domain. To cater for this,
the Factor Display Text is provided which allows
an administrator to define the names to appear in
the assessment results for the factor.

Classification Display Text The term classification might be named
differently from agency to agency. For example,
a classification might be called a rating or result.
To cater for this, the Classification Display Text is
provided which allows an administrator to define
the names to appear in the assessment results for
the factor.

Count Same Score As One Priority Indicates whether the same factor score that is
achieved by more than one client can be counted
as a single priority factor.

Result Page It enables an agency to override the default
assessment results page if they need to do so. It
is only applicable if graphs are not displayed.

Security Identifiers When a user attempts to click particular
operations on an assessment, the system does a
check to ensure that the user has the appropriate
privileges to run a particular action.

Categories After a new category is configured on the
category code table, you can select one or more
of the categories by selecting them when the
assessment definition is created.

3. Click Save.

Assessment definition values for Independent Living
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Specify the following values for configuring an assessment definition for Independent Living.

Table 72: Assessment definition values

Assessment Interval Days

Assessment Configuration

Reassessment Warning Days

Name Value

Name Needs Assessment
Reference NeedsAssessment
Start Date Current date

5
90

Needs Assessment Config

Type Role based

Role Change Allowed Yes

Reassessment Allowed Yes

Display Graphs Yes

Graph By Graph by Classification
Graph Type Bar

Priorities Applicable Yes

Display Guidance Yes

Group Results By Category No

Display Score Yes

Guidance Result Cluster Closed

Factor Display Text Needs Assessed
Count Same Score As One Priority No

Result Page AssessmentDelivery_viewResultsForinstance

Configuring roles

You configure a role for an assessment definition to target questions at certain clients. Assigning
clients to a role ensures that you can ask them the appropriate questions.

Assessment roles

An assessment role represents the part that a client plays in terms of an assessment. For example,
an assessment might be assessing a client in their role as Primary Caregiver or as a Secondary
Caregiver.

Configuring an assessment role

You must assign at least one role to each assessment definition. Complete the following steps to
configure roles for an assessment definition.

About this task

You must define at least one role for an assessment before it can be run, but multiple roles can

be configured. You can configure the role such that multiple clients can fill that role during

an assessment. You can specify the role as mandatory. It means that at least one client must

be specified for the role before the assessment can be carried out by a caseworker. You must
decide which questions are applicable to each role. If you decide that questions are not applicable
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to a role, then those questions are not presented to the client who fulfills that role during the
assessment. You must also decide the order in which roles are processed in an assessment.

You must decide whether an abbreviation is specified for an assessment role, which can then be
displayed in the assessment results rather than displaying the full name of the role.
Procedure

1. From the assessment definition, select the Roles tab and click New Role....

2. From the New Role window, enter the following details to create a new role.

Name Description

Type The role an individual has regarding an
assessment, for example, Primary Caregiver,
Secondary Caregiver. The specification of roles
for an assessment is mandatory.

Type Abbreviation Abbreviation of the role type. An abbreviation can
be specified for an assessment role. If multiple
roles exist in an assessment and displaying the
name of each role might take up too much space,
use the abbreviation.

For example, the role of “Primary Caregiver” can
be abbreviated to “PC”.

Reference A reference field that allows the assessment role
to be reference from within code. The reference
field is unique across all active roles for an
assessment definition.

Mandatory Indicates whether a client must be specified for
the role when the assessment is run.

For creating an assessment role, you can specify
that the role is mandatory. It means that a

client must be selected for that role before the
assessment can be run. Mandatory roles must be
filled before an assessment can proceed.

Multiple Clients Indicates whether the assessment role applies to
multiple clients or not.

An administrator can define that multiple clients
can fulfill a role. It means that multiple clients
can be selected for the same role when you are
running an assessment.
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Name Description

Questions Applicable Indicates whether the assessment questions are
asked for this role in the assessment script.

For some cases, questions are not asked of
clients that are fulfilling a particular role.

For example, in the CSN assessment, the role of a
focus child does not require questions to be asked
of the child. Administrators can specify whether
questions are asked of a client that is fulfilling a
particular role.

Note: If the assessment type is group-based,
then this indicator is not applicable.

3. Click Save.

Assessment role values for Independent Living
Specify the following values for configuring an assessment definition role for Independent
Living.

Table 73: Assessment definition role values

Name Value

Type Claimant Role
Type Abbreviation Claim Role
Reference blank
Mandatory Yes

Multiple Clients No

Questions Applicable Yes

Reordering an assessment role
You can configure the order in which roles can be processed in an assessment. The list of clients
are displayed based on the ordering configured for their associated roles.

Procedure

1. From the Roles tab, click Reorder.

2. From the Set Role Display Order window, select the role that you want to reorder and click
the up/down arrows to move it to the correct order.

3. Click Save.
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Configuring categories

You need to configure categories to categorize factors and to determine the applicable
classifications for the assessment. Examples of categories include Need and Barrier.
Categories

You can specify one or more category for each assessment definition. An assessment is made
up of one or more factors. These factors are categorized in order to determine the applicable
classifications for the assessment. Examples of categories include Need and Barrier.

A Need category may consist of factors that represent something that the client needs. A Barrier
category may consist of factors that prevent a client's progress in achieving something.

Category code table
Categories are defined in the Assess Def Factor Type code table. A new category can be
dynamically added to this code table and published as part of system administration. For example,
default categories that are provided: Need and Barrier.

Configuring a new code table item
Complete the following steps to add new code table items to an existing Ctiram code table. The
new code table items are then available for selection on Curam screens.

Procedure

1. Log in to the Cliram system as a user with the system administrator credentials.

2. Select the System Configurations tab, expand the Shortcuts menu, and select Application
Data > Code Tables.

3. To add a code table item to an existing Curam code table, from the Search Criteria cluster,
enter the name and/or item and click Search.

4. From the action icon, select New Item to open the New Code Table Item window.

5. Enter the following fields and click Save to create a new code table item.

Name Description
Item Name The item name.
Technical ID (Code) The code for the item.

6. From the Code Tables tab, click Publish > Yes.

Categories specified for Independent Living
The categories that are used for Independent Living are defined in an existing
CT_AssessDef Fact or Type. ct x code table therefore no new code table configurations are
required. The Need category is the only category that is selected during the assessment definition
category creation for Independent Living.
Configuring a category
Complete the following steps to configure a category and associate it with an assessment
definition.

About this task

A category is mandatory for configuring a factor. There are two steps to category configuration.
You must first add the new categories to the category code table and then associate one or more of
these categories with an assessment definition.
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After a new category is configured on the category code table, it must be associated with

an assessment definition before it can be used to categorize factors. There are two ways of
associating a category with an assessment definition. When a category code table is configure, it
is automatically displayed on the New Assessment Definition window.

One or more of the categories that are displayed can be associated with the assessment definition
by selecting them when the assessment definition is created. Alternatively, one or more categories
can be associated with an assessment definition from the Categories tab on the assessment
definition as shown here.

Note: Once a category has been associated with an assessment definition, it can be used
to group the factors that apply to the assessment definition. For more information, see the
Outcome Management Configuration Guide.

Procedure

1. From the assessment definition, select the Categories tab. Selects the action icon and click
Add Categories.

2. From the Add Categories window, tick the category that you want to add and click Save.

Configuring category classifications

You configure a classification to outline different levels of severity for the type of category under
which the factor is being assessed.

Classifications

Classifications are the potential results that a client can achieve when assessed for a factor.
Classifications are used to define a scale that measures a client's position pertaining to the factors
that are being assessed.

For example, the classifications that are configured for a Need category might include 'At Risk’,
'In Crisis', 'Stable', and 'Thriving'. When a client is assessed across a number of factors, the
classifications that are defined by the administrator for the category of factors represent the
results of the assessment.

Classification configuration allows the administrator to define individual classifications
and associate them with categories. When a classification is associated with a category, it
automatically applies to all factors defined for the selected category.

Note: A number of extra configuration options for classifications are available for individual
factors, which provide a finer level of granularity for configuring classifications for factors.
For more information, see the Outcome Management Configuration Guide.

Classification code table
Classifications are associated with the Classification Division Type code table. A new
classification type can be dynamically added to this code table and published as part of system
administration. When a classification is added to the classification code table, it is automatically
available for selection in the Classification drop-down list.

Configuring a new code table item

© Merative US L.P. 2012, 2024



1 Independent Living accelerator 109

Complete the following steps to add new code table items to an existing Ctiram code table. The
new code table items are then available for selection on Curam screens.

Procedure

1. Log in to the Cliram system as a user with the system administrator credentials.

2. Select the System Configurations tab, expand the Shortcuts menu, and select Application
Data > Code Tables.

3. To add a code table item to an existing Curam code table, from the Search Criteria cluster,
enter the name and/or item and click Search.

4. From the action icon, select New Item to open the New Code Table Item window.

5. Enter the following fields and click Save to create a new code table item.

Name

Description

Item Name

Technical ID (Code)

The item name.

The code for the item.

6. From the Code Tables tab, click Publish > Yes.

Classification code table values for Independent Living
Specify the following values for configuring an Classification Division Type code table for

Independent Living.

Table 74: Classification division type code table search criteria

Name

Value

Search Criteria Name

ClassDivisionType

Table 75: Classification division type code table new item values

Name

Description Code 1 Value Code 2 Value

Code 3 Value

Item Name

Technical ID
(Code)

The item name Critical Substantial
which is displayed

in the drop-

down list on the

Classification

Division Type

window.

The code for the CDT24001

item.

CDT24000

Moderate

CDT24002

Configuring the classification association with a category
You can associate a classification with a pre-defined category that uses the Classification menu.

Complete the following steps for configuring a classification for a category.

Procedure

1. From the assessment definitions Categories tab, select the action icon and click New

Classification.

2. From the New Category Classification window, enter the following details:
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Name

Description

Category

Classification

Minimum Priority

Maximum Priority

Initial Warning Days

Unique identifier of the category that is associated
with this Category Classification, for example,
Need, Barrier.

The type of classification division, for example,
need, neutral, strength.

A minimum priority number can be set for

a classification. The minimum number of a
classification division that can be used to consider
priority on the assessment results page.

For example, if the minimum priority number is
set to 1 for a classification of In Crisis, a minimum
of one factor must be selected as a priority by a
caseworker on the assessment results page.

A maximum priority number can be set for a
classification. It defines the maximum number of
factors that can be specified as a priority on the
assessment results page.

For example, if the maximum priority number is
set to 3 for a classification of Thriving, a maximum
of three factors can be selected as a priority by a
caseworker on the assessment results page.

The initial warning days configuration setting

is provided to support an agency's custom
escalation processing. If a priority factor is not
addressed within a specified number of days,
an agency can create custom processing that is
started.

An initial warning number of days can be set for
each classification. The initial warning number of
days is the number of days after which an initial
warning is sent to a user.

For example, if the initial warning number of days
is set to 3. If a factor that is marked as a priority
is not addressed, the system automatically might
send a notification to the caseworker after three
days.
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Name Description

Escalation Warning Days The escalation warning days configuration
setting is provided to support an agency's custom
escalation processing. If a priority factor is not
addressed within a specified number of days,
an agency can create custom processing that is
started.

An escalation number of days can be set for each
classification. The escalation number of days

is the number of days after which an escalation
warning is sent to a user.

For example, if the escalation number of days is
set to 10. If a factor that is marked as a priority
is not addressed by a casework, the system
automatically might send a notification to a case
supervisor after 10 days.

Hide From Result A classification can be hidden from assessment
results. The Hide From Result indicator dictates
whether factors for achieving a particular
classification when assessed are hidden in the
assessment results.

For example, if this indicator is turned on for a
classification of Thriving, factors that are classified
as Thriving are not displayed in assessment
results.

3. Click Save.

Category classification values for Independent Living
There are 3 classifications that are configured for Independent Living. Specify the following
values for configuring the 3 classifications for the Need category.

Table 76: New category classifications values

Category Classification
Need Critical

Need Substantial
Need Moderate

Configuring factors

You configure factors so that the clients needs are assessed when a particular type of assessment
is run.

Factors

A factor is an aspect of a client circumstance that is of interest to an organization. Client needs are
assessed by using factors.

Typically, a factor is considered either a need or a barrier:

* Needs are things that a client or family requires to be self-sustaining, but currently lack.

» Barriers are conditions that prevent or complicate a client's ability to obtain or achieve
something. Examples of assessment factors include substance abuse, mental health, and
parenting skills.
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Each assessment typically has one or more factors, which describe performance standards for that
assessment. Each assessment has unique characteristics and while some factors might look similar
between assessments, the details of factors such as classifications, and thresholds, might differ
across assessments.

A factor can be added to an outcome plan as a result of an assessment. By running a Strengths
and Needs assessment, factors such as Substance Abuse and Mental Health can be added to the
outcome plan. A factor can also be added to an outcome plan by a caseworker who can select

a factor from a pre-defined list of appropriate factors. For example, this option can be used if a
third party is running the assessment and the caseworker wants to record the results manually

on the outcome plan. Finally, a factor can be added to an outcome plan when defined by a user
to specially address a particular circumstance. For example, through meetings between the
caseworker and the client an environmental issue might be identified as a factor. The caseworker
can record this factor on the outcome plan.

Guidance text can be defined for factors to help the user understand the steps that can be taken

to address a particular issue. For example, the following guidance can be displayed if a client is
assessed for Substance Abuse and is classified as 'Need': 'The client can use alcohol or prescribed
drugs; however, use does not negatively affect their ability to look after themselves. Minimum
support is required; perhaps ensure that the client has support from family and friends, the
community, or both.'

Configuring a factor

A factor can be assessed as part of an assessment with other factors or it can be used in a stand-
alone manner. Complete the following steps for configuring a factor that is associated with an
assessment definition.

Procedure

1. From the assessment definition, select the Factors tab and click New Factor....

2. From the New Factor window, enter the following details.

Name Description

Name The name of the factor, for example, Income,
Education, Childcare.

Start Date The start date of the factor.
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Name Description

Category The type of factor, for example, Need or Barrier.

A category must be specified for a factor.
Categories must be specified before factors can
be added to an assessment. How a factor is
categorized depends on the factor.

For example, in a self-sufficiency assessment,

a range of factors need to be assessed in order
to determine whether a person or family is self-
sufficient. In such an assessment, a number of
factors might be identified such as child care,
language proficiency, education & literacy.
Similarly, a range of Barrier factors might be
identified such as mental health, physical health,
alcohol abuse. So, for this self-sufficiency
assessment, all factors can be classified as either
a Need or a Barrier category.

Note: Once a category is selected for a factor,
any classifications that are associated with that
category are the classifications that are used to
classify that factor during assessment.

Reference The reference identification for the factor definition
so the factor can be referenced by the rules.

End Date The end date of the factor.

Threshold Each factor has a threshold value, which
represents a marker/value on a factor scale. You
use the threshold value to indicate the relative
level of functioning for a factor.

For example, on a scale of 1-10, a threshold of

5 can indicate a sufficient level of functioning.
Depending on the assessment, the meaning of the
threshold can vary.

Threshold is a string value, which allows the
threshold value to be blank and not be defaulted
to zero when the threshold is not specified. For
example, for a self-sufficiency assessment, the
threshold can represent the value that must

be satisfied for a client to be considered self-
sufficient.

For a back-to-work assessment, the threshold can
represent a value that must be satisfied for a client
to be considered to be able to obtain and sustain
employment.
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Name Description

Merge The same assessment can be run multiple times
for the same person and in some cases it is
appropriate to merge the factor results produced.

For example, a CSN assessment can be run for
client 1 focusing on client 2. It might subsequently
be run again for client 1 focusing on client 3. In
this case, client 1 is assessed twice for Substance
Abuse. The results for substance abuse can be
merged that is, only one result for substance
abuse is displayed when an assessment is run,
rather than two sets of results.

The merge indicator dictates if factor results are
merged or not when an assessment is run. If the
merge is enabled, the results are merged and the
latest factor results is displayed.

Planning Applicable Indicates whether the factor is a planning factor. If
the factor is a planning factor, the caseworker can
associate activities and objectives to the factor. If
the factor is not a planning factor, then the factor
is only used to capture results and is not involved
in planning.

3. Click Save.

Factor values for Independent Living
Specify the following values for configuring 2 assessment definition factors for Independent
Living.

Table 77: Needs Assessment factors configured

Name Description

Assess Needs under Health and Safety Health and Safety. Includes freedom from harm,
abuse or neglect, and taking account of wider issues
of housing and community safety.

Management of Daily Routine Management of daily routine; the ability to manage
personal and other daily routines.

Table 78: The 5 factor values

Name Value

Start Date Current date
Category Need
Planning Applicable Yes

Mapping CDA outcomes to factors
You must map each of the decision assist outcomes to factors or factor classifications.

Procedure

1. Select the Administration Workspace tab, expand the Shortcuts menu, select Qutcome
Management > Assessment Definitions.
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From the Assessment Definitions window, click on an assessment name.
From the Assessment window, click on the Factors tab.

From the Factors window, click on a factor name.

From the ACTIONS menu, click on the Map CDA Outcome option.

AR

From the Map CDA Outcome window, select the appropriate outcome from the drop-down
list.

7. Click Save.

Decision assist outcome factor mapping values for Independent Living
Specify the following values when associating decision assist outcomes with factors for
Independent Living.

Table 79: Daily Routine outcome values

Name Value

Outcome Daily Routine - Needs

Table 80: Health and Safety outcome values

Name Value

Outcome Health and Safety - Needs

Configuring factor classifications

You can configure a classification for individual factors, which provide a finer level of
granularity. Classifications outline the different levels of severity for the type of category under
which the factor is being assessed.

Factor classifications

Classifications are the potential results that can be achieved for a factor. For example, a need
category might include classifications such as Vulnerable, Engaged, Progressing, and Self-
Sufficient. Factors are assigned to a category and thus adopt the category classification.

Once the classifications described in are configured, they are automatically associated with a
factor when a factor category is specified. Administrators can configure additional information
for each classification at the factor level. Factor classifications represent measurement indicators
for an individual factor. A classification is a portion of the scale that measures the actual progress
of a client, for example, 'Need', 'Neutral', 'Strength'. A subdivision defines a portion of the range
that is entered on the classification, which enables a finer level of measurement.

A maximum and minimum range can be set for factor classifications. It is the range that a factor
score must fall between in order to achieve that classification. Administrators can also choose to
hide factors that achieve a particular classification from assessment results.

Activities can also be configured for a factor classification and classification subdivision. It
allows activities to be recommended to a caseworker when a client achieves a particular score/
classification when assessed.

The following can also be recorded for factor classifications:

* Definitions

» Subdivisions
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* Guidance Text

Configuring a factor classification

A measurement indicator of a clients progress for a factor. A factor classification can be either
a classification or classification subdivision. A classification is a portion of the scale that
measures the actual progress of a client for example, Need 0-5. Complete the following steps for

configuring a factor classification.

Procedure

1. From the assessment definition, select the Factors tab.

2. From the Factors list, select a factors name, which opens in its own tab.

3. Select the Classification tab.

4. For each of the classifications, select the action icon and click Edit to add the following

details.

Name

Description

Minimum Range

Maximum Range

Hide from Priority Selection

Definition

Guidance Text

A minimum and maximum range can be set for
classifications. It enables the administrator to
configure how classifications are rated on a scale.

For example, the CSN substance abuse factor has
a 'Strength’ range of 0 to 5, and a 'Need' range of
-3to 0. When a client is assessed for substance
abuse and they achieve a score of -2, they are
classified as having a 'Need' since -2 falls within
the 'Need' range.

Administrators can hide factor classifications from
assessment results. If a factor classification is
hidden, it means that the factor is not displayed

to the caseworker in the assessment results if the
classification is achieved by a client. It allows the
administrator to specify which factor classifications
are displayed for a factor.

For example, an agency might want a caseworker
to concentrate on a substance abuse factor where
a client is classified as a need, but not a strength.
In this case, a factor classification of 'Strength' can
be hidden.

A definition provides a description of what a
particular score means. For example, it aims
to describe a clients situation if they achieve a
particular classification.

The guidance text that is defined for a factor
classification is displayed in the caseworker
application within the assessment results.
Guidance assists a caseworker in the analysis of
client results and helps them to deal with clients
to achieve particular results. It might contain
items or information that can be considered by a
caseworker for considering activities to address
the factor result.
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5. Click Save.

Classification values for Independent Living
Specify the following values for configuring the 3 classifications for a factor.

Table 81: Critical classification configuration values

Name Value

Minimum Range 16

Maximum Range 31

Hide from Priority Selection No

Definition Critical

Guidance Text Factor 2: Critical 16-31. There is an inability to

carry out vital personal care or domestic routines.
Without the provision of community care services,
there would be a breakdown of care or living
arrangements, or they would become unsafe. There
would also be a risk of significant harm, neglect, or
abuse.

Table 82: Substantial classification configuration values

Name Value

Minimum Range 8

Maximum Range 15

Hide from Priority Selection No

Definition Substantial

Guidance Text Factor 2: Substantial 8-15. There is an inability

to carry out most of essential personal care

or domestic routines. A person needs daily or
continuous help and support with essential activities
of daily living. In particular whose care or living
arrangements break down or become unsafe
without provision of community care services. A
person who is unable to manage their own essential
activities of daily living without the provision of
community care services to support them to sustain
their caring role.

Table 83: Moderate classification configuration values

Name Value
Minimum Range 1
Maximum Range 7

Hide from Priority Selection No
Definition Moderate
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Name Value

Guidance Text Factor 2: Moderate 1-7. There is an inability to carry
out several personal care or domestic routines. A
person who is, or will be in the foreseeable future,
unable to manage most of activities of daily living.
Or other daily routines and sustain their caring
role, without the provision of care services. People
who need some support or assistance to manage
independently each week, but less often than every
day.

Classification subdivisions

You can use classification subdivisions to further separate and define information for smaller
ranges within the main factor classification range. Subdivisions allow further processing to be
assigned to factor classifications.

For example, an income factor can be classified as 'In Crisis' with a range of -5 to 0. The 'In
Crisis' classification division can be further subdivided. The administrator sets three subdivisions
for the values -5, -4 to -3, and -2 to 0. Each subdivision value has a specific definition:

* -2 to 0: Family receives little or no income

* -4 to -3: Income and / or budgeting skills are limited to the point that the family is unable to
meet its basic needs

* -5: The family is unwilling or unable to plan or save
* -4 to -3: Client presents with suicidal tendencies
* -5: Client is a danger to themselves.

Configuring a classification subdivision

A subdivision defines a portion of the range that is entered on the classification, which enables
a finer level of measurement for example, a value of 1. Complete the following steps for
configuring a subdivision.

Procedure

1. From the assessment definition, select the Factors tab.

2. From the Factors list, select a factors name, which opens in its own tab.
3. Select the Classification tab.
4

. For each of the classifications, you can add subdivisions by selecting the action icon and click
Add Subdivision.

5. From the Add Subdivision window, enter the following details.

Name Description

Minimum Range Value The minimum range value for a classification
division.

Maximum Range Value The maximum range value for a classification
division.
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Name Description

Definition A definition provides a description of what a
particular score means. For example, it aims
to describe a clients situation if they achieve a
particular classification.

Guidance Text The guidance text that is defined for a factor
classification is displayed in the caseworker
application within the assessment results.
Guidance assists a caseworker in the analysis of
client results and helps them to deal with clients
to achieve particular results. It might contain
items or information that can be considered by a
caseworker for considering activities to address
the factor result.

6. Click Save.

Classification subdivision values for Independent Living
Specify the following values for configuring the subdivision classifications specific for the 2
factors that are created for Independent Living.

Table 84: Critical classification subdivisions

Range Factor 1 - Health and Safety - Factor 2 - Daily Routine -
Guidance Guidance

16 to 16 Factor 1: Critical 16. Client in Factor 2: Critical 16. Client
need of advice on psychiatric requires a wheelchair to get
service around.

17 to 17 Factor 1: Critical 17. Client in Factor 2: Critical 17. Client
need of advice on psychiatric requires a wheelchair and
services and provision of assistance feeding.
housekeeping services.

18to 18 Factor 1: Critical 18. Client in Factor 2: Critical 18. Client
need of advice on psychiatric requires a wheelchair and
services and provision of nursing  assistance washing.
services.

19to 19 Factor 1: Critical 19. Client in Factor 2: Critical 19. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance feeding and washing.
housekeeping and nursing
services.

20to 20 Factor 1: Critical 20. Client in Factor 2: Critical 20. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance shopping.
budgeting services.

21to 21 Factor 1: Critical 21. Client in Factor 2: Critical 21. Client
need of advice on psychiatric requires a wheelchair and
services and the provision assistance feeding and shopping.
of household and budgeting
services.

22t0 22 Factor 1: Critical 22. Client in Factor 2: Critical 22. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance washing and shopping.
nursing and budgeting services.
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Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

23to 23

241024

25t0 25

26to 26

271027

2810 28

2910 29

30to 30

Factor 1: Critical 23. Client in
need of advice on psychiatric
services and the provision of
housekeeping, nursing, and
budgeting services.

Factor 1: Critical 24. Client in
need of advice on psychiatric
services and secure care.

Factor 1: Critical 25. Client in
need of advice on psychiatric
services and secure care, and
the provision of housekeeping
services.

Factor 1: Critical 26. Client in
need of advice on psychiatric
services and secure care, and the
provision of nursing services.

Factor 1: Critical 27. Client in
need of advice on psychiatric
services and secure care, and
the provision of housekeeping,
nursing, and budgeting services.

Factor 1: Critical 28. Client in
need of advice on psychiatric
services and secure care, and
provision of budgeting services.

Factor 1: Critical 29. Client in
need of advice on psychiatric
services and secure care, and the
provision of housekeeping and
budgeting services.

Factor 1: Critical 30. Client in
need of advice on psychiatric
services and secure care, and the
provision of nursing and budgeting
services.

Factor 2: Critical 23. Client
requires a wheelchair and
assistance feeding, washing, and
shopping.

Factor 2: Critical 24. Client
requires a wheelchair and
assistance using the toilet.

Factor 2: Critical 25. Client
requires a wheelchair and
assistance with feeding and using
the toilet.

Factor 2: Critical 26. Client
requires a wheelchair and
assistance with washing and
using the toilet.

Factor 2: Critical 27. Client
requires a wheelchair and
assistance with feeding, washing
and using the toilet.

Factor 2: Critical 28. Client
requires a wheelchair and
assistance with shopping and
using the toilet.

Factor 2: Critical 29. Client
requires a wheelchair and
assistance with feeding, shopping
and using the toilet.

Factor 2: Critical 30. Client
requires a wheelchair and
assistance with washing,
shopping and using the toilet.

Table 85: Substantial classification subdivisions

Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

8to 8

9to 9

10to 10

Factor 1: Substantial 8. Provide
client with advice on secure care
facilities.

Factor 1: Substantial 9. Provide
client with advice on secure
care and provide housekeeping
services.

Factor 1: Substantial 10. Provide
client with advice on secure care
and provide nursing services.

Factor 2: Substantial 8. Client
needs assistance using toilet.

Factor 2: Substantial 9. Client
needs assistance with feeding
and using toilet.

Factor 2: Substantial 10. Client
needs assistance with washing
and using toilet.
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Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

11to 11

12 to 12

13to0 13

14to 14

15to0 15

Factor 1: Substantial 11. Provide
client with advice on secure care,
and provide housekeeping and
nursing services.

Factor 1: Substantial 12. Provide
client with advice on secure care,
and provide budgeting services.

Factor 1: Substantial 13. Provide
client with advice on secure
care, and provide budgeting and
housekeeping services.

Factor 1: Substantial 14. Provide
client with advice on secure
care, and provide budgeting and
nursing services

Factor 1: Substantial 15. Provide
client with advice on secure care,
and provide budgeting, nursing
and housekeeping services.

Factor 2: Substantial 11. Client
needs assistance with feeding,
washing and using toilet.

Factor 2: Substantial 12. Client
needs assistance with shopping
and using toilet.

Factor 2: Substantial 13. Client
needs assistance with feeding,
shopping and using toilet facilities.

Factor 2: Substantial 14. Client
needs assistance with washing,
shopping and using toilet facilities.

Factor 2: Substantial 15. Client
needs assistance with feeding,
washing, shopping and using
toilet facilities.

Table 86: Moderate classification subdivisions

Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

ltol

2to2

3to3

4104

5t05

6to6

7t07

Factor 1: Moderate 1. Client may
need housekeeping services.

Factor 1: Moderate 2. Client may
need nursing services.

Factor 1: Moderate 3. Client may
need housekeeping and nursing
services.

Factor 1: Moderate 4. Client may
need budgeting services.

Factor 1: Moderate 5. Client
may need housekeeping and
budgeting services.

Factor 1: Moderate 6. Client may
need nursing and budgeting
services.

Factor 1: Moderate 7. Client may
require housekeeping, nursing
and budgeting services.

Factor 2: Moderate 1. Client
needs assistance with feeding.

Factor 2: Moderate 2. Client
needs assistance with washing.

Factor 2: Moderate 3. Client
needs assistance with feeding
and washing.

Factor 2: Moderate 4. Client
needs assistance with shopping.

Factor 2: Moderate 5. Client
needs assistance with feeding
and shopping.

Factor 2: Moderate 6. Client
needs assistance with washing
and shopping.

Factor 2: Moderate 7. Client
needs assistance with feeding,
washing and shopping.

Configuring recommendations

You can configure a recommendation either through the factor recommendation tab or as part
of the factor classification subdivision. You need to configure the recommendations as part of
the subdivision if you are configuring at a more granular level otherwise configure through the

recommendations tab.

Recommendations
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Recommendations are suggestions of activities (services, actions, or referrals) that are targeted
to address a client's specific circumstances. These recommendations are often based on best
practices or suggestions from subject matter experts.

Recommendations are displayed in the activity workspace in the outcome plan when clients
are assessed and recommendations are configured for the assessment that is run. The
recommendation that is displayed depends on the client's circumstances (assessment results).

An activity can be recommended in two ways. It can be recommended by the system when that
outcome plan is created for a client. It can also be associated with a factor such that the action is
recommended when a client achieves a particular result from being assessed.

For example, you can configure that a counseling service (Service C) is recommended
if a client scores a classification of 'Need' on the Substance Abuse factor.

Service A
(012 5) Service B
Substance abuse Suw —
with scoring
Need Service C
(-510-1) Service D

Activities can also be recommended at a more granular level, for example a day retreat program
(Service D) can be recommended if a client scores a value of -5.

Recommendations can be created for services, referrals, and actions. A recommendation and
reason can be specified. A recommendation indicates whether the caseworker is advised to

add the recommended activity or objective to the outcome plan for a client, or whether it is
discretionary to do so. The reason indicates why you think the recommended activity or objective
must be added to the outcome plan.
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Service A
p Strength 4
{0hoi5] Service B
Substance abuse 4 | Subslance
with =coring abuse
(-2 to -1) Service C
Meed . .
(-5 to -1} (-3 to -3) Service D

Objectives can also be configured such that they are recommended when an assessment is run.
Note: This configuration is reserved for future use.

Recommending an action for an assessment
Complete the following steps for configuring an action recommendation for a factor.
Procedure

1. From the assessment definition, select the Factors tab.

2. From the Factors list, select a factors name, which opens in its own tab.
3. Select the Recommendations tab.
4. From the ACTIONS icon, select Recommend Action.
5. From the Recommend Action window, enter in the following details to create a
recommendation action.
Name Description
Action You can select an action from the drop-down list,
which is pre-configured as part of configuring an
action.
Recommendation Indicates whether the recommendation is advised

or discretionary.

Reason You can enter the reason that a recommendation
is recommended for a client.

Classifications You can select the classifications that you want to
associate the action against.

Select Programs You can select the program that you want to
associate the action against.

6. Click Save.

Recommendation values for Independent Living
For Independent Living, the recommendations are configured as part of configuring a subdivision

recommendation.
Configuring a subdivision recommendation action
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Complete the following tasks for configuring a subdivision recommendation.

Procedure
1. From the assessment definition, select the Factors tab.
2. From the Factors list, select a factors name, which opens in its own tab.
3. Select the Classification tab.
4. Expand a classification and click the Subdivisions tab.
5. For each range specified, select the action icon and click Recommend Action.
6. From the Recommend Action window, enter the following details.
Name Description
Action You can select an action from the drop-down list,
which is pre-configured as part of configuring an
action.
Recommendation Indicates whether the recommendation is advised

or discretionary.

Reason You can enter the reason that a recommendation
is recommended for a client.

Program You can select the program that you want to
associate action against.

7. Click Save.

Health and safely factor subdivision recommendation values for Independent Living
Specify the following values for configuring subdivision action recommendations for
Independent Living. The action recommendations are not linked to programs for Independent
Living.
To give you an example of how the logic (rules) is defined for Independent Living for the first 3
questions that are specified in the assessment. Open up the Needs Assessment Matrix to see the
scores that are specified for each question.

If the client specifies "No" to question 1 "Is the home clean and tidy", you see from table 2 that
housekeeping services are recommended. You see in the Needs Assessment Matrix that the score
is 1 if the client specifies "No".

For question 2, if the client specifies "Yes" to question 2 "Does the client suffer from pressure
scores", nursing services are recommended. You see in the Needs Assessment Matrix that the
score is 2 if the client specifies "No".

If 3 is the final score that is achieved by the client assessment, you see that for range 3 to 3 that
housekeeping services and nursing services are recommended.

Table 87: Action configurations

Activity Activity Type Recommendation Reason

Advise on Psychiatric Action Advised Advise on

Services Psychiatric Services
Recommendation

© Merative US L.P. 2012, 2024



1 Independent Living accelerator 125

Activity Activity Type Recommendation Reason

Budgeting Services Action Advised Budgeting Services
Recommendation

Housekeeping Services  Action Advised Housekeeping Services
Recommendation

Nursing Services Action Advised Nursing Services
Recommendation

Advise on Secure Care  Action Advised Advise on Secure Care
Recommendation

Table 88: Moderate classification subdivision recommendations

Range Budgeting Services Housekeeping Services Nursing Services
ltol No Yes No

2to 2 No No Yes

3to3 No Yes Yes

4to4 Yes No No

5t05 Yes Yes No

6to6 Yes No Yes

7t07 Yes Yes Yes

Table 89: Substantial classification subdivision recommendations

Range Budgeting Housekeeping Nursing Services Advise on Secure
Services Services Care
8to8 No No No Yes
9to 9 No Yes No Yes
10to 10 No No Yes Yes
11to 11 No Yes Yes Yes
12 to 12 Yes No No Yes
13t0 13 Yes Yes No Yes
14 to 14 Yes No Yes Yes
15t0 15 Yes Yes Yes Yes

Table 90: Critical classification subdivision recommendations

Range Advise on Budgeting Housekeeping Nursing Advise on
Psychiatric Services Services Services Secure Care
Services

16 to 16 Yes No No No No

17 to 17 Yes No Yes No No

18to 18 Yes No No Yes No

19to 19 Yes No Yes Yes No

20to 20 Yes Yes No No No

21to 21 Yes Yes Yes No No

221022 Yes Yes No Yes No
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Range Advise on Budgeting Housekeeping Nursing Advise on
Psychiatric Services Services Services Secure Care
Services

23to 23 Yes Yes Yes Yes No

241024 Yes No Yes No Yes

25t0 25 Yes No No Yes Yes

26to 26 Yes No Yes Yes Yes

271027 Yes No Yes Yes Yes

2810 28 Yes Yes No No Yes

2910 29 Yes Yes Yes No Yes

30to 30 Yes Yes No Yes Yes

Daily routine factor subdivision recommendation values for Independent Living
Specify the following values for configuring subdivision action recommendations for
Independent Living. The action recommendations are not linked to programs for Independent
Living.

Table 91: Action configurations

Activity Activity Type Recommendation Reason

Feeding / Carer Services Action Advised Feeding / Carer Services
Recommendation

Washing / Carer Action Advised Washing /

Services Carer Services
Recommendation

Shopping / Carer Action Advised Shopping /

Services Carer Services
Recommendation

Toilet / Carer Services Action Advised Toilet / Carer Services
Recommendation

Wheelchair Service Action Advised Wheelchair Service
Recommendation

Table 92: Moderate classification subdivision recommendations

Range Feeding / Carer Washing / Carer Shopping / Carer
Services Services Services

ltol Yes No No

2to2 No Yes No

3to3 Yes Yes No

4t04 No No Yes

5t05 Yes No Yes

6to6 No Yes Yes

7t07 Yes Yes Yes
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Range Feeding / Carer Washing / Carer Shopping / Carer  Toilet / Carer
Services Services Services Services
8to8 No No No Yes
9t 9 Yes No No Yes
10to 10 No Yes No Yes
11to 11 Yes Yes No Yes
12 to 12 No No Yes Yes
13t0 13 Yes No Yes Yes
14to 14 No Yes Yes Yes
15to0 15 Yes Yes Yes Yes
Table 94: Critical classification subdivision recommendations
Range Feeding / Carer Washing / Shopping / Toilet / Carer Wheelchair
Services Carer Services Carer Services Services Service
16 to 16 No No No No Yes
17to 17 Yes No No No Yes
18 to 18 No Yes No No Yes
19to 19 Yes Yes No No Yes
20to 20 No No Yes No Yes
21to 21 Yes No Yes No Yes
22 t0 22 No Yes Yes No Yes
231023 Yes Yes Yes No Yes
241024 No No No Yes Yes
25t0 25 Yes No No Yes Yes
26 to 26 No Yes No Yes Yes
2710 27 Yes Yes No Yes Yes
2810 28 No No Yes Yes Yes
2910 29 Yes No Yes Yes Yes
30 to 30 No Yes Yes Yes Yes

Configuring case associations with an assessment definition
You can configure an association between an assessment definition and a case so that the
assessment is available to run on the case.
Assessments association with cases and outcome plans
Assessments can be associated with cases and outcome plans. It allows the administrator to
configure which assessments can be run from a particular case. Once the case is associated with
an assessment, the caseworker can then run the assessment for any cases of that type.

Two extra settings are provided:

* The On Home Page setting dictates whether assessment results are displayed on the home
page of the associated case. It allows an administrator to display the most pertinent assessment

results on the home page of the case.
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* The Assessment Available From setting dictates where an assessment can be run from within
an outcome plan.

For example, the assessment can be run from within a review of an outcome plan, it can be run
from within the outcome plan itself.

Associating an assessment definition with a case
Complete the following steps to configure an association between an assessment definition and a
case.

About this task
Associating an assessment type and a case type enables that type of assessment to be run from
that type of case. For example, a needs assessment can be run from a Reunification outcome plan.

Procedure

1. From the assessment definition, select the Cases tab and click Add.

2. From the Add Cases window, select the case that you want to associate your assessment
definition with and click Save.

3. For the case type, select the actions icon and click Show on Home Page in order for the
assessment to be displayed on the home page of the associate case.

4. For the case type, select the actions icon and click Edit Assessment Availablility.
5. From the Edit Assessment Availability window, select where an assessment can be run from
within an outcome plan and click Save.

Assessment definition case association for Independent Living
Associate the assessment definition with the following Outcome Plan. Configure the assessment
to be displayed on the Outcome Plan home page and that the assessment can be run from within
the outcome plan.

Table 95: Assessment Definition Outcome Plan Link

Type Name Assessment Available On Home Page
From
Outcome Plan Needs Outcome Plan Plan Yes

Saving your assessment configuration files

You must save your configurations.

Quick reference for saving your assessment configuration files

Reference table for all files that are associated with saving your assessment configuration.

The following descriptions detail each column of the reference table and what their purpose is.

» Task Name: The name of the current task.

» Data Contained In: The relevant file or files in the “CURAM DI R\ EJBSer ver\ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
$CURAM DIRS% is the Curam installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

+ Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R EJBSer ver \ bui | d\ dat aext ract or folder for each task.
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+ Files To Be Created: A list of files that need to be created by the user for each task.

Table 96: Assessment Configurations File Reference Table

Task Name Data Contained In

Files To Be Copied Files To Be Created
From Data Extractor

Saving your assessment
definition configuration
files

Saving your assessment
role configuration files

Saving your category CCODETABLEI TEM dmnx
configuration files

Saving your factor
configuration files

Saving your classification CODETABLEI TEM dnx
configuration files

Saving your factor
classification
configuration files

Saving your case
association configuration
files

ASSESSMENTDEFI NI TI ON. dnmxLOCALI ZABLETEXT)

ASSESSMENTROLE. dnmxLOCALI ZABLETEXT. dnmxTE)

dmMXTEXTTRA

KTTRANSLATI

FACTORCATEGORY. dnx CATECERY EEABST FRCADH Dpd et X

FACTOR. dnxFACTORLI NK. dnxLOCALI ZABLETEXT),

CT_Cl assDi vi si onTyp¢

FACTORCLASSI FI CATI ON. dnxCLASSI FI CATI ONG

ASSESSMENTDEFI NI TI ONCASELI NK. dnx

dmMXTEXTTRA

. Ct X

Ul DANCE. dnx

Saving Your Assessment Configuration Reference Table
Reference table for all files that are associated with saving your assessment configuration.

About this task

e Task Name: The name of the current task.

» Data Contained In: The relevant file or files in the %CURAM DI R EJBSer ver\ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer at i ve

\ Cur am Devel opnent .

+ Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or folder for each task.

» Files To Be Created: A list of files that need to be created by the user for each task.

Table 97:

Task Name Data Contained In

Files To Be Copied Files To Be Created
From Data Extractor

Saving your assessment
definition configuration
files

Saving your assessment
role configuration files

e ASSESSMENTDEFINITION.dmx
e LOCALIZABLETEXT.dmx
e TEXTTRANSLATION.dmx

*  ASSESSMENTROLE.dmx
e LOCALIZABLETEXT.dmx
e TEXTTRANSLATION.dmx
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Task Name Data Contained In

Files To Be Copied Files To Be Created
From Data Extractor

configuration files

Saving your factor
configuration files

configuration files

Saving your factor
classification
configuration files

Saving your case
association configuration
files

Saving your category « CODETABLEITEM.dm

Saving your classification CODETABLEITEM.dmx

FACTORCATEGORY.dmxCT_AssessDefFactorT]|
CATEGORYCLASSIFICATION.dmx

FACTOR.dmx
FACTORLINK.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

e CT_ClassDivisionTypel.

FACTORCLASSIFICATION.dmx
CLASSIFICATIONGUIDANCE.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

ASSESSMENTDEFINITIONCASELINK.dmx

ype.ctx

ctx

Saving Your Assessment Configuration Reference Table
Reference table for all files that are associated with saving your assessment configuration.

About this task

e Task Name: The name of the current task.

» Data Contained In: The relevant file or files in the %CURAM DI RV EJBSer ver\ bui | d
\ dat aext r act or folder, which contains data that you need to extract for the step.
YCURAM DI R%is the Ctiram installation directory, which by defaultis C: \ Mer ati ve

\ Cur am Devel opnent .

 Files To Be Copied From Data Extractor: A list of files that the user must copy from the
%CURAM DI R% EJBSer ver \ bui | d\ dat aext ract or folder for each task.

» Files To Be Created: A list of files that need to be created by the user for each task.

Table 98:

Task Name Data Contained In

Files To Be Copied Files To Be Created
From Data Extractor

Saving your assessment
definition configuration
files

Saving your assessment
role configuration files

configuration files

Saving your category e CODETABLEITEM.dm

ASSESSMENTDEFINITION.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

ASSESSMENTROLE.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

FACTORCATEGORY.dmxCT_AssessDefFactorT]|
CATEGORYCLASSIFICATION.dmx

ype.ctx
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Task Name Data Contained In

Files To Be Copied
From Data Extractor

Files To Be Created

Saving your factor
configuration files

Saving your classification ,
configuration files

Saving your factor
classification
configuration files

Saving your case
association configuration
files

CODETABLEITEM.dmx

FACTOR.dmx
FACTORLINK.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

e CT_ClassDivisionType.

FACTORCLASSIFICATION.dmx
CLASSIFICATIONGUIDANCE.dmx
LOCALIZABLETEXT.dmx
TEXTTRANSLATION.dmx

ASSESSMENTDEFINITIONCASELINK.dmx

Saving your assessment definition configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.
2. From the #CURAM DI R EJBSer ver \ bui | d\ dat aext r act or directory, copy the

following DMX files.

File name Description

LOCALI ZABLETEXT. dnx

TEXTTRANSLATI ON. dnx

ASSESSMENTDEFI NI TI ON. dihis entity stores the assessment definition information.

This entity holds a link to text translations for descriptions that appear
throughout the application.

This entity holds the text translation for various locales.

\ Mer ati ve\ Curam Devel opnent .

Note: % CURAM DI R%is the Ctram installation directory, which by default is C:

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.
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Assessment definition configuration files for Independent Living
The Independent Living assessment definition configurations files are in the following location in
the accelerator.

Table 99: DMX files

File name Location

ASSESSMENTDEFI NI TI ON. d##CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
LOCALI ZABLETEXT. dmx ' ™M 112

TEXTTRANSLATI ON. dnx Note: %CURAM DI R%is the Curam installation directory, which by default
is C: \ Mer ati ve\ Cur am Devel opnent .

Saving your assessment role configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

ASSESSMENTROLE. dnmx This entity stores the assessment role information.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. From Y%CURAM DI R% EJBSer ver , run bui | d dat abase.

4. Save your configuration files.

Assessment role configuration files for Independent Living
The Independent Living assessment role configurations files are in the following location in the
accelerator.

Table 100: DMX files

File name Location

ASSESSMVENTROLE. dnx YCURAM DI R4 EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
LOCALI ZABLETEXT. dnx \initial

TEXTTRANSLATI ON. dnx Note: %CURAM DI R%is the Cdram installation directory, which by default
is C: \ Merati ve\ Cur am Devel opnent .
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Saving your category configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

FACTORCATEGORY. dix This entity stores the categories that can be used to categorize a factor,
Need and Barrier for example.

CATEGORYCLASSI FI CATI ON lnantity stores the classifications that are associated with a category
that can be used to classify a factor, Critical and Substantial for example.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Merative\ Curam Devel opnent .

3. From the %CURAM DI R4 EJBSer ver \ bui | d\ dat aextr act or
\ CODETABLEI TEM dnx file, search for AssessDefFactorType.

4. If there is no pre-existing code table in the CURAM DI R% EJBSer ver \ conponent s
\ COVPONENT_NAME\ codet abl e directory, create a new code table for the following code
tables. Add the content from the CODETABLEI TEM dnx file. If the code table exists, add the
content to the existing code table.

Table 101: Code tables files

File name Description

CT_AssessDef Fact oiThedie cortaining the entries for the AssessDefFactorType code table.

5. From “CURAM DI R% EJBSer ver ,runbui | d ct gen dat abase.
6. From “CURAM DI R webclient,runbuild client.

7. Save your configuration files.

Category configuration files for Independent Living
The Independent Living category configurations files are in the following location in the
accelerator.

Table 102: DMX files

File name Location

FACTORCATEGORY. dnx %CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
CATEGORYCLASSI FI CATI O\ di 1 &

Note: %CURAM DI R%is the Clram installation directory, which by default
is C: \ Mer ati ve\ Cur am Devel opnent .
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Saving your factor configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.
2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the

following DMX files.
File name Description
FACTOR. dnx This entity stores the factor information.
FACTORLI NK. dnx This entity links a factor to an assessment or an outcome plan.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.

Note: % CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Factor configuration files for Independent Living
The Independent Living factor configurations files are in the following location in the accelerator.

Table 103: DMX files

File name Location

FACTOR. dnx Y%CURAM DI R EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
FACTORLI NK. dmx ‘initial

LOCALI ZABLETEXT. dnx Note: %CURAM DI R%is the Curam installation directory, which by default
TEXTTRANSLATI ON. dimx is C: \ Mer ati ve\ Cur am Devel opnent .

Saving your CDA outcomes to factors mapping configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the CURAM DI RO EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

DAQUTCOVEFACTORLI NK. drithis entity stores the relationship between an assessment and a type of
case, Outcome Plan for example.
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Note: %CURAM DI R%is the Cliram installation directory, which by default is C:
\ Mer ati ve\ Curam Devel opnent .

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

CDA outcomes to factors mapping configuration files for Independent Living
The Independent Living CDA outcomes to factors mapping configurations files are in the
following location in the accelerator.

Table 104: DMX files

File name Location

DACQUTCOVEFACTORLI NK. dm#CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
\initial

Note: %CURAM DI R%is the Curam installation directory, which by default
is C:\ Merati ve\ Cur am Devel opnent .

Saving your classification configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the “CURAM DI R% EJBSer ver\ bui | d\ dat aext ract or
\ CODETABLEI TEM dnx file, search for AssessDefFactorType.

%CURAM DI R%is the Ctram installation directory, which by defaultis C: \ Mer ati ve
\ Cur am Devel opnent .

3. Ifthere is no pre-existing code table in the “CURAM DI R% EJBSer ver \ conponent s
\ COVPONENT_NAME\ codet abl e directory, create a new code table for the following code
tables. Add the content from the CODETABLEI TEM dnx file. If the code table exists, add the
content to the existing code table.

Table 105: Code tables files

File name Description

CT_dl assDi vi si onTyhe.fit¢ xontaining the entries for the ClassDivisionType code table.

4. From CURAM DI R EJBSer ver,runbui | d ct gen dat abase.
5. From “CURAM DI R webclient,runbuild client.

6. Save your configuration files.
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Classification configuration files for Independent Living

Independent Living uses the existing classification codes of Critical, Substantial, and Moderate.
Saving your factor classification configuration files

Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the “CURAM DI RO EJBSer ver \ bui | d\ dat aext ract or directory, copy the
following DMX files.

File name Description

FACTORCLASSI FI CATI ON. dirhds entity contains measurement indicators of a client's progress for a
factor.

CLASSI FI CATI ONGUI DANCH hdsrentity contains a history of guidance for a factor classification.

LOCALI ZABLETEXT. dnx  This entity holds a link to text translations for descriptions that appear
throughout the application.

TEXTTRANSLATI ON. dnx  This entity holds the text translation for various locales.

Note: %CURAM DI R%is the Ctram installation directory, which by default is C:
\ Mer at i ve\ Cur am Devel opnent .

3. From “CURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Factor classification configuration files for Independent Living
The Independent Living factor configurations files are in the following location in the accelerator.

Table 106: DMX files

File name Location

FACTORCLASSI FI CATI ON. ds#®CURAM DI R% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a
CLASSI FI CATI ONGUI DANCE. dr 1 &

LOCALI ZABLETEXT. dnx Note: %CURAM DI R%is the Curam installation directory, which by default
TEXTTRANSLATI ON. dnx is C:\ Mer ati ve\ Cur am Devel opnent .

Saving your case association configuration files
Extract the specified DMX files from the database and put them under source control.

Procedure

1. Extract the DMX files from the database with the ext r act dat a build target.

2. From the %CURAM DI R% EJBSer ver \ bui | d\ dat aext r act or directory, copy the
following DMX files.

File name Description

ASSESSMENTDEFI NI TI ONCASHHS ENttydstares the relationship between an assessment and a type of
case, Outcome Plan for example.
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\ Mer ati ve\ Curam Devel opnent .

Note: %CURAM DI R%is the Cliram installation directory, which by default is C:

3. From YCURAM DI R% EJBSer ver ,run bui | d dat abase.

4. Save your configuration files.

Case association configuration files for Independent Living

The Independent Living category configurations files are in the following location in the

accelerator.

Table 107: DMX files

File name Location

\initial

ASSESSMVENTDEFI NI TI ONCASEILR® dinRk% EJBSer ver \ conponent s\ | ndependent Li vi ng\ dat a

is C:\ Merati ve\ Cur am Devel opnent .

Note: %CURAM DI R%is the Curam installation directory, which by default

Reference

Refer to the following information for specific Independent Living configuration values.

User configuration values for Independent Living

A complete list of the configuration values that you need to configure users in Independent

Living.
User values for Independent Living

Specity the following values for creating the assessment planner user for Independent Living.

Table 108: New user values

Name Value

Title Mr

First Name INDEPENDENT LIVING
Last Name PLANNER

Location Springdfield

Personal Email financialuser@curamsoftware.com

Username ilplanner

Password password

Application ILAssessmentPlannerHome
Role Name PLANNERROLE

Account Enabled True
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Assign the assessment planner a position for Independent Living
Specify the following values for assigning the assessment planner user to a position for

Independent Living.

Name Value

Organization Midway Social Welfare Plan '03
Structures

Organization Units Board of Directors

Position Chief Executive Officer

Assign User INDEPENDENT LIVING PLANNER

Workspace banner values for Independent Living
Specify the following values for creating an application for the Independent Living assessment
planner workspace section.

Table 109: New application values

Name Value

ID ILAPAPP

Component Cdram

Application Outcome Planner
Welcome Message Welcome %user-full-name

Table 110: New application values

Name Value
Preference Link True
Logout Link True
Preference Title Preferences
Logout Title Log out

Table 111: Search values

Name Value
Default Search Page OutcomePlan_resolveByReference
Initial Text Enter a Plan Reference Number

Table 112: Sections added

Sections

ILAPAPPHomeSection
ILAPAPPWorkspaceSection
DefaultAppCalendarSection
DefaultApplnboxSection
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Specify the following values for creating the personalized pods for the Independent Living

assessment planner worker.

Name Value
Page ID ILAssessmentPlannerHome
User Role PLANNERROLE

Available Pods Select the following check boxes:

¢ My Next Reviews

¢ My Onging Reviews
e My Tasks

e My Appointments

¢ Quicks Links

*  Work Queues
Default Pods Select 'Available Tasks'

Page Layout 3

Quick links values for Independent Living

Specify the following quick links to be displayed on the assessment planner home page quick link

pod.
Name Value
Application ILAssessmentPlannerHome
Quick Links Select the following quick links:

¢« New Outcome Plan

¢ My Outcome Plans

¢ Outcome Plan Search
e Search for a Person

« Search for a Case

e Search for a Person

* Register a Person

¢ My Cases

Home section values for Independent Living

Specify the following values for creating a section for the Independent Living assessment planner

home section.

Table 113: New Home section values

Name Value
Section ID ILAPAPPHomeSection
Section Title Home

Default Page ID ILAssessmentPlannerHome

Hide Tab Container True
Indicator
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Table 114: New tab to search for and select

Name Value

Tab Name ILAssessmentPlannerHome

Tab values for Independent Living
Specify the following values for creating a tab for the Independent Living assessment planner

home page.
Name Value
ID ILAssessmentPlannerHome
Name Home
Title Home

Workspace section values for Independent Living
Specify the following values for creating a section for the Independent Living assessment planner
workspace.

Table 115: New Section values

Name Value

Section ID ILAPAPPWorkspaceSection
Section Title Outcome Plans

Default Page ID Leave blank.

Hide Tab Container Leave the check box blank.
Indicator

Table 116: New Outcome Plans shortcuts group values

Name Value
ID OutcomePlans
Title Outcome Plans

Table 117: New Outcome Plans link values

Link ID Page ID Title
MyOutcomePlans  OutcomePlan_listByOwner My Outcome Plans
NewOutcomePlan  OutcomePlan_create New Outcome Plan

Table 118: New Searches shortcuts group values

Name Value
ID Searches
Title Searches

Table 119: New Searches link values

Link ID Page ID Title Open as Modal

OutcomePlanSea@otcomePlan_search Outcome Plan Yes
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Link ID Page ID Title Open as Modal
PersonSearch  Person_searchl Person No
CaseSearch Case_searchl Case No

Table 120: Search tabs

Search Tabs

OutcomePlanSearch
PersonSearch

CaseSearch

Application data code table values for Independent Living
Specify the following values for linking the assessment planner home page to the application
code for Independent Living.

Table 121: New application values

Name Value
Item Name ILAssessmentPlannerHome
Technical ID (Code) ILAPAPP

Custom person home tab navigation values for Independent Living
Specify the additional custom navigation page and associated property that is required for the
person home tab navigation for Independent Living.

Additional entry for Per sonHone. nav

<nc:navigation-page id="OutcomePlan"
page-id="OutcomePlan listByParticipant"
title="Page.Title.OutcomePlans"/>

Additional entry for Per sonHone. properties

Page.Title.OutcomePlans=0Outcome Plans

Outcome plan values for Independent Living

A complete list of the configuration values that you need to configure outcome plans in
Independent Living.

Goal values for Independent Living

Specity the following values for configuring a goal for Independent Living.

Name Value
Name Independent Living
Reference blank
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Name

Value

Description

The aim of independent living is to empower and
enable people to achieve choice and control over
their lives and full participation as equal citizens in
society.

Action values for Independent Living

Specify the following values for configuring actions for Independent Living.

Table 122: Actions configured

Name

Description

Advise on Psychiatric Services

Advise on Secure Care

Budgeting Services

Feeding / Carer Services

Housekeeping Services

Nursing Services

Shopping / Carer Services

Toilet / Carer Services

Washing / Carer Services

Wheelchair Service

Advise on Psychiatric Services. Psychiatric services
can be provided where an assessor feels that they
are appropriate.

Advise on Secure Care. Some clients may require
secure accommodation and care.

Budgeting Services. Help with money management,
bill paying etc.

Feeding / Carer Services. Feeding is part of general
carer services.

Housekeeping Services. This could include cleaning
and vacuuming the home. Ensuring that the home is
a pleasant environment to live in.

Nursing services are available where a client has
a medical condition that requires qualified nursing
care.

Shopping / Carer Services. Assisting the client with
the shopping list, purchasing the goods and storing
them in their proper location in the home where the
client can retrieve them.

Toilet / Carer Services. Assisting the client in the
use of the toilet, ensuring that they are comfortable.

Washing / Carer Services. Washing, bathing the
client is part of general services that a carer would
be expected to perform.

Wheelchair Services. The client requires wheelchair
assistance to get around.

Table 123: Common configurations across all actions configured for Independent Living

Name

Value

Client Participation
Responsibility

Owner

True
User Creating Action

User Creating Action
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Specify the following progress values for Independent Living.
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Value

Resource Name

Excellent

Good

Moderate

Poor

ExcellentProgress

GoodProgress

ModerateProgress

PoorProgress

%CURAM DI R%

\ EJBSer ver\ conponent s
\ | ndependent Li vi ng
\data\initial\blob

\ Excel | ent Progress. png

Note: %CURAM DI R%is
the Cdram installation
directory, which by default
isC.\ Merative\ Curam
\ Devel opnent .

Y%CURAM DI R%

\ EJBSer ver\ conponent s
\ | ndependent Li vi ng
\data\initial\blob

\ GoodPr ogr ess. png

Y%CURAM DI R%

\ EJBSer ver\ conponent s
\ | ndependent Li vi ng
\data\initial\blob

\ Mbder at ePr ogr ess. png

Y%CURAM DI R%

\ EJBSer ver\ conponent s
\ | ndependent Li vi ng
\data\initial\blob

\ Poor Pr ogr ess. png

Outcome plan values for Independent Living

Specify the following values for configuring an outcome plan for Independent Living.

Multidisciplinary team configurations are not required.

Table 124: Outcome plan

Goals Applicable To
Agreement Approval Check
Ownership Strategy

Description

Name Value

Name Needs Outcome Plan
Reference NeedsAssess

Home Page blank

Outcome Plan Only
blank
blank

Needs Outcome Plan Description

Table 125: User Creation Options

Name

Value

Create Actions

True
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Name Value
Create Objectives True
Create Factors True
Table 126: Review Options
Name Value
First Review (days) 30
Frequency Calculation Scheduled Date
Frequency (days) 30

CDA assessment values for Independent Living
A complete list of the configuration values that you need to configure CDA assessment in

Independent Living.

Questionnaire values specific for Independent Living
Specify the following values for configuring a questionnaire for Independent Living.

Name Value

Name Needs Assessment
Type Needs

Comments blank

Data stores values for Independent Living

Specify the following values for configuring new data store entities and attributes for Independent

Living.

Table 127: Parent entity values

Name Value

Name Application
Table 128: Child entity values

Name Value

Name Person

Key Attribute personiD
Table 129: Child entity attribute values

Name Domain Type
personiD SVR_KEY
firstName IEG_STRING
gender IEG_GENDER
dateOfBirth IEG_DATE
rolelD IEG_INT64
participantlD IEG_INT64
guestionsApplicableind IEG_BOOLEAN
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Name Domain Type
hasCleanTidyHome IEG_YES_NO
sufferFromPressureSores IEG_YES_NO
canManageFinances IEG_YES_NO
placelndividualOrOthersAtRisk IEG_YES_NO
displayDangerousBehaviourToOthers IEG_YES_NO
canWashSelf IEG_YES_NO
canFeedSelf IEG_YES_NO
canGetMedicineFoodHouseholdltems IEG_YES_NO
requiresAssistanceToToilet IEG_YES_NO
canWalkLongDistances IEG_YES_NO

Script properties values for Independent Living
Specity the following values for configuring the script properties for Independent Living.

Config Properties
Show Progress Bar
Show Sections
Validate Save & Exit
Highlight Validation
Fast-Path

Hide Control Question

Name Value
Quit Page AssessmentScript_exit
Finish Page AssessmentDelivery_executeAssessment

ILDA_ieg-config

True
True
True
False
False

False

Section values for Independent Living

Specify the following values for creating the 3 sections that are created for Independent Living.

Table 130: Health and Safety section properties

Name Value

Title Health and Safety

Title ID Section.TitleHealthAndSafety

Enabled NeedsAssessment_health.png

Disabled NeedsAssessment_health_disabled.png
Selected NeedsAssessment_health.png

Table 131: Daily Routine section properties

Name Value

Title Daily Routine

Title ID Section.TitleDailyRoutine
Enabled NeedsAssessment_routine.png

© Merative US L.P. 2012, 2024



Curam 8.1.3 146

Name Value
Disabled NeedsAssessment_routine_disabled.png
Selected NeedsAssessment_routine.png

Table 132: Summary section properties

Name Value

Title Summary

Title ID Section.TitleSummary

Enabled NeedsAssessment_summary.png

Disabled NeedsAssessment_summary_disabled.png
Selected NeedsAssessment_summary.png

Question page values for Independent Living
Specify the following question pages for the associated sections that are created for Independent

Living.
Table 133: Health and Safety question page properties

The following values are specific for the page, which is created for the Health and Safely section.

Name Value

Page ID HealthAndSafetyPage

Entity Person

Page.Title Health and Safety

Page Title ID Groupl.Title

Page Description These questions are related to health and safety

and whether the client's state of health compromises
their standard of living.

Page Description ID Groupl.Description

Set Focus True

Table 134: Daily Routine question page properties

The following values are specific for the page, which is created for the Daily Routine section.

Name Value

Page ID DailyRoutinePage

Entity Person

Page.Title Daily Routine

Page Title ID Group2.Title

Page Description These questions are related to daily routine

and whether the client requires help performing
everyday tasks.

Page Description ID Group2.Description
Set Focus True
Progress 50
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Summary page values for Independent Living
Specify the following summary page for the associated summary section that is created for
Independent Living.

Table 135: Summary page properties

The following values are specific for the page, which is created for the Summary section.

Name Value

Page ID SummaryPage
Page.Title Summary
Page Title ID Summary.Title
Set Focus True

Progress 100

Cluster values for Independent Living
Specify the following clusters on the associated pages that are configured for Independent Living.

Table 136: Health and Safety cluster values

The following values are specific for the cluster, which is created for the Health and Safety page.

Name Value
Cluster Title Health and Safety
Cluster Title ID Groupl.Title

Table 137: Daily Routine cluster values

The following values are specific for the cluster, which is created for the Daily Routine page.

Name Value
Cluster Title Daily Routine
Cluster Title ID Group2.Title

Table 138: Summary cluster 1 values

The following values are specific for the first cluster, which is created for the Summary page.

Name Value

Cluster Title Health and Safety
Cluster Title ID Groupl.Title
Cluster Entity Person

Table 139: Summary cluster 2 values

The following values are specific for the second cluster, which is created for the Summary page.

Name Value
Cluster Title Daily Routine
Cluster Title ID Group2.Title
Cluster Entity Person
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Question values for Independent Living
Specify the following questions inside the clusters that are created for each section that is
configured for Independent Living. The help text for each question is displayed at the cluster

level within a cluster. The help text is combined for all the questions with the overall help text for

the cluster itself to create a help panel within the cluster.

Table 140: Health and Safety cluster question values

The following values are specific for the 5 questions, which are created for the Health and
Safety cluster on the Health and Safety page.

sufferFromPressuf@8eres

canManageFinancasie

placelndividualOrJtiersAtRisk

displayDangerousBeleviourToOthelBoes the

clean and tidy?

Does the client  Q2.Label
suffer from
pressure sores?

Is the client able Q3.Label
to manage their

own financial

affairs?

Does the client's Q4.Label
lifestyle place

them or others

at risk?

Q5.Label
client display

dangerous

behavior

towards others?

Question Mandatory Question Label Question Label Question Help Question Help
Attribute 1D Text Text ID
hasCleanTidyHomEue Is the home Q1.Label Is the home tidy QJ1.HelpText

and are kitchen
utensils clean?

Pressure sores Q2.HelpText
are areas of
damaged skin
that is caused
by staying in
one position
for too long.
You are at

risk if you are
bedridden, use
a wheelchair,
or are unable
to change your
position.

Can the client
manage paying
bills, look after
their money and
budget?

Q3.HelpText

An example
might be where
client drives a
car but has poor
vision.

Q4.HelpText

Client threatens Q5.HelpText
people or

is verbally

abusive.

Table 141: Daily Routine cluster question values

The following values are specific for the 5 questions, which are created for the Daily Routine
cluster on the Daily Routine page.
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Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
canWashSelf True Can the Q6.Label Is the client Q6.HelpText
client wash capable of
themselves? taking a bath or
shower without
assistance?
canFeedSelf True Can the Q7.Label Is the client Q7.HelpText
client feed capable
themselves? of feeding
themselves or
do they require
assistance?
canGetMedicineFdodélouseholditen@an the client Q8.Label Is the client Q8.HelpText
obtain food, capable of
medicines, doing their
and household own shopping?
items? This includes
preparing
shopping lists,
getting to and
from the shops,
and managing
money.
requiresAssistanca@Ttod oilet Can the client Q9.Label Is the client Q9.HelpText
access the capable of
toilet without going to and
assistance? from, and using,
the toilet without
assistance?
canWalkLongDistdmaes Can the client Q10.Label Client cannot Q10.HelpText
walk long walk long
distances distances
without without tiring
assistance? quickly.

Table 142: Summary cluster 1 question values

The following values are specific for the 5 questions, which are created for the first Summary

cluster on the Summary page.

clean and tidy?

and are kitchen
utensils clean?

Question Mandatory Question Label Question Label Question Help Question Help
Attribute 1D Text Text ID
hasCleanTidyHomgue Is the home Q1.Label Is the home tidy Q1.HelpText

© Merative US L.P. 2012, 2024




Curam 8.1.3 150

canManageFinancesie

placelndividualOrQtersAtRisk

displayDangerousBelgaviourToOthelBoes the

suffer from
pressure sores?

Is the client able Q3.Label
to manage their

own financial

affairs?

Does the client's Q4.Label
lifestyle place

them or others

at risk?

Q5.Label
client display

dangerous

behavior

towards others?

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
sufferFromPressuii@8eres Does the client  Q2.Label Pressure sores Q2.HelpText

are areas of
damaged skin
that is caused
by staying in
one position
for too long.
You are at

risk if you are
bedridden, use
a wheelchair,
or are unable
to change your
position.

Can the client
manage paying
bills, look after
their money and
budget?

Q3.HelpText

An example
might be where
client drives a
car but has poor
vision.

Q4.HelpText

Client threatens Q5.HelpText
people or

is verbally

abusive.

Table 143: Summary cluster 2 question values

The following values are specific for the 5 questions, which are created for the second Summary

cluster on the Summary page.

Question Mandatory Question Label Question Label Question Help Question Help
Attribute ID Text Text ID
canWashSelf True Can the Q6.Label Is the client Q6.HelpText
client wash capable of
themselves? taking a bath or
shower without
assistance?
canFeedSelf True Can the Q7.Label Is the client Q7.HelpText
client feed capable
themselves? of feeding

themselves or
do they require
assistance?
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Question
Attribute

Mandatory

Question Label

Question Label
ID

Question Help
Text

Question Help
Text ID

requiresAssistanca@tod oilet

canWalkLongDistdmaes

canGetMedicineFdodélouseholdlten@an the client

obtain food,
medicines,
and household
items?

Can the client
access the
toilet without
assistance?

Can the client
walk long
distances
without
assistance?

Q8.Label

Q9.Label

Q10.Label

Is the client
capable of
doing their
own shopping?
This includes
preparing
shopping lists,
getting to and
from the shops,
and managing
money.

Is the client
capable of
going to and
from, and using,
the toilet without
assistance?

Client cannot
walk long
distances
without tiring
quickly.

Q8.HelpText

Q9.HelpText

Q10.HelpText

Cluster layout values for Independent Living
Specity the following values for configuring the cluster layout for the needs assessment IEG

script for Independent Living.

Table 144: Cluster layout values

Name Value
Layout Type flow
Num Cols blank
Label Width 70
Label Alignment right
Cluster Width blank

Outcome values for the needs assessment matrix for Independent Living
Specify the following values for configuring an outcome for the needs assessment matrix for

Independent Living.

Table 145: Daily Routine outcome values

Name Value

Name Daily Routine
Type Needs

Start Date 3/1/2015
End Date blank
Comments blank
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Table 146: Health and Safety outcome values

Name Value

Name Health and Safety
Type Needs

Start Date 4/1/2015

End Date blank

Comments blank

Decision assist outcome factor values Independent Living
Specify the following values when associating decision assist outcomes with factors for
Independent Living.

Table 147: Daily Routine outcome values

Name Value
Outcome Daily Routine
Classification Moderate

Table 148: Health and Safety outcome values

Name Value
Outcome Health and Safety
Classification Moderate

Assessment configuration values for Independent Living
Specify the following assessment configuration values for Independent Living.

Table 149: CDA assessment configuration values

Name

Value

Name

Question Script

Needs Assessment Config

Needs Assessment Questionnaire

CDA matrix values for Independent Living
Complete the following values for configuring a CDA matrix for Independent Living.

Name Value

Name Needs Assessment Matrix
Type Needs

Scoring By Outcome Yes

Multiple Outcomes Yes

Comments blank

© Merative US L.P. 2012, 2024



1 Independent Living accelerator 153

Matrix values for Independent Living
Specity the following values to be configured a new matrix for Independent Living.

Table 150: Question selected

Select all 10 questions to be included in the CDA matrix.

Questions

Is the home clean and tidy?

Does the client suffer from pressure sores?

Is the client able to manage their own financial affairs?

Does the client's lifestyle place them or others at risk?

Does the client display dangerous behavior towards others?
Can the client wash themselves?

Can the client feed themselves?

Can the client obtain food, medicines, and household items?
Can the client access the toilet without assistance?

Can the client walk long distances without assistance?

Table 151: Outcomes selected

Select the following outcome to be included in the CDA matrix.

Outcomes

Health and Safety
Daily Routine

Table 152: Options selected

Select the following option to be included in the CDA matrix.

Options

Scores

Matrix score values for Independent Living
Specify the following scores for the Yes/No answers and the different combinations for each
question.

Table 153: Health and Safety questions score values

Question  Question Answers Scores
Number
Q1 Is the home clean and tidy? Yes 0
No 1
Q2 Does the client suffer from pressure Yes 2
sores?
No 0
Q3 Is the client able to manage their own Yes 0
financial affairs? No 4
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Question  Question Answers Scores
Number
Q4 Does the client's lifestyle place them  Yes 8
or others at risk?
No 0
Q5 Does the client display dangerous Yes 16
behavior towards others?
No 0
Table 154: Daily Routine questions score values
Question  Question Answers Scores
Number
Q6 Can the client wash themselves? Yes 0
No 1
Q7 Can the client feed themselves? Yes 0
No 2
Q8 Can the client obtain food, medicines, Yes 0
and household items?
No 4
Q9 Can the client access the toilet without Yes 0
assistance?
I No 8
Q10 Can the client walk long distances Yes 0
without assistance?
No 16

Table 155: Health and Safety questions answer combination (C) values

Num

Ques ArCiCzC:zCLCECECICECECICICICICICICICICICICCzCzCzCzCzCzCaCe Cz ClCiCy

Q1 YeJru€ru€ruéru€ru€ru€ru€ru€ru€ru€ruéruérueruéruérue

Q4 YeJru€rue Tru€rue Tru€rue Tru€rue TruBrue TruBrue Tru€rue TruBrue
No Tru€rue Tru€rue Tru€rue Tru€rue Tru€rue TruBrue TruBrue Truer
Q5 YeJrue True True True True True True True True True True True True True True True

No True True True True True True True True True True True True True True True Tr

No Tru€ruerukruBrueruerutrugrueruerutrutruerueruerpe
Q2 YeJru€ru€ru€ruéruéruéruérue TruBruBruérueruerueruerue

No Tru€ru€ru€ruéruéruéruérue Tru€ruerurutruerueruerpe
Q3 YeJru€ru€ru€rue Tru€ru€ru€rue TruBruéruérue Tru€ruerugrue

No Tru€ru€éruérue Tru€ruéruérue Tru€ruerugrue TruBrueruerpe

e

e

Table 156: Daily Routine questions answer combination (C) values

QuesArClCzC:CsCECeECICeECECICICICICICICICICcIcICczczczczczciczcocacocicei ey
Num

Q6  YeJru€ru€ru€ru€ruéru€ruéruéruéru€ru€ru€ruéruéruérue
No TruBruBruBruBruruerueruBruerueruerueruerueruer
Q7 YeJru€ru€ru€ru€ruéru€ruérue TruBruEruErueruerueruérue

Lie
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Q10 YeJrue True True True True True True True True True True True True True True True

No True True True True True True True True True True True True True True True Tr

QuesArClCzCzCsCECeECICECECICICICICICICICICICcICzczceczczcaczcecaczcieiey2
Num

No Tru€ru€ruéruéruéruéruérue TruBrugrukrukruerueruerpe
Q8 YeJru€ru€ruérue Tru€ruéruérue TruBrueruérue TruBrueruérue

No Tru€ru€éruérue Truéruéruérue TruBruéruérue TruBruéruerpe
Q9 YeJruérue Tru€rue Truérue Tru€rue TruBrue TruBrue TruBrue TruBrue

No Truérue Truérue Truérue Trugrue Tru€rue Trugrue Truérpe

Lie

Assessment values for Independent Living

A complete list of the configuration values that you need to configure assessment in Independent

Living.

Assessment definition values for Independent Living

Specify the following values for configuring an assessment definition for Independent Living.

Table 157: Assessment definition values

Reassessment Warning Days
Assessment Interval Days
Assessment Configuration
Type

Role Change Allowed
Reassessment Allowed
Display Graphs

Graph By

Graph Type

Priorities Applicable

Display Guidance

Group Results By Category
Display Score

Guidance Result Cluster
Factor Display Text

Count Same Score As One Priority

Result Page

Name Value

Name Needs Assessment
Reference NeedsAssessment
Start Date Current date

5

90

Needs Assessment Config
Role based

Yes

Yes

Yes

Graph by Classification
Bar

Yes

Yes

No

Yes

Closed

Needs Assessed

No

AssessmentDelivery_viewResultsForinstance
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Assessment role values for Independent Living
Specify the following values for configuring an assessment definition role for Independent
Living.

Table 158: Assessment definition role values

Name Value

Type Claimant Role
Type Abbreviation Claim Role
Reference blank
Mandatory Yes

Multiple Clients No

Questions Applicable Yes

Categories specified for Independent Living

The categories that are used for Independent Living are defined in an existing

CT_AssessDef Fact or Type. ct X code table therefore no new code table configurations are
required. The Need category is the only category that is selected during the assessment definition
category creation for Independent Living.

Classification code table values for Independent Living

Specity the following values for configuring an Classification Division Type code table for
Independent Living.

Table 159: Classification division type code table search criteria

Name Value

Search Criteria Name ClassDivisionType

Table 160: Classification division type code table new item values

Name Description Code 1 Value Code 2 Value Code 3 Value
Item Name The item name Critical Substantial Moderate
which is displayed
in the drop-

down list on the
Classification

Division Type

window.
Technical ID The code for the CDT24000 CDT24001 CDT24002
(Code) item.

Category classification values for Independent Living
There are 3 classifications that are configured for Independent Living. Specify the following
values for configuring the 3 classifications for the Need category.

Table 161: New category classifications values

Category Classification
Need Critical
Need Substantial
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Category

Classification

Need

Moderate

Factor values for Independent Living

Specify the following values for configuring 2 assessment definition factors for Independent

Living.

Table 162: Needs Assessment factors configured

Name

Description

Assess Needs under Health and Safety

Management of Daily Routine

Health and Safety. Includes freedom from harm,
abuse or neglect, and taking account of wider issues
of housing and community safety.

Management of daily routine; the ability to manage
personal and other daily routines.

Table 163: The 5 factor values

Name Value

Start Date Current date
Category Need
Planning Applicable Yes

Decision assist outcome factor mapping values for Independent Living
Specify the following values when associating decision assist outcomes with factors for

Independent Living.

Table 164: Daily Routine outcome values

Name

Value

Outcome

Daily Routine - Needs

Table 165: Health and Safety outcome values

Name

Value

Outcome

Health and Safety - Needs

Classification values for Independent Living

Specify the following values for configuring the 3 classifications for a factor.

Table 166: Critical classification configuration values

Name Value
Minimum Range 16
Maximum Range 31
Hide from Priority Selection No
Definition Critical
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Name

Value

Guidance Text

Factor 2: Critical 16-31. There is an inability to
carry out vital personal care or domestic routines.
Without the provision of community care services,
there would be a breakdown of care or living
arrangements, or they would become unsafe. There
would also be a risk of significant harm, neglect, or
abuse.

Table 167: Substantial classification configuration values

Guidance Text

Name Value
Minimum Range 8
Maximum Range 15

Hide from Priority Selection No
Definition Substantial

Factor 2: Substantial 8-15. There is an inability

to carry out most of essential personal care

or domestic routines. A person needs daily or
continuous help and support with essential activities
of daily living. In particular whose care or living
arrangements break down or become unsafe
without provision of community care services. A
person who is unable to manage their own essential
activities of daily living without the provision of
community care services to support them to sustain
their caring role.

Table 168: Moderate classification configuration values

Guidance Text

Name Value
Minimum Range 1
Maximum Range 7

Hide from Priority Selection No
Definition Moderate

Factor 2: Moderate 1-7. There is an inability to carry
out several personal care or domestic routines. A
person who is, or will be in the foreseeable future,
unable to manage most of activities of daily living.
Or other daily routines and sustain their caring

role, without the provision of care services. People
who need some support or assistance to manage
independently each week, but less often than every
day.
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Classification subdivision values for Independent Living
Specify the following values for configuring the subdivision classifications specific for the 2
factors that are created for Independent Living.

Table 169: Critical classification subdivisions

need of advice on psychiatric
services and secure care, and the
provision of nursing services.

Range Factor 1 - Health and Safety - Factor 2 - Daily Routine -
Guidance Guidance

16to 16 Factor 1: Critical 16. Client in Factor 2: Critical 16. Client
need of advice on psychiatric requires a wheelchair to get
service around.

17 to 17 Factor 1: Critical 17. Client in Factor 2: Critical 17. Client
need of advice on psychiatric requires a wheelchair and
services and provision of assistance feeding.
housekeeping services.

18to 18 Factor 1: Critical 18. Client in Factor 2: Critical 18. Client
need of advice on psychiatric requires a wheelchair and
services and provision of nursing  assistance washing.
services.

19to 19 Factor 1: Critical 19. Client in Factor 2: Critical 19. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance feeding and washing.
housekeeping and nursing
services.

20to 20 Factor 1: Critical 20. Client in Factor 2: Critical 20. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance shopping.
budgeting services.

21t021 Factor 1: Critical 21. Client in Factor 2: Critical 21. Client
need of advice on psychiatric requires a wheelchair and
services and the provision assistance feeding and shopping.
of household and budgeting
services.

2210 22 Factor 1: Critical 22. Client in Factor 2: Critical 22. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance washing and shopping.
nursing and budgeting services.

2310 23 Factor 1: Critical 23. Client in Factor 2: Critical 23. Client
need of advice on psychiatric requires a wheelchair and
services and the provision of assistance feeding, washing, and
housekeeping, nursing, and shopping.
budgeting services.

24 t0 24 Factor 1: Critical 24. Client in Factor 2: Critical 24. Client
need of advice on psychiatric requires a wheelchair and
services and secure care. assistance using the toilet.

2510 25 Factor 1: Critical 25. Client in Factor 2: Critical 25. Client
need of advice on psychiatric requires a wheelchair and
services and secure care, and assistance with feeding and using
the provision of housekeeping the toilet.
services.

26 to 26 Factor 1: Critical 26. Client in Factor 2: Critical 26. Client

requires a wheelchair and
assistance with washing and
using the toilet.
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Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

271027

2810 28

2910 29

30to 30

Factor 1: Critical 27. Client in
need of advice on psychiatric
services and secure care, and
the provision of housekeeping,
nursing, and budgeting services.

Factor 1: Critical 28. Client in
need of advice on psychiatric
services and secure care, and
provision of budgeting services.

Factor 1: Critical 29. Client in
need of advice on psychiatric
services and secure care, and the
provision of housekeeping and
budgeting services.

Factor 1: Critical 30. Client in
need of advice on psychiatric
services and secure care, and the
provision of nursing and budgeting
services.

Factor 2: Critical 27. Client
requires a wheelchair and
assistance with feeding, washing
and using the toilet.

Factor 2: Critical 28. Client
requires a wheelchair and
assistance with shopping and
using the toilet.

Factor 2: Critical 29. Client
requires a wheelchair and
assistance with feeding, shopping
and using the toilet.

Factor 2: Critical 30. Client
requires a wheelchair and
assistance with washing,
shopping and using the toilet.

Table 170: Substantial classification subdivisions

Range

Factor 1 - Health and Safety -
Guidance

Factor 2 - Daily Routine -
Guidance

8to 8

9to 9

10to 10

11to 11

12to 12

13t0 13

14to 14

15to0 15

Factor 1: Substantial 8. Provide
client with advice on secure care
facilities.

Factor 1: Substantial 9. Provide
client with advice on secure
care and provide housekeeping
services.

Factor 1: Substantial 10. Provide
client with advice on secure care
and provide nursing services.

Factor 1: Substantial 11. Provide
client with advice on secure care,
and provide housekeeping and
nursing services.

Factor 1: Substantial 12. Provide
client with advice on secure care,
and provide budgeting services.

Factor 1: Substantial 13. Provide
client with advice on secure
care, and provide budgeting and
housekeeping services.

Factor 1: Substantial 14. Provide
client with advice on secure
care, and provide budgeting and
nursing services

Factor 1: Substantial 15. Provide
client with advice on secure care,
and provide budgeting, nursing
and housekeeping services.

Factor 2: Substantial 8. Client
needs assistance using toilet.

Factor 2: Substantial 9. Client
needs assistance with feeding
and using toilet.

Factor 2: Substantial 10. Client
needs assistance with washing
and using toilet.

Factor 2: Substantial 11. Client
needs assistance with feeding,
washing and using toilet.

Factor 2: Substantial 12. Client
needs assistance with shopping
and using toilet.

Factor 2: Substantial 13. Client
needs assistance with feeding,
shopping and using toilet facilities.

Factor 2: Substantial 14. Client
needs assistance with washing,
shopping and using toilet facilities.

Factor 2: Substantial 15. Client
needs assistance with feeding,
washing, shopping and using
toilet facilities.
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require housekeeping, nursing
and budgeting services.

Range Factor 1 - Health and Safety - Factor 2 - Daily Routine -
Guidance Guidance

lto1l Factor 1: Moderate 1. Client may  Factor 2: Moderate 1. Client
need housekeeping services. needs assistance with feeding.

2to2 Factor 1: Moderate 2. Client may  Factor 2: Moderate 2. Client
need nursing services. needs assistance with washing.

3to3 Factor 1: Moderate 3. Client may  Factor 2: Moderate 3. Client
need housekeeping and nursing  needs assistance with feeding
services. and washing.

4t04 Factor 1: Moderate 4. Client may  Factor 2: Moderate 4. Client
need budgeting services. needs assistance with shopping.

5t05 Factor 1: Moderate 5. Client Factor 2: Moderate 5. Client
may need housekeeping and needs assistance with feeding
budgeting services. and shopping.

6 to 6 Factor 1: Moderate 6. Client may  Factor 2: Moderate 6. Client
need nursing and budgeting needs assistance with washing
services. and shopping.

7to7 Factor 1: Moderate 7. Client may  Factor 2: Moderate 7. Client

needs assistance with feeding,
washing and shopping.

Recommendation values for Independent Living

For Independent Living, the recommendations are configured as part of configuring a subdivision

recommendation.

Health and safely factor subdivision recommendation values for Independent

Living

Specify the following values for configuring subdivision action recommendations for
Independent Living. The action recommendations are not linked to programs for Independent

Living.

To give you an example of how the logic (rules) is defined for Independent Living for the first 3
questions that are specified in the assessment. Open up the Needs Assessment Matrix to see the
scores that are specified for each question.

If the client specifies "No" to question 1 "Is the home clean and tidy", you see from table 2 that
housekeeping services are recommended. You see in the Needs Assessment Matrix that the score
is 1 if the client specifies "No".

For question 2, if the client specifies "Yes" to question 2 "Does the client suffer from pressure
scores", nursing services are recommended. You see in the Needs Assessment Matrix that the
score is 2 if the client specifies "No".

If 3 is the final score that is achieved by the client assessment, you see that for range 3 to 3 that
housekeeping services and nursing services are recommended.

Table 172: Action configurations

Activity Activity Type Recommendation Reason

Advise on
Psychiatric Services
Recommendation

Advise on Psychiatric Action Advised

Services
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Activity

Activity Type

Recommendation

Reason

Nursing Services

Budgeting Services

Housekeeping Services

Advise on Secure Care

Action

Action

Action

Action

Advised

Advised

Advised

Advised

Budgeting Services
Recommendation

Housekeeping Services
Recommendation

Nursing Services
Recommendation

Advise on Secure Care
Recommendation

Table 173: Moderate classification subdivision recommendations

Range

Budgeting Services

Housekeeping Services

Nursing Services

ltol
2to 2
3to3
4to4
5t05
6to6
7t07

No
No
No
Yes
Yes
Yes

Yes

Yes
No
Yes
No
Yes
No

Yes

No
Yes
Yes
No
No
Yes

Yes

Table 174: Substantial classification subdivision recommendations

Range Budgeting Housekeeping Nursing Services Advise on Secure
Services Services Care

8to8 No No No Yes

9to 9 No Yes No Yes

10to 10 No No Yes Yes

11to 11 No Yes Yes Yes

12 to 12 Yes No No Yes

13t0 13 Yes Yes No Yes

14 to 14 Yes No Yes Yes

15to 15 Yes Yes Yes Yes
Table 175: Critical classification subdivision recommendations

Range Advise on Budgeting Housekeeping Nursing Advise on

Psychiatric Services Services Services Secure Care
Services

16 to 16 Yes No No No No

17 to 17 Yes No Yes No No

18to 18 Yes No No Yes No

19to 19 Yes No Yes Yes No

20to 20 Yes Yes No No No

21to 21 Yes Yes Yes No No
221022 Yes Yes No Yes No
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Range Advise on Budgeting Housekeeping Nursing Advise on
Psychiatric Services Services Services Secure Care
Services

23to 23 Yes Yes Yes Yes No

241024 Yes No Yes No Yes

25t0 25 Yes No No Yes Yes

26to 26 Yes No Yes Yes Yes

271027 Yes No Yes Yes Yes

2810 28 Yes Yes No No Yes

2910 29 Yes Yes Yes No Yes

30to 30 Yes Yes No Yes Yes

Daily routine factor subdivision recommendation values for Independent Living
Specify the following values for configuring subdivision action recommendations for
Independent Living. The action recommendations are not linked to programs for Independent

Living.

Table 176: Action configurations

Activity

Activity Type

Recommendation

Reason

Washing / Carer
Services

Shopping / Carer
Services

Toilet / Carer Services

Wheelchair Service

Feeding / Carer Services

Action

Action

Action

Action

Action

Advised

Advised

Advised

Advised

Advised

Feeding / Carer Services
Recommendation

Washing /
Carer Services
Recommendation

Shopping /
Carer Services
Recommendation

Toilet / Carer Services
Recommendation

Wheelchair Service
Recommendation

Table 177: Moderate classification subdivision recommendations

Range Feeding / Carer Washing / Carer Shopping / Carer
Services Services Services

ltol Yes No No

2to2 No Yes No

3to3 Yes Yes No

4t04 No No Yes

5t05 Yes No Yes

6to6 No Yes Yes

7t07 Yes Yes Yes
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Table 178: Substantial classification subdivision recommendations

Range Feeding / Carer Washing / Carer Shopping / Carer  Toilet / Carer
Services Services Services Services
8to8 No No No Yes
9t 9 Yes No No Yes
10to 10 No Yes No Yes
11to 11 Yes Yes No Yes
12 to 12 No No Yes Yes
13t0 13 Yes No Yes Yes
14to 14 No Yes Yes Yes
15to0 15 Yes Yes Yes Yes

Table 179: Critical classification subdivision recommendations

Range Feeding / Carer Washing / Shopping / Toilet / Carer Wheelchair
Services Carer Services Carer Services Services Service
16 to 16 No No No No Yes
17to 17 Yes No No No Yes
18 to 18 No Yes No No Yes
19to 19 Yes Yes No No Yes
20to 20 No No Yes No Yes
21to 21 Yes No Yes No Yes
22 t0 22 No Yes Yes No Yes
23t0 23 Yes Yes Yes No Yes
241024 No No No Yes Yes
25t0 25 Yes No No Yes Yes
26 to 26 No Yes No Yes Yes
2710 27 Yes Yes No Yes Yes
2810 28 No No Yes Yes Yes
2910 29 Yes No Yes Yes Yes
30 to 30 No Yes Yes Yes Yes

Assessment definition case association for Independent Living

Associate the assessment definition with the following Outcome Plan. Configure the assessment
to be displayed on the Outcome Plan home page and that the assessment can be run from within
the outcome plan.

Table 180: Assessment Definition Outcome Plan Link

Type Name Assessment Available On Home Page
From
Outcome Plan Needs Outcome Plan Plan Yes
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Notices

Permissions for the use of these publications are granted subject to the following terms and
conditions.

Applicability
These terms and conditions are in addition to any terms of use for the Merative website.
Personal use

You may reproduce these publications for your personal, noncommercial use provided that all
proprietary notices are preserved. You may not distribute, display or make derivative work of
these publications, or any portion thereof, without the express consent of Merative

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise
provided that all proprietary notices are preserved. You may not make derivative works of these
publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of Merative.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are
granted, either express or implied, to the publications or any information, data, software or other
intellectual property contained therein.

Merative reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as determined by Merative,
the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all
applicable laws and regulations, including all United States export laws and regulations.

MERATIVE MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT,
AND FITNESS FOR A PARTICULAR PURPOSE.

Merative or its licensors may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this documentation does not grant you any license
to these patents.

Information concerning non-Merative products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. Merative has not tested those
products and cannot confirm the accuracy of performance, compatibility or any other claims
related to non-Merative products. Questions on the capabilities of non-Merative products should
be addressed to the suppliers of those products.

Any references in this information to non-Merative websites are provided for convenience only
and do not in any manner serve as an endorsement of those websites. The materials at those
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websites are not part of the materials for this Merative product and use of those websites is at
your own risk.

This information contains examples of data and reports used in daily business operations.

To illustrate them as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any similarity to actual
people or business enterprises is entirely coincidental.

The licensed program described in this document and all licensed material available for it are
provided by Merative under terms of the Merative Client Agreement.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to Merative, for the purposes of developing,
using, marketing or distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. Merative, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample programs are provided
"AS IS", without warranty of any kind. Merative shall not be liable for any damages arising out of
your use of the sample programs.

Privacy policy

The Merative privacy policy is available at https://www.merative.com/privacy.

Trademarks

Merative " and the Merative ™ logo are trademarks of Merative US L.P. in the United States and
other countries.

IBM®, the IBM® logo, and ibm.com® are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide.

Adobe™, the Adobe™ logo, PostScript™, and the PostScript™ logo are either registered
trademarks or trademarks of Adobe™ Systems Incorporated in the United States, and/or other
countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

The registered trademark Linux® is used pursuant to a sublicense from the Linux Foundation, the
exclusive licensee of Linus Torvalds, owner of the mark on a worldwide basis.

Microsoft™, Windows™, and the Windows™ logo are trademarks of Microsoft™ Corporation in
the United States, other countries, or both.

UNIX™ is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
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